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ALONG THE 
WAY ...

... you’ll find helpful tips, 
definitions and more in this 
side column.

Here’s your first tip: see those 
small dots in the upper right-
hand margin? These represent 
the sections of the chapter 
you’re currently in. Use them 
to navigate to a specific 
exercise within a chapter (the 
dots on this page are just an 
example).
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LEVEL ONE TRAINING

The following chapters are all required courses to receive your Q-Sys Level One Certification. These textbook 

chapters are designed to be supplementary materials, used alongside the online video-based training sessions 

available at qsctraining.com. To receive certification, follow the instructions available at qsctraining.com in the 

Q-Sys Training: Level 1 Course.

SECTION ONE
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The first step in understanding Q-Sys™ is becoming familiar with the physical 

elements that are part of its system. As an integrated, scalable audio solution, 

Q-Sys simply has no equal. In this hardware overview, you’ll take a brief look 

at the building blocks of this system, which includes the Core, I/O Frames, 

Peripherals, and I/O Cards, as well as their networked redundancy.

• Study the basic Q-Sys Signal Path

• Explore the Core and I/O Frame Front and Back Panels

• Meet the I/O Cards and Network Peripherals

• Learn the outline of System Redundancy models

Hardware Overview

In This Chapter:

Core 500i
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1.1 THE BASIC SIGNAL PATH OF Q-SYS

To better understand the Q-Sys system, start off by diagramming a basic signal path.

1. Audio input begins at the source, such as a microphone or CD player. 

The input is connected to a Q-Sys I/O Card, which provides the points of 

connection to the Q-Sys System. You can choose from any number of different 

I/O Card options to fit your needs. These cards can be installed into either I/O 

Frames or directly into the Q-Sys Core if you don’t need remote inputs and 

outputs.

2. Q-Sys I/O Frames allow for remote input and output connections for the Q-Sys 

system, and, as a result, can be positioned in relatively close proximity to the 

physical input and output devices.

3. In this example, I/O Frames convert audio inputs into network packets which 

are sent on to a standard Gigabit Ethernet infrastructure. These connections 

between devices are made simple with a single CAT5e network cable; no 

multiple cable types are required.

4. With the audio source now digitized and on the network, it is transported to the 

Q-Sys Core. This powerful 64-bit core manages all audio processing and data 

routing.

5. After the Q-Sys Core has processed the audio, it routes the signal to the 

appropriate output. In some cases, this signal may travel back over the network 

to a remote I/O Frame where it is converted to analog, digital AES3, or other 

networked audio protocol such as CobraNet.

6. The audio is finally delivered to an output device such as an amplifier which 

will feed the signal to its destination loudspeakers.

MICROPHONES
MIXERS

LAPTOPS
VIDEO-CONFERENCING

DVD/CD PLAYERS

SWITCHI/O FRAME I/O FRAME

Q-SYS CORE
AMPLIFIERS

LOUDSPEAKERS

❶

❷

❸

❹

This revolutionary protocol 
suite is called Q-LAN, a true 
Layer-3 routable protocol. 
Q-LAN is so advanced it can 
stream up to 512 x 512 (1024) 
channels on a Gigabit network 
simultaneously. 

THE POWER OF 
Q-LAN

❺

❻

In other cases, it is routed to 

a local I/O Card on the Q-Sys 

Core itself and delivered to an 

output device.

1.1
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1.2 THE Q-SYS CORE

Now take a closer look at the Q-Sys Core’s front panel.

The main indicator will display 
the following information:

• The Name of the Core

• The name of the Design 
currently saved to the Core

• The Status of the design

• Network IP settings

• Device Model and 
Firmware version

• I/O Card Slot information 
(for any I/O Card(s) installed in 
the Core)

1. The main indicator is an LCD graphics display. It displays the basic 

housekeeping information about the Q-Sys Core.

2. You can cycle through the menus of the main indicator by using the PAGE (or 

NEXT) button to the right of the LCD screen.

3. The ID Button allows you to identify a device in the Q-Sys Designer software. 

When pressed, the Core will be identified on-screen in the Q-Sys Designer or 

GUI. This function also works in the opposite direction: from within the Q-Sys 

Designer software, you can use a function to ping the Core and cause the LCD 

screen to flash, helping you or your technician in the remote rack room to 

identify which device you are working on. 

❶ ❷ ❸

❹
❺

5. The POWER LED signifies that the system is powered up.

OFF means the system is idle and not running a design.
AMBER means the Core is starting or stopping a design.
GREEN means the Core is running a design.
RED means the Core is offline.

4. The Status LED has 

four different states.

6. Every Core has at least one I/O 

Card slot to allow for local inputs or 

outputs to the Core. If you decide 

to install an I/O Card in the Core, 

you will use the I/O Card STATUS 

LED on the front panel to monitor 

this audio. You have four LEDs, one 

for each channel.

OFF means no audio.
GREEN means signal present.
YELLOW means 3 dB before clipping.
RED means audio clipping.

❻

HOUSEKEEPING

Core 500i

1.2
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Next we’ll take a closer look at the Q-Sys Core’s back panel.

The most critical connection on the Q-Sys Core is the Q-Sys Network 

connection. All audio transportation and data communication streams through 

this port using QSC’s own Q-LAN protocol. This port transports data over 

standard Gigabit Ethernet between the Q-Sys Core and other Q-Sys networked 

peripheral devices such as I/O Frames and Page Stations. You’ll notice that there 

are two Q-Sys Network connections; this dual network setup enables you to run 

a redundant backup network. 

Any Q-Sys I/O Card can be installed into an Audio I/O Slot. Enterprise Core 

models have one I/O Card slot, and Integrated Cores have eight. 

The Q-Sys Core is powered by a universal power supply. This allows the 

Core to be powered by AC electrical power sources across the globe.

The Q-Sys Core contains a number of inputs allowing the integration of third-

❹    The Serial RS232 connection port connects to an external device that supports an 
RS232 control such as a professional CD/DVD player or video matrix switchers.
 

❺    There are two GPIO connections. GPIO stands for General Purpose Input Output. 
With the help of Q-Sys Designer, the GPIO allows for connectivity to potentiometers, 
buttons, switches, LED/lights, relays, etc. – basically anything that interfaces with GPIO.
 

❻    The Video Out connection is intended for manufacturing and diagnostic purposes.

❼     The four rear USB connectors are reserved for future Q-Sys development. There 
are also two auxiliary network connections for third-party controllers such as AMX, 
Crestron, Medialon, etc. using TCP/IP.

❶

❷
❸

❹

❺

❻

❼

DIFFERENT CORES 
FOR DIFFERENT 
NEEDS

Choose the Core that best sits 

your installation’s needs. The 

Integrated Cores (250i and 

5ooi) are more cost-effective, 

while larger Enterprise Cores 

(1100 and 3100) can handle far 

more channels.

Enterprise Core 3100

1.2

party peripherals.

❶

❷

❸
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1.3 TAKING THE LID OFF

Q-Sys Cores are assembled at 

QSC Audio Headquarters in 

Costa Mesa, CA, in the same 

facility as many of QSC’s most 

powerful and trusted amplifiers.

The heart of the Q-Sys 

centralized processing architecture is the Q-Sys Core. 

The Core runs QSC-developed DSP algorithms under a customized Linux operating 

system running on Intel® microprocessors and motherboards. 

Q-Sys doesn’t depend on proprietary DSP hardware that is sustained exclusively by 

narrow, specialized markets. Instead, advances in processing power are driven by the 

entire global IT industry, and software improvements don’t require new hardware.

The Q-Sys Core is available in multiple sizes tailored to the varying requirements of 

different facilities. The Enterprise Cores 1100 and Core 3100 are each designed to 

work with inputs and outputs provided by one or more external I/O Frames. The 

Integrated Cores 250i and 500i combine I/O Frame and Core functionality into a 

single integrated unit supporting up to eight internal I/O cards. The size and scope of 

your project will determine which Q-Sys Core is right for you.

Core 250i – A total of 64 flex channels with up to 32 
channels of integrated I/O (eight card slots) onboard 
and up to 32 AEC conferencing channels.

Core 500i – A total of 128 flex channels with up 
to 32 channels of integrated I/O (eight card slots) 
onboard and up to 48 AEC conferencing channels.

Core 1100 – A total of 256x256 channels with up to 
4 channels of integrated I/O (one card slot) onboard 
and up to 96 AEC conferencing channels.

Core 3100 – A total of 512x512 channels with up to 
4 channels of integrated I/O (one card slot) onboard 
and up to 192 AEC conferencing channels.

This Intel hardware already 

meets industry-best 

reliability standards and 

is used in many of the 

world’s most mission-critical 

projects. 

KEEP GOING!

If the eight I/O Card slots on 

the Core 250i and 500i aren’t 

enough for you, you can 

always continue to add I/O 

Frames with these Cores just as 

you can with the others. 
Core 250i/500i

Core 1100/3100

1.3
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1.4 Q-SYS I/O FRAME

Each Q-Sys I/O Frame can be customized to your I/O needs, giving you the ability 

to install up to four I/O Cards. 

 

The front panel of the I/O Frame is very similar to that of the Q-Sys Core. You will 

see that the I/O Frame’s front panel has four sets of I/O STATUS LEDs, one for each 

I/O Card.

1. The I/O Card STATUS LEDs on the 

front panel are used to monitor the 

audio signal. There are four LEDs, 

one for each channel.

OFF means no audio.
GREEN means signal present.
YELLOW means 3 dB before clipping.
RED means audio clipping.

❶

2. The LCD display on the I/O Frame operates similar to the Q-Sys Core. 

The main indicator is a monochrome LCD graphics display. It displays basic 

housekeeping information about the I/O Frame.

3. You can cycle through these menus by using the PAGE button to the right of the 

LCD screen.

4. To the right of that button is the ID button. This button allows you to identify this 

device in the Q-Sys Designer software. This function will be especially useful on 

the I/O Frame. 

5. The POWER LED will be blue when the I/O Frame has a good main AC input.

Much like the main display on 

the Core, the I/O Frame can 

display various information:

• The name of the I/O Frame

• The name of the design that 

the system is running

• Network settings

• Device model and Firmware 

version

• I/O Card Slot information

❸❷ ❹

Here are two common 

scenarios of how the ID button 

is typically used:

•   A technician can push this 

button to cause this device 

to be identified in the Q-Sys 

Designer software status 

component.

 

•   A technician can activate 

this function from the software 

to cause the LCD panel to 

blink. When you have an entire 

rack full of I/O frames, this 

function can be very helpful in 

identifying the right I/O Frame.

❺
❻

IDENTIFICATION, 
PLEASE ... ?

THIS LOOKS 
FAMILIAR ...

OFF means the I/O Frame is not in the current design schematic.
AMBER means the I/O Frame is starting or stopping a design.
GREEN means the I/O Frame is running a design.
RED means the I/O Frame is offline.

6. The device 

STATUS LED has 

four different 

states:

1.4
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Next take a look at the I/O Frame’s back panel.

1. There are four available Audio I/O Slots for I/O card installation. The different 

types of cards will be covered in detail in the next section. One important thing 

to note at this point is that all card slots must be filled in each I/O Frame. QSC 

manufactures blank cards plates if you don’t need to populate all four slots. 

The blank cards help to block external RF interference from getting into the I/O 

Frame. The I/O-Frame 8s is a larger IO-Frame that can hold eight card slots, 

which increases the channel count accessible for CobraNet and Dante cards. You 

can learn more about this device in the Peripherals seciton of this course.

2. Like the Q-Sys Core, the I/O Frame has two Gigabit Ethernet connections used 

for Q-LAN streams between the I/O Frame and the Core.

The Q-Sys Core contains a number of inputs that allow for third-party peripherals 

integration:

3. The Serial RS232 connection port connects to an external device that supports 

an RS232 control such as a professional CD/DVD player or video matrix switcher.

4. Each I/O Frame has one GPIO connection. With the help of Q-Sys Designer, the 

GPIO allows for connectivity to potentiometers, buttons, switches, LED/lights, 

relays, etc. – basically anything that interfaces with GPIO.

5. The I/O Frame is also powered by a universal power supply.

❶
❷❸❹ ❺

What is the difference between 

audio streams and audio 

channels? If you’re not sure 

exactly what your I/O Frame 

can handle, you should check 

out Lesson 11.3: Audio 

Channels vs. Audio Streams 

(page 160).

1.4
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1.5 Q-SYS I/O CARDS

Now that you understand the Q-Sys Core and the I/O Frame, take a look at the 

many card options.

CIML4 – This is a four-channel 
industry standard Mic/Line 
Analog Input Card. Its dynamic 
range matches the specs of almost 

every DSP box so it’s perfect for most medium-to-high level analog inputs. 48-volt phantom 
power is available on each channel, selectable by Q-Sys Designer software.

COL4 – The Analog Line Output 
Card gives you four channels of 
balanced connectors. It’s primarily 

used for line-level output to non-DataPort amplifiers, recording devices, and tele-
conference systems. 

CODP4 – By using DataPort-
enabled QSC amps, you can take 
advantage of the features provided 

by the DataPort™ Output Card. This card allows for four channels of audio line-level 
output (two channels per port), plus send control data while simultaneously receiving 
amplifier monitoring and status data. The DataPort card also provides DSP for loudspeaker 
processing and peak voltage protection as well as monitoring each loudspeaker line for 
open or short circuits.

When it comes time to choose 

between the two, here is an 

example to help you decide: 

If you are looking to get 

a microphone input for a 

standard meeting room or 

for general public address 

purposes, choose the CIML4. 

On the other hand, if you are 

planning to connect a studio 

grade microphone or taking 

the line signals off a very 

high-end console, choose the 

CIML4-HP.

1.5

CIML4-HP – This is a High 
Performance Mic/Line Analog 
Input Card, with broadcast quality 
microphone preamps. Much like 

the CIML4, this card also provides four channels of microphone and line-level analog 
audio input. However, the HP version gives you a lot more dynamic range and higher 
performance A/D converters and pre-amplifiers than the CIML4. It also has 48-volt 
phantom power available on any channel selectable by the software.
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CAES4 – The AES-3 Digital Input/
Output Card allows four channels 
of input and four channels of output 

simultaneously. If you filled an I/O Frame with four of these cards, you’d be able to achieve 
sixteen channels of input as well as sixteen channels of output from a single I/O Frame.

CCN32 – The CobraNet™ Digital 
Input/Output Card can be set up 
in four different modes: 4x4, 8x8, 

16x16, and 32x32. In an I/O Frame, the CobraNet card can be used in 4x4, 8x8, and 16x16 
mode, whereas inserting it into a Core allows all of these as well as the additional 32x32 
mode.

1.5

CDN64 - The Dante Bridge Card 
for Q-Sys is a solution to bridge 
Dante-enabled sources (such as 

wireless microphones and digital mixers) directly into the Q-Sys ecosystem for advanced 
processing and redistribution over Q-LAN for larger LAN and WAN IT infrastructures. 
Ideal for integrating Dante-enabled “front of house” input and output sources in theaters, 
auditoriums and houses of worship with the “back-of-house” or “facility-wide” Q-Sys 
integrated platform.

CIAES-16 - The 16-channel AES/
EBU Input Card provides 24-bit 
digital input to interface with an 
existing installation. It accepts 16 

channels of AES/EBU (AES3) digital audio on a single card, and uses IT industry-standard 
RJ45 connectors.

An AVB Bridge Card is also available that integrates AVB networks with Q-Sys.
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1.6 HARDWARE PERIPHERALS

The Core makes up the heart of the Q-Sys system, and the I/O Frame is considered 

one of its peripheral devices. There are a number of other peripherals you may 

have as part of your network as well. Each peripheral connects to your gigabit 

network using standard CAT5e cables and is capable of simultaneously connecting to 

a redundant network as well.

THE I/O-22

The I/O-22 is a compact standalone I/O Box 

intended to be used when audio sources and 

destinations are physically spread out, such as 

the individual seats in a conferencing system or 

different rooms in a multi-room venue.  Each 

I/O-22 provides two mic/line inputs and two 

line outputs, is powered over the Ethernet, 

and includes an 8.5 watt mono amplifier to 

drive a local monitor speaker (when using PoE+, 

the I/O-22 can do 10 watts).

Compact in size, the I/O-22’s mounting plate lets 

it be used in numerous hideaway locations such 

as under a desk or attached to a rack tray.

SO MANY 
INPUTS!

Q: If there are inputs and 
outputs on the Core, the I/O 
Frame, and the I/O-22 as well, 
how do I know which to use?

A: The answer depends on 
a combination of the size of 
your system and the proximity 
of your audio to its network 
access. In small systems, the 
built-in I/O Cards on the Core 
may be enough to handle all 
your audio. In larger systems, 
I/O Frames are used to bring 
your I/O Cards closer to audio 
sources and destinations that 
are not located physically 
close to the Core. The I/O-22 
is a smaller, discreet device 
used specifically for multiple 
sources/destinations that 
are physically spread out 
throughout a room.

1.6

THE I/O FRAME 8S

The I/O Frame 8s may look like a Core, with good reason. It provides an integrated 

Core’s higher capacity for I/O Cards (eight I/O slots) as a peripheral device, allowing 

for remote bridging of complicated networks such as CobraNet, Dante, and AVB ... up 

to 128 inputs and 128 outputs. 

And of course, any I/O Cards can be used in the I/O Frame 8s if you simply want to 

have eight slots rather than the four available on a standard I/O Frame.
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PAGE STATION

The rugged networked Page Station 

peripherals are part of the sophisticated 

Q-Sys Paging system.

Available with either handheld or gooseneck microphone 

options, each Page Station is designed for either desktop or wall-

mounted installation, contains a 240x64 monochrome graphics 

LCD display, a capacitive touchpad that offers visible feedback 

and audible cues, and is powered over Ethernet.

The PS-X is an additional accessory that provides a 

secondary remote microphone, for applications such as 

an airport gangway or rail platform.

PS-X

Different models have a different number of customizable 

command buttons or a full numeric keypad.

For a complete walkthrough 
of how to integrate your Page 
Station peripherals into your 
design, try the Public Address  
chapter on page 164.

1.6
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TOUCHSCREEN CONTROLLERS

The QSC TouchScreen Controllers offer 

full-color access to the audio system. Facility 

managers can selectively enable which 

permissions are available at each Touchscreen, 

which display a User Control Interface that 

can be creatively designed with the Q-Sys 

Designer software.

When designing your system, every peripheral that is properly connected to your 

Gigabit network will be discoverable by the Q-Sys Configurator. In order to make 

a peripheral accessible in your design, simply go to the Inventory pane, click 

the Plus Icon, select Peripherals, and add your device to your design. For more 

information on this process, check out the Configurator tutorial on page 61.

ADDING PERIPHERALS TO YOUR DESIGN

The TSC-3 features a 3.5 inch screen, has one 10/100 network port, and is powered 

over the internet. It is available in either black or white. The discontinued TSC-8 uses 

a 12V power cable. For information on future touchscreen controllers, visit the Q-Sys 

peripherals on qsc.com.

It sure is! To learn more about 
how to design User Control 
Interfaces for a TouchScreen 
(or a desktop, iPad, or iPhone) 
check out “Exercise 4.9: 
The User Control Interface 
(UCI)” (page 93).

TSC-3
TSC-8

iPhone

HEY, IS THAT 
AN iPHONE?

1.6
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DAB-801

CXD-Q AMPLIFIERS

PTL-1

AMPLIFIER AND I/O FRAME BACKUP ACCESSORY

Q-SYS ACCESSORIES

PILOT TONE LOAD

The DAB-801 provides true N+1 amplifier redundancy to any Q-Sys system, plus 

the ability to automatically switch amplifier input sources from a primary I/O Frame 

to a backup I/O Frame. This provides redundancy, emergency pagin, and other 

functionality for many Life-Safety and Evacuation or mission-critical audio systems.

Although not strictly a Q-Sys 

accessory, the CXD-Q Series 

of amplifiers are designed 

specifically to seamlessly integrate 

with a Q-Sys system. Each of the 

three models in the series has 

four routable inputs on the rear panel that act as remote input sources to Q-Sys. In 

essence, the CXD-Q is both an amplifier and an I/O-Frame. 

The PTL-1 is a Q-Sys accessory that provides an end-of-line 22kHz impedance soak 

for 70V and 100V distributed loudspeaker circuits. Used in combination with QSC 

DataPort or CXD platform amplifiers, the PTL-1 allows the Q-Sys system to monitor 

shorts, opens, and other faults in a loudspeaker line, even in real time.
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1.7 DATAPORT: FUNCTIONALITY AND ADVANTAGES

The Q-Sys system stands apart when using DataPort-enabled QSC amplifiers. 

Once connected, a whole new level of system supervision is available. The DataPort 

provides amplifier and load monitoring information to be sent back to the system 

operator. 

 

You gain the benefit of these added 

parameters:

• Load voltage, current and impedance

• Open and short circuits

• Pre and port DSP clip monitoring

• Thermal readings

• Power/Standby Status

 

 

You can even set up the system to alert you, for instance, if someone has walked 

into your amp room and physically adjusted the settings of the amplifier on your 

network. 

Ease of Installation: Each connection carries two channels of balanced audio 

as well as all of the monitoring information. This makes for a very easy installation. 

There is no need for soldering additional XLR connectors or terminating Phoenix 

Connectors.

1.7
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Remember: DataPorts on four and eight channel (multi-port) amplifiers must be 

wired to DataPorts on the same I/O Frame or the Q-Sys Core. You cannot wire some 

of the amplifier’s DataPorts to one I/O Frame and others on the same amplifier to 

another I/O Frame.

You’ll note that the Q-Sys system is backwards compatible with several of QSC’s 

legacy amplifiers. This means that if you are looking to upgrade an existing system 

with one of these legacy products, you need only to connect to a DataPort card. The 

complete CX and PowerLight™ 3 Series QSC amplifiers are equipped with proper 

DataPort interfaces. 

DATAPORT CABLES

An important note about connecting your DataPort amplifier to your I/O Frame: 
While this connection may look like a standard HD-15 VGA port, it does not mean 
you can use a standard VGA cable. VGA cables typically do not have all 15 pins wired, 
and all the pins are required to properly interface with the DataPort. Will some off-
the-shelf VGA cables work? Well, some might give you satisfactory results. However 
more often than not, off-the-shelf cables will give less than satisfactory results and 
could even cause damage to QSC DataPort amplifiers. On top of that, non-QSC 
DataPort cables may void your warranty. Therefore, QSC recommends that you use 
QSC DataPort cables exclusively, which are available through the service department.

Just because it fits doesn’t 

mean this standard VGA cable 

is the correct choice!

USING AMPLIFIERS WITHOUT QSC DATAPORTS

You can certainly use Q-Sys with standard amplifiers lacking a DataPort, but you will 
not have access to the extended system functionality. The simplest way to do this is to 
connect a COL4 output card to the inputs of the amplifier, but it will not give the user 
any load monitoring, temperature status, etc. 

Note: The CODP4 DataPort 

card is not compatible with 

the ISA amplifier’s limited 

DataPort V2 connector. For ISA 

amplifiers, QSC recommends 

using the COL4 output card.

ISA SERIES

1.7
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1.8 SYSTEM REDUNDANCY

There are a number of ways to integrate redundant components in your Q-Sys 

system for protection in the event of physical hardware failure. For every Core and 

I/O Frame on your network, you can include an additional Core or I/O Frame that 

is configured to be redundant and will take over whenever the Primary unit goes 

offline.

In addition, each unit has two Ethernet ports on its Back Panel, allowing you to set up 

an entirely separate network that will take over if your primary network fails.

When setting up your unit in 

the Designer software, go to its 

Properties panel and change 

the Is Redundant field to Yes, 

and enter the backup unit’s 

name in the Backup Name 

field.

HOW DO I 
CONFIGURE A 
REDUNDANT 
UNIT?

1.8
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DataPort amplifiers can be backed up as well with the use of the DAB-801, 

which configures five 2-channel QSC DataPort amplifiers so that the fifth amplifier 

automatically kicks in if a problem is detected with any of the other four (4+1 

redundancy). A second DAB-801 may be added to implement 8+1 redundancy. 

Note that you cannot use 8-channel amps with the DAB-801.

Total system redudancy is achieved by implementing all four primary redundancy 

types: Core, I/O, network, and amplifier. In mission-critical applications - particularly 

those involving life safety - it is imperative to ensure continued operation of an 

emergency paging system, even when individual components are compromised by 

an adverse event such as power failure, fire, or flood. Eliminating any single point of 

failure provides the best possible protection for your system.

BACK
UP

BACKUP YOUR LIFE!

If you make a Backup of 
yourself, then you can stay 
home all day and have your 
Backup do all the work!

1.8
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1.9 I/O CARD INSTALLATION

1.9

When ordering a Q-Sys Core or I/O Frame from QSC, you have the option to 

configure your device to order (CTO) with your custom I/O Card selections on 

qsysconfigurator.com

However, if you need to 

order a non-CTO unit or 

if you are upgrading an 

existing device with new 

I/O Cards, this section will 

describe how to properly 

install an I/O Card into the 

device.

BEFORE YOU GET STARTED: 
THE IMPORTANCE OF BLANK CARDS

Q-Sys Cores and I/O Frames are not designed 

to run with empty slots. This is why a new 

device will come pre-filled with Blank Cards, 

which can then be replaced with I/O Cards. If 

you do not intend on using an I/O Card in every 

available I/O slot, you need to use the included 

Blank Cards in each of the remaining slots. 

The Core 250i, 500i, and IO-Fram 8s each have 8 I/O Card Slots. 

I/O Frames have 4 I/O Card Slots. 

Enterprise Cores (Core 1100 and 3100) have 1 Card Slot. 

 

If it has not been configured to 
order, your device will come 
with Blank Cards. To install 
an I/O Card, you will need to 
uninstall the Blank Card that is 
in the desired slot.

FILL IN THE BLANK!

screenshot from www.qsysconfigurator.com
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1.9

TYPE 1 vs TYPE 2
You also want to be sure that you are ordering the right type of card, namely 

Type 1 or Type 2. Both types have the same functionality, but use different 

connections. Older Q-Sys devices use Type 1 Cards which use a ZIF connector,  

while Type 2 Cards use a more standard IDC connector. 

TYPE 1 TYPE 2

The easiest way to determine if your 

device requires Type 1 or Type 2 I/O 

Cards is to look at its serial number 

on the back of the chassis. The first 4 

digits of the serial number represent 

the month and year that the device 

was manufactured. Devices made in 

April 2012 or earlier (0412) require 

Type 1 I/O Cards, while devices made 

in May 2012 or later (0512) will use 

Type 2 I/O Cards.

PREPARATION
You’ll need a screwdriver, small wire cutters, and an anti-static wrist strap or anti-

static work mat. If you do not have access to these anti-static devices, be sure to 

occasionally ground yourself by touching the chassis to dissipate your body’s static 

charge, and only handle the circuit boards by their edges. This will provide a minimal 

static safeguard, but using anti-static tools is recommended. If you are using a 

power screwdriver, be sure to set it to a very low torque setting. 

YOUR DEVICE
HAS A BIRTHDAY

This device on the top was 
made in June of 2012, so it 
uses Type 2 Cards. 
 
 
This device on the bottom was 
made in October of 2011, so it 
uses Type 1 Cards. 
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For the screws in the body of the card, you will use stand-off 

screws that will provide the attachment points for the card 

above it. Regular screws will then be used on the top card that 

attaches to these stand-off points.

3. Before moving on to install additional I/O Cards, connect the data cable to the 

motherboard. The connection points on the motherboard will be labeled with 

letters corresponding to the position of the I/O Card, which you can identify by 

looking at the rear panel. 

1.9

I/O CARD INSTALLATION
1. Remove all ten screws that attach to the device’s top panel - there will be four 

on the back and three on each side. Set the cover aside.

2. Uninstall the existing or Blank I/O Cards, starting with the one on top. Each card 

uses six screws to secure it in place - four in the body of the card, and two to 

attach the faceplate through the rear panel. When installing a new card, you may 

need to detach this faceplate first before setting the card in position. 

MULTI-TOOL

If you are using a screwdriver 
with an interchangeable bit, 
the empty bit housing is the 
perfect size to use on the 
stand-off screws. Once again, 
if you are using a power 
screwdriver, be sure to turn its 
torque settings to low.

OR

 

Type 1 cards use a ZIF connector. Carefully 

unlock the brown flap, insert the ribbon with 

the blue side up, and lock the flap down again. 

Be sure that the ribbon is straight and fully 

seated. 

 

Type 2 cards use an IDC connector. Line up 

the notches and insert the connector until the 

two levers on either end engage and lock the 

connection.

TY
P

E 
1

TY
P

E 
2

BREAK IT 
DOWN,
BUILD IT UP

If you are replacing a card on 
the bottom, you will have to 
uninstall all of the cards above 
it first, and then reinstall them 
one by one after you have 
replaced your card.
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1.9

4. Continue installing all cards and cables until all slots are filled again.

5. Use the included cable ties to loosely collect the data ribbons to the chassis 

lances. The cables should not be tight or deformed, this is simply to keep them 

from moving around too much. 

If you are working on a Core 250i or 

500i, you will also have to tie the data 

ribbon from the GPIO port to the top 

stand-off screw of the I/O Cards, to 

prevent this ribbon from touching the 

motherboard or power supply. In this 

instance, you will have to squeeze the 

ribbon to slightly deform it.

6. Once you are done with the cable 

ties, use your wire cutters to snip 

the ends of the ties off as closely to 

the buckle as possible to avoid any 

sharp ends inside the device.

7. Reinstall the top lid.

8. Supply power to the unit and wait for it to boot. You can use the Page or 

Next button to toggle the display screen and see if the I/O Cards are properly 

installed. If the correct information is not displayed here, you may need to 

double check that all the data cables are secure and that no other connections 

were accidentally dislodged during installation.
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• Explore the main areas of the Q-Sys Designer software

• Familiarize yourself with the general layout of the workspace, adding 
Inventory to your design, and methods for wiring components together

• Navigate the various panels of the left- and right-side panes.

Software Overview

In This Chapter:

The Q-Sys Designer software allows you to build your audio design on a computer 

to be loaded to the Q-Sys Core. This chapter is designed to get you comfortable with 

the way Designer operates, and familiar with the location of its tools and features. 

There’s no reason to waste valuable time trying to hunt down what you’re looking for 

when all the tools you need to create a dynamic system design are literally at your 

fingertips. So let’s get started!

CHAPTER MAP
2.1  LEARNING THE 
BASICS  page 27

2.2  UNDERSTANDING 
COMPONENTS page 28

2.3  SETTING UP YOUR 
CORE  page 32

2.4  ADDING AN I/O 
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2.7  SIGNAL NAMES  
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2.10  CREATE A 
COMPLETE SIGNAL PATH 
page 44

2.11  ALTERNATIVE 
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page 45

2.12  THE SCHEMATIC 
LIBRARY  page 47

2.13  CUSTOMIZING 
COMPONENTS page 49

2.14  GRAPHIC TOOLS  
page 53

2.15  THE LEFT-SIDE 
PANE  page 56

2.16  MAXIMIZING 
AUDIO CHANNELS 
(FAN-OUT METHOD)  
page 58
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LEFT-SIDE PANE

The Left-Side Pane has six accordion-style panels labeled Inventory, Schematic Pages, User 

Control Interfaces, Snapshots, Named Controls, and Design Inspector. These panels let you 

add inventory to your design, manage the layout of your Schematic and Interface pages, customize 

controls for internal and external use, and check the integrity of your design.

THE SCHEMATIC 

The Center Pane of the Q-Sys Designer workspace is called the Schematic. This is where your 

Q-Sys system is designed. From the Schematic, you can organize, connect, and configure Schematic 

components, write scripts, test control logic and audio signal flow, and operate and adjust the system.

RIGHT-SIDE PANE 

The Right-Side Pane has several collapsible panels specific to what is currently selected. The Graphic 

Tools, Schematic Library and User Library are always available, providing you with a library of 

virtual DSP components, control components, and visual tools for creating your design. When working 

on a component in your Schematic, there will also be a Properties panel that lets you customize and 

configure that particular component, as well as access its additional Control Pins.

2. Click on the double-arrow icon at the top 

of the Side Panes to collapse them, and 

then to expand them again.

3. Alternatively, you can drag the border between the Side Pane and the Schematic 

to the left or right to manually adjust the size of the Pane.  

ADVANCED ZOOM 
CONTROL

Expert users may be interested 

to learn some keyboard 

shortcuts for viewing your Side 

Panes and the Schematic. If 

you hold the Control key and 

scroll your mouse wheel, the 

Schematic will zoom in and 

out. If you hold the Control 

and Shift keys and scroll 

your mouse wheel, all three 

sections will zoom in and out. 

Use these shortcut keys to 

find a size that’s comfortable 

for you.

FOR MORE
INFORMATION

The different panels of the 

Left-Side Pane will be detailed 

in Exercise 2.15 (page 56).

EXERCISE 2.1: LEARNING THE BASICS

1. Open the Q-Sys Designer Software. You’ll notice there are three main 

sections, divided vertically.

LEFT-SIDE PANE THE SCHEMATIC RIGHT-SIDE PANE

2.1
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EXERCISE 2.2: UNDERSTANDING COMPONENTS

You should get used to some of the vocabulary that will be used to describe 

elements inside the software. As you’ve already noticed, the Schematic refers to 

the bright workspace in the middle of the screen. You can drag elements from the 

Side Panes into your Schematic. Most of these are called components, and will be 

represented by a rectangular box in the Schematic.

1. In the Schematic Library, expand the Audio Components branch.

2. Expand the Audio Players branch by clicking the triangle next to it.

3. Drag an Audio Player into your Schematic. 

 

This is a component. It is identified by 

the label in the middle of its rectangle. 

Components may have small shapes on 

their sides – these are called pins. Pins 

are input and output ports with which 

you connect the components together.  

Pins on the left side represent audio 

coming into the component, and pins 

on the right side represent audio leaving 

the component. Hovering your mouse 

cursor over a Pin will give you more 

information about its function. This 

Audio Player has two output pins for 

Track 1 and Track 2, represented by 

two small circles.

COMPONENT PIN

You can drag and move components and other elements 

anywhere you would like in the Schematic. You may have 

noticed that there is no grid in your workspace, but the Designer 

software uses automatic alignment lines to keep your layout 

well-organized. You’ll see these alignment lines in the next step.

2.2
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ALIGN, 
DISTRIBUTE, 
PACK, & ORDER

Feel free to spend a few 

minutes learning how each of 

these options will arrange the 

components in your Schematic. 

Highlight multiple components 

and then arrange them. Align 

will align them along the same 

vertical or horizontal axis, 

Distribute will standardize the 

distance between them, Pack 

will align them and also pack 

them right next to each other, 

and Order lets you layer them  

in front or behind each other, 

as well as Lock or Unlock their 

movement.

4. From the Schematic Library, drag a Crossfader into your Schematic. 

 

As you drag this component close to your Audio Player, you’ll notice the red 

alignment lines help you snap the components so that their edges are aligned. 

 

 

 

 

 

 

If you drag two components together, a green vertex will show you where their 

corners touch. 

 

If components are overlapping layers, you can right-click and use an Order 

option to bring one component to the front or to the back. If you highlight 

multiple components and right-click, you can arrange them in a number of ways 

by using the Align and Distribute options. 

 

In order to group multiple items, Q-Sys Designer supports the same highlighting 

methodology as AutoCAD: 

 

If you create a selection box by moving your cursor from left to right, 

(creating a solid blue selection box) then anything you FULLY enclose will 

be highlighted. 

 

 

 

If you create a selection box by moving your cursor from right to left, 

(creating a dashed green selection box) then only elements that are 

touched by the edge of the box will be highlighted.

2.2

YOU CAN’T TELL 
ME WHAT TO DO!

If you don’t want your edges 

to auto-align, simply hold the 

Control button while moving 

a component to disable this 

feature.
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QUESTION: “Where is the 

Properties panel? I don’t see 

it!”

ANSWER: The Properties 

panel for a component is only 

visible in the Right-Side Pane 

when you have selected that 

component in the Schematic. If 

you have multiple components 

selected, you will only have 

access to Properties that all 

of your selected components 

have in common. Also, 

the Properties will only be 

available to edit during design 

mode, and not in Emulation 

Mode or when connected to 

a Core. Learn more about 

Emulation Mode on the next 

page.

You can also change the color of any component by selecting a new color in the 

Fill field in that component’s Properties panel. 

The last thing you’ll need to know about the basics of components is how to 

use them. Double-click on any component and a window will open. This is the 

component’s Control Panel. Control Panels are where you monitor or make 

adjustments to the component.  

Every object inside a Control Panel is a Control. Controls can be dragged and 

copied onto the Schematic, and they will still retain their functionality to their 

parent component.

ADVANCED TIP:
Here’s a very helpful tool you might want to master early on: the Find feature. If you drag a copy of 

a control out of its Control Panel into the Schematic, you might later forget which component that 

control originated from. Simply click on the control in question and press Ctrl+F on your keyboard to 

open the Find window. You’ll notice an option that says Jump to source of control, which will open 

up the Control Panel for the parent component and highlight the control within it. You can also do this 

in reverse. From within a Control Panel you can click on a control that you have copied elsewhere in 

your Schematic and press Ctrl+F – now you will see an option that says Jump to copy of control 

which will bring you to the copy (if you have multiple copies, it will even offer to Jump to next 

copy). You can also use the Find feature to search for controls and components by name by changing 

the Find By field to Label instead of Context, and then type in what you are looking for.

THE FIND WINDOW

2.2
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2.2You may have noticed that 

none of the buttons in the 

Audio Player’s control panel are 

functional. Why not? It all has 

to do with which Mode you are 

currently in.

ADMIT IT!

You pressed that 

Play button the 

instant you saw 

it. So why didn’t it 

work?

UNDERSTAND WHICH MODE YOU ARE IN!
The Designer software has a few different modes, and you can only accomplish certain 

tasks based on which mode you’re in. You will change modes constantly while working 

in the software, so it’s best to understand what you can accomplish in each one now!

DESIGN MODE (F7) 
When you open the software, you’re in Design Mode. In this mode, you can add 

components to your Schematic, wire them together, drag controls around, and 

configure their properties. Basically, this mode is where you construct the design, but 

nothing is functional. The same way a plumber can only connect pipes when the water 

valve is off, or en electrician will work on the physical wiring of a room only when the 

circuit breakers are off. As the audio engineer, any layout changes to your signal path 

have to be performed in Design Mode, when there is no audio being processed.

RUNNING ON THE CORE (F5) 
In order to activate your design, you need to save it and run it on the Core. You can do 

this by pressing F5, or by selecting Save to Core & Run from the File menu. Once 

the design is running, you can operate all of the controls in the control panels, but you 

cannot make any layout changes. You wouldn’t want to rewire an electrical junction 

box with the power still on, would you? In order to make layout changes again, you 

need to disconnect from the Core by pressing F7 (or select Disconnect from the File 

menu).

EMULATION MODE (F6) 
If you don’t have access to a Core, or haven’t properly configured yours yet, don’t 

worry! You can still test out most of the functions of your design by using Emulation 

Mode, by pressing F6 or selecting Emulate from the File menu. Emulation Mode 

simulates the act of running on a Core, letting you make adjustments to most of the 

controls in your design. The only functions unavailable to you are those that require 

actual audio, since audio processing takes place on a Core. Which means, sorry, that 

the Audio Player still won’t play anything until you’re connected to a Core.
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EXERCISE 2.3: SETTING UP YOUR CORE

The Inventory panel in the Left-Side Pane represents all of the physical devices that 

are part of your Q-Sys network. Since every design needs a Core to operate, your 

inventory will always default with a Core.

YES...
... you can name your Core 

Bob. Or Fred. Just don’t call 

it Sparky, please. We don’t 

appreciate the implications.

1. Click on your Core (Default is “Core-1”).

2. Go to the Core Properties panel in the Right-Side Pane.

3. Click on the Name field 

to give your Core a name. 

You can choose any 

name you like as long as 

it does not begin or end 

with a hyphen. In a real 

system, it is critical that 

the name of this virtual 

Core matches the name 

of the physical Core on 

your network. But for this 

exercise, you can simply 

rename it “Core-A”.

4. Notice that its name change has been reflected in your Inventory.

2.3
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5. Click on the Location field to rename the default location to something more 

helpful to you. For this exercise, simply rename it “Rack 1”.

6. Once again, notice that this location’s name has changed in your Inventory.

CHANGING THE
LOCATION ...

... is not a mandatory function, 

but can be very helpful when 

organizing multiple racks, or 

an entire rack room for that 

matter! 

UPGRADE CITY!  When you 

order your Core you can have 

it upgraded to handle more 

audio tracks! The onboard 

Media Drive upgrades allow 

you to  increase the storage 

capacity of your Core, while 

the MTP-128 upgrade increases   

the number of tracks you can 

play simultaneously from 16 

to 128! For more information 

on how to upload audio to 

the Media Drive, check out 

“Exercise 3.7: Audio Files” 

(page 75).

❶

❶

7. Click on the Model field 

to choose the correct Core 

model you are using.

8. If you are creating 

your system to have a 

redundant Core, then 

change the Is Redundant  

field to “Yes”. This will bring 

up a Backup Name field. 

Rename this redundant 

Core to “Core-B.”

9. If you choose to install an 

I/O Card into the Core, click on the I/O Slot drop-down menu and choose the 

appropriate I/O Card. For this tutorial, select the AES3 In/Out Card. There will 

be a different number of Card Slots available depending on which Model of Core 

you have selected.

10. Notice that AES3 Input and Output slots are now part of your Core’s Inventory.

11. The Audio Tracks field allows you specify the number of stored media tracks 

your core is capable of handling. By default each core has the ability to play up 

to 16 simultaneous media tracks (MP3 or WAV). Leave this set to Default. 

12. Network Receive Buffer lets you stretch the buffer beyond the default 2.5ms 

audio I/O latency sync requirement, up to an extra 1ms. This would only be 

necessary for VERY LARGE networks. Leave this set to Default.

13. The Clocking tab lets you adjust the sample rate of your clock, the clock source 

(you can choose one of your Core’s GPIO slots to handle the clock), or change 

the clock domain. Leave these options alone for this exercise.

❷ ❷

❸

❸

❹

❹

❺

❺

❻

❻

❼

❼

2.3
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There are several different components that represent parts of the Core, and to 

access one you need to drag it from the Inventory into your Schematic.

14.  Drag the Status component from your Core Inventory into your Schematic.

15.  This component’s Properties pane is the same as the one you just adjusted, but 

you now have access to its Control Panel. Double-click the component to access 

this Control Panel.

❶  The large grey bar at the top is your Core’s Status. Since you’re not running your 

design, this is inactive. When your design is running, this should be green to indicate that 

your Core’s status is good.  

❷  The Identify Device, or ID button, can be very handy. Clicking on it in the software will 

cause the LED screen on your actual Core to flash, verifying that you are connected. If you 

are using a designated redundant Core, its LED screen will flash as well. You can also press 

the ID button on the front of your Core, and this icon will flash inside the Designer software.

❸  Clock Master and Clock Offset let you monitor the status of your Core’s clock.

❹  Temperature displays the temperature of the Core, measured in Celsius.

❺  Audio File Sync will be highlighted when your Backup Core’s audio is fully synced with 

your Primary Core. Backup functionality will be disabled if you did not specify your Core as 

“Is Redundant”.

❻  Primary and Backup sections indicate which of your Cores is Active and which is in 

Standby. To change from one to the other, select Go Active on the inactive Core.

❼  If you go to your Core Properties panel, you will see a field called Verbose under 

Clocking. Changing this to “Yes” will give you access to more information in the Control 

Panel for monitoring your network.

“Wow, that’s helpful!”

When you start creating User 

Control Interfaces (UCIs for 

short) you’ll notice that there 

is a default Interface called 

Inventory Status. This UCI is 

automatically populated with 

the status bar indicators from 

the components of every item 

in your inventory. This is a 

quick and easy way to check 

on all of your devices at a 

glance without opening each 

of their component’s control 

panels one by one.

❶ 

❷

❸ 
❹
❺ 

❻

ADVANCED TIP:

2.3
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It’s time to add more to your design’s Inventory. You have the choice of Amplifiers, 

Loudspeakers, Peripherals, or Streaming I/O. 

1. Click on the “plus” icon located on the far right of the Inventory bar.

2. Click on Peripherals.

3. Click on I/O Frame.

You’ll notice an I/O Frame has now been added to your Inventory in a new Default 

Location. Much like the Core, you can now click on this I/O Frame and adjust its 

properties in the Properties panel in the Left-Side Pane.

4. Change the Name or Location of your I/O Frame.

5. You can select whether this I/O Frame is running a redundant I/O Frame as well 

as a redundant network.

6. I/O Slots let you specify which customizable I/O Cards you have installed in 

your frame. For this exercise, select a Mic/Line Card for one of your slots, a 

Data Port card for two of your slots, and a Line Out Card for the final slot.

Just like the Core, you can also drag the Status Component of the I/O Frame into the 

Schematic so that you can monitor your I/O Frame’s status.

You have now learned the basics of how to navigate the Q-Sys Designer software, 

and have familiarized yourself with how to add to your Inventory, change a 

component’s Properties, access its Control Panel, and align multiple components. In 

the next exercise you’ll learn how to link components to each other using Wiring. 

EXERCISE 2.4: ADDING AN I/O FRAME

Don’t stop now! Move on to 

the next section!

2.4
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Whether you are sending audio from one component to another or connecting 

custom control pins, you’ll need to get your components to communicate by wiring 

them together.

There are several methods of wiring within the Schematic, just as there are in the real 

world.

Wiring two things together 
shouldn’t be this difficult, Doc.

EXERCISE 2.5: WIRING BASICS

You could use Traditional Wiring which connects 

components with a black line, in much the same 

way your vacuum plugs into the wall with a power 

cord ... if you ever use the vacuum.

You could use Signal Names, which let two 

components communicate without messy wires. 

You could think of this the same way that you 

can connect wirelessly to a WiFi network - all 

you have to do is know your neighbor’s router 

password.

Finally there are Signal Snakes which compile a 

bunch of connections into one wireless package. 

You could think of this as a giant electrified snake, 

but doing that won’t really help you learn anything 

about it. Instead, you should complete the next 

exercise.

2.5
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EXERCISE 2.6: TRADITIONAL WIRING

In order to learn about wiring, you’ll need a few components to wire together.

1. In your Inventory, click the plus icon. 

 

 

2. Click on Peripherals > I/O Frame.

3. Click on the I/O Frame in your Inventory, and go to its Properties panel in the 

Right-Side Pane.

4. Change Slot A to Mic/Line.

5. Change Slot B to DataPort.

6. In your Inventory, drag the components from Slot A and Slot B into your 

Schematic.

If you are working on this 
training module just after 
finishing the last exercise, then 
you will already have this I/O 
Frame added. Congratulations, 
efficiency expert! You deserve 
a hefty raise. Skip to Step 6.

Wiring components together happens by connecting their Pins. You’ll notice that the 

Mic/Line In component has no inputs, because its inputs are the physical lines that 

you connect to your actual I/O Frame.

There are different types of Pins:

• Circle Pins represent audio signal.

• Right-Facing Triangle Pins represent data from a DataPort.

• You’ll learn other types of pins as you become familiar with more components.
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3. A black wire has now linked the two channels together. 

4. If you want to make a change, it’s easy to wire them differently. Simply delete 

this wire by clicking on it and press the Delete key. 

5. You can wire multiple channels at once. Create a selection box with your mouse 

to highlight all of the output pins of the Mic/Line In component, and drag them 

to the DataPort. 

 

The channels will automatically wire themselves to the appropriate inputs.

Traditionally your audio signal 
would go through any number 
of digital signal processes 
in the Core (represented 
by components in your 
Schematic) before leaving 
your system again, but for the 
purposes of this exercise we 
will make a simple direct link 
from input to output.

“THAT’S IT?”

You’re now going to wire your Mic/Line In to your DataPort Out. This represents 

external audio being plugged into your I/O Frame, which is routed to the Core 

and processed, then routed back to the I/O Frame and sent out to amplifiers and 

loudspeakers. 

1. Click on the top pin of the Mic/Line component, and hold the mouse button 

down.

2. Dragging the cursor will create a wire. Drag the end of your wire to the top input 

pin of your DataPort component and release the mouse button.
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1. Q-Sys Designer defaults to Bezier-curved wires, but if you prefer straight lines 

you can simply click anywhere on the wire and drag it to create a breakpoint. 

Don’t get carried away.

You can create as many breakpoints on a wire as you wish. This way you could 

keep your wires tidy by routing them however you like. 

 

To delete a breakpoint, simply select the breakpoint and press the Delete key.
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EXERCISE 2.7: SIGNAL NAMES

The second method of wiring components uses Signal Names.

1. Delete any traditional wires you created in the last exercise.

2. Start by clicking on a pin in the Mic/Line component and press the Space Bar. 

You can now type a name of your choice. For this example we will name the 

signal “In 1”. A small label is now connected to the pin, which represents its 

Signal Name.

3. Notice that the end of this signal label is jagged. This means that it is incomplete 

and is not connected to another component. You’ll also notice a warning triangle 

by your Design Inspector notifying you of the error.

4. To complete the connection, click on a corresponding pin on the DataPort 

component, press the Space Bar, and type the same name (“In 1”).

5. As you type it, a drop down menu appears to offer you a selection of pre-existing 

Signal Names if you wish to choose one.

DANGER!

Don’t worry, your Core isn’t 
about to explode. This warning 
icon simply informs you that 
you have incomplete Signal 
Names, and that you should 
probably complete their 
connections before running 
your design. 

QUESTION: If there’ s no 
danger, why is there a picture 
of an explosion?

ANSWER: Explosions are cool.
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1. After completing the signal, notice that the labels are no longer jagged, indicating 

that the connection has been terminated.

You can generate multiple signal names simultaneously to save yourself some time.

2. Delete the Signal Name connection that you just made.

3. Select all of the pins on the Mic/Line In, press the Space Bar, and type in a 

name. When you hit enter, you’ll notice that each of the pins has been assigned 

an ascending incremental value.

4. Now select all of the newly labeled Signal Name labels, and press Ctrl+C to 

copy them. 

5. Select the destination pins on the DataPort component, and press Ctrl+V to 

paste the labels. You’ll note that all of your signals are now terminated.

QUESTION: “It’s been 
terminated? Can I get it back?”

ANSWER: In wiring 
terminology, terminated 
means that both ends have 
reached a terminal, not that 
an android from the future 
has come to kill your signal’s 
children.

6. You’ll notice that once you’ve completed your Signal Name, the warning icon 

on the Design Inspector will disappear. Keep an eye on the Design Inspector 

whenever working with Signal Names to make sure you’ve wired your 

components together properly.
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EXERCISE 2.8: SIGNAL SNAKES

The third method of wiring components uses Signal Snakes. Signal Snakes 

provide a way to reduce a set of signals to a single graphical wire. Signal Snakes are 

comprised of a Signal Snake Input and a Signal Snake Output.

1. Delete any Signal Name connections you made in the last exercise.

2. Click all of the Mic/Lin In output pins and drag them away from the component, 

as if you were going to use a traditional wiring method.

3. Instead of dragging the wires to other pins, press the Space Bar to create a 

Signal Snake Input.

4. Repeat this process from your destination pins on the DataPort component to 

create a Signal Snake Output.

5. You’ll notice that the Signal Snakes have a unique pin shape. You can connect 

these pins using either the Traditional Wiring method or the Signal Names 

method. This lets you transport a large number of inputs to another part of your 

design, or to another Schematic page, with a single connection.

Keep your design organized! Don’t make your wiring paths more complicated than they need to be.

HELPFUL
HINT:

VERY 
IMPORTANT!

You can also add Signal 
Snake Inputs and Outputs 
by dragging them from the 
Schematic Library in the 
Layout branch.

Signal Snakes should have the 
same number of inputs and 
outputs. A Signal Snake Input 
with only one pin, for instance, 
will not “fan-out” that audio 
across all the pins of a Signal 
Snake Output with multiple 
pins. Signal Snakes simply 
transport audio directly from 
pin to pin.
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EXERCISE 2.9: PAGINATION

Because some designs are very large, Q-Sys Designer has the ability to add multiple 

Schematic Pages, and connect components between the pages. This enables you to 

have a large design but still maintain an uncluttered and organized workspace.

1. Add a Schematic Page. There are a few ways to do this. You can click the + sign 

in the upper right-hand corner of the center Schematic pane, or you could go 

to the Schematic Pages panel of the Left-Side Pane and click the + sign at the 

right side of the title bar.

2. Rename the Schematic Page. Simply double-click the current name either on the 

tab at the top of the center Schematic pane, or on the title of the page in your 

Schematic Pages panel.

3. You can reorder the pages by dragging their tabs to their desired position.  

4. To close a Schematic Page, click on the x sign in its tab. This does not delete the 

page or its contents. It is filed away in the Schematic Page section, and all of the 

DSP on its page will still be functioning. This way a user can close a tab they are 

not using and bring it back when they need it.

5. To delete a Schematic Page, select its tab or its title in the Schematic Pages 

panel and press the Delete key.

If you find it helpful to navigate between multiple pages when organizing your 

design, don’t forget that you can wire across pages. Simply create a signal name for 

an element on one page, toggle to another page, and use the same signal name on 

another component to terminate your connection.

ADVANCED TIP:

You can undock a Schematic 
Page from Designer and move 
it elsewhere on your desktop, 
which could be especially 
useful for users with multiple 
monitors. Simply grab the 
Schematic tab and drag it 
away from the workspace 
to create its own window. In 
addition, if you drag one Page 
over another one you’ll see 
the split-screen icon (image 
below). You can split the 
screen between two pages by 
releasing the mouse button 
on one of the icons. This will 
split the screen vertically, 
horizontally, or redock it as 
a tab by selecting the middle 
button.

QUESTION: “Terminate my 
connection? What if I need my 
connection to lead humanity in 
the upcoming war against the 
machines?”

ANSWER: You are fired.

REBUTTAL: I’ll be back.
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EXERCISE 2.10: CREATE A COMPLETE SIGNAL PATH

Now it’s time to put all your knowledge to use. You’ll create an example system that 

contains a complete audio path from input to loudspeaker.

1. Wire your Mic/Line In component to your DataPort component, using any 

wiring method you prefer.

2. Add a PL340 Amplifier and a PL380 Amplifier into your Inventory.

3. Drag the components for these two amplifiers into your Schematic.

4. Wire your DataPort Channels 1 and 2 to the corresponding input of the PL340 

Amplifer.

5. Wire your DataPort Channels 3 and 4 to the corresponding input of the PL380 

Amplifier.

6. Add a Wideline-8 loudspeaker to your Inventory.

7. Drag the component for this loudspeaker into your Schematic.

8. Note the left-facing triangles on the outputs of the amplifiers match those of the 

inputs to the loudspeaker. Wire your amplifier to your loudspeaker.

Keep in mind that in a real design, there would be some kind of EQ and mixing 

happening between your input signal and your output signal. Nonetheless, you have 

now completed your first Q-Sys networked audio system!

“HOW DO I DO 
THAT?!”

“There’s only one input on the 
PL340 Amplifier!”

If you hover over a pin, it 
will tell you what that pin 
represents. You’ll notice that 
these pins represent “DataPort 
1,2” and when you wire them 
together there will be a double 
wire rather than a single wire. 
This is because one DataPort 
pin is carrying two channels to 
the amplifier.

The amplifiers you choose 
to power your loudspeakers 
are at your discretion. It all 
depends on your power needs 
and design. For this example, 
since Wideline-8 is a three-way 
loudspeaker, QSC generally 
recommends the following 
amplifier complement:

HF is powered by PL340.
MF & LF are powered by 
PL380. Since the MF and LF are 
identical drivers and we need 
to maintain the ability to move 
which driver controls the MF 
and LF, they need to be driven 
by the exact same amplifier 
complement.

1. Audio enters the system through the Mic/Line card.

2. The signal is routed to the Core and processed.

3. The Core routes the audio back over the network to the DataPort Card.

4. The DataPort Card sends the audio to the amplifiers.

5. The amplifiers deliver the signal to the loudspeakers. 
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EXERCISE 2.11: ALTERNATIVE LOUDSPEAKERS

There’s a big advantage to using QSC amplifiers and loudspeakers in your Q-Sys 

System: built-in voicing & Intrinsic Correction™. The system will automatically 

recognize these loudspeakers and tune them to their best performance. If you’re 

using non-QSC loudspeakers and you want to tune your speakers, you must add 

a Generic Speaker from the inventory and manually input its tuning data using a 

Custom Voicing component.  

1. Add a Custom Voicing component and a Generic Speaker to your Inventory 

(you’ll find them under “Loudspeakers”). Drag the Status/Control components 

for both of these into your Schematic.

2. Click on the Custom Voicing 

component and go to its Properties 

panel. Change the Name to 

something appropriate, and adjust 

its Band Count to the proper 

specifications.

HOW AM I 
SUPPOSED TO 
KNOW ALL 
THIS?

This information should be 
easily found on the spec 
sheet for your loudspeaker. 
If you do not have the 
original spec sheet, check 
the manufacturer’s website 
or search online for the 
appropriate information.

NON-QSC 
LOUDSPEAKER

Note that the processing 
for a Generic Speaker is 
accomplished in the DataPort 
card, so if you are not using a 
DataPort amplifier, the Custom 
Voicing component has no 
effect.

2.11

4. Input the Speaker Impedance, RMS Power, and Voice Coil Diameter for 

each band of your loudspeaker, and be sure to identify whether or not the driver 

is a Compression Driver.

3. Click on the Generic Speaker 

component and go to its Properties 

panel. Adjust its Band Count and 

be sure to change the Custom 

Voicing parameter to the name you 

just created for the Custom Voicing 

component.
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EMULATION 
MODE?

Did you swipe past a page and 
miss it earlier? Emulation Mode 
simulates an active system 
without actually loading your 
design to a Core. This lets you 
make DSP adjustments to the 
design that would otherwise 
not be available to you. You 
can enter Emulation Mode by 
pressing F6 at any time, and 
exit again by pressing F7. Make 
sure you exit Emulation Mode 
when you’re done or you 
won’t be able to add or move 
components!

THAT SEEMS
LIKE A LOT
OF WORK

You can save yourself a lot of 
time by using QSC products 
in your design. All of the 
proper specifications and 
voicing for QSC products are 
automatically built into their 
components, ensuring that 
your system is voiced properly 
and delivers incredible audio 
performance.

2.11

5. Enter Emulation Mode by pressing F6 to configure the Custom Voicing.

6. Double-click on the Custom Voicing component to open its Control Panel.

7. Fill out all of the necessary information for each band. This includes Gain 

adjustment, Delay, Polarity (Invert), information on the band’s High Pass and 

Low Pass crossover (the Type, Slope, and Frequency), and any suggested 

voicing filters (the Type for each, its Gain, Q/Width, and Frequency, and 

Order if appropriate).

WHERE DO I GET ALL THAT?

Finding the tuning data for your loudspeaker can be tricky. Some manufacturers will list 

this information on their websites or in their product manuals, while others might not 

make it available at all. When you do find your loudspeaker’s tuning data, it will probably 

not be formatted the same way that it is displayed in the Custom Voicing Control Panel, so 

be careful to find the right information for each of the data fields. Watch the video for this 

section online to see an example of how to read a tuning spec sheet and input that data.

Q VS OCTAVE WIDTH 
In the Q/Width column, you must input the octave-width of each filter ... but some 

manufacturers may provide this in terms of Q. In order to use a Q number, you 

must first convert it into octave-width, which you can do with a Q converter. Simply 

search the internet for “Q converter octave width” and you should find any number 

of sites that allow you to input your Q number and receive its equivalent value in 

terms of octave-width. Then input the result into this column of the Control Panel.

8. Activate your decisions. All those pink buttons are bypass buttons, which mean 

that the component is currently ignoring all the information you just put in. In 

order to activate any of your filter data, you must de-active its associated bypass 

button. This is true in both the Crossover and Voicing Filters section. Don’t be 

fooled into thinking that bright pink button means the filter is active, because it 

actually means the exact opposite!
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EXERCISE 2.12: THE SCHEMATIC LIBRARY

In the Right-Side Pane you will find the Schematic Library. This contains virtual 

DSP components you can use both to design and test your audio system. To add a 

component from the Schematic Library to your Schematic, simply drag the name of 

your desired component onto the Schematic pane and release the mouse button. 

You may remember that when you brought the Status Component of your Core into 

the Schematic, that component was no longer available in your Inventory. However, 

since components in the Schematic Library are virtual, there is no limit to the number 

of times you could add a component from the Schematic Libary. They are not part of 

your physical inventory, and will not be listed in your Inventory panel.

The Schematic Library has three branches – Audio Components, Control 

Components, and Layout.

1. In the Schematic Library, expand the Audio Components branch by clicking on 

its triangle.

Here you can see a list of available audio components, some of which are grouped 

together within further branches. This module does not intend to be a complex 

tutorial into how every one of these components is used, but you will look at a few 

of these to get an idea of how to interact with components in general.

Depending on your software version, available audio components may include: 

• Acoustic Echo Canceler - Removes echoes from a teleconference system. 
See Chapter Eight: “Acoustic Echo Canceler” (page 190).

• Audio Player –Plays MP3 and WAV files from your Core.

• Crossfader – Allows the simple fading between channels.

• Crossover – Divides an audio signal into different frequency bands for 
distribution to different loudspeakers.

• Delay – Introduces a delay in the audio signal.

• Dynamics – This set contains components that can control your signal’s 
dynamics, such as the Compressor, Expander, and the Peak Limiter. You 
can learn about more complicated dynamic components such as the Gated 
Ambient Compensator and the Continuous Ambient Compensator in 
Chapter Nine (page 140).

(continued)

NO LIBRARY 
CARD 
REQUIRED!
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• Effects – This branch contains customizable effects that can be applied to your 
signal such as Chorus, Flanger, Reverb, and others.

• Equalizers and Filters – This branch contains many common filters to apply 
to your signal that are individually customizable. These include the Low-Pass 
Filter, Graphic Equalizer, Parametric Equalizer, and many others.

• Gain – Gives control of gain adjustment, muting, and inverting to a signal.

• Gain Ramp – Allows a time-controlled gain adjustment between user-made 
presets.

• Meter – Creates a True Peak / RMS Meter for monitoring an audio signal.

• Mixers  - This branch contains various types of audio mixers. You can learn 
more detail about the Gating Automatic Mic Mixer and the Gain-Sharing 
Automatic Mic Mixer in Chapter Eight: Automatic Mixers (page 129).

• Public Address – This branch includes the PA Router and the Virtual Page 
Station, which are used to establish your Paging System.

• Room Combiner – Allows you to create an interface for combining audio in 
rooms with removable walls. For more information on this component, go to 
Chapter Seven: “Room Combining” (page 123).

• Router – Provides simple channel routing from inputs to outputs.

• Signal Presence – Detects the existence of an output signal.

• System Mute – Mutes the entire system.

• Test and Measurement – This branch contains various devices used to test 
and measure your system, and is covered in detail in Chapter Six (page 111).

All of these components contain comprehensive Help file entries to help you fully 

understand their uses. To access the Help file, you click on Help>Help, or highlight 

an element you are interested in and press the F1 key.

(Audio Components continued)

Don’t forget to expand the 

branches to see all of the 

available components!

SEE SOMETHING NEW?

The team at QSC is constantly improving and adding new features 
to the Designer software, which sometimes may take the form of 
new components in the Schematic Library. If you see an exciting 
new tool that isn’t listed in this chapter, there will probably be a 
tutorial for it at www.qsctraining.com. 
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EXERCISE 2.13: CUSTOMIZING COMPONENTS

You’ve already familiarized yourself with the way components work, so now it’s time 

to go a little deeper in learning how to manipulate them. One way is to expose a 

component’s Control Pins. There is a pin for every control in a component’s control 

panel. You can wire these Control Pins together just like audio pins, to customize the 

way controls behave and link them together to perfrom more complicated functions. 

1. Go to the Mixers branch of the Schematic Library.

2. Drag a Matrix Mixer into your Schematic.

3. Expand the Control Pins panel in the Right-Side Pane. You will find this at the 

bottom of the Properties panel.

4. Expand Input 1 and check the box to the right of Mute.

5. Notice that an Input 1 Mute control bin has been added to the bottom of your 

component. A control pin has a rounded-square shape rather than a circle, and 

can only be wired to another control pin.

Adding these control pins allows you to create unique logic and scripting interaction 

between your components. There are a number of components in the Control 

Components branch of the Schematic Library that let you manage the path of these 

control pins, including the ability to create Custom Controls, adding a Control 

Delay, Control Router, and the access to deeper logic using Control Function 

and Control Script.

I DON’T SEE IT?
WHERE IS IT?

Don’t forget that you need to 

select the component you wish 

to edit before you have access 

to its Properties panel.
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The details of these components will not be covered in this course. For now, just 

know that the flow of control pins flows left to right, just like audio. So you could 

activate this Mute button from another control by wiring it into the left input pin, or 

you could use this Mute button to activate something else by wiring the right output 

pin to another control.

3.  Change the Input Count of 

Mono Channels from 8 to 4.

4. Notice how the Control Panel 

has changed to reflect the new 

number of inputs.

2.13

Another important thing to 

remember about components is 

that the display of their Control 

Panels can often be defined by 

their Properties.

1. Double-click the Mixer 

component to open its Control 

Panel.

2. Note that just because the 

Control Panel is open doesn’t 

mean you have access to the 

Properties pane. Click once 

on the Mixer component to 

gain access to its Properties.

ANOTHER CONTROL
ACTIVATING THE MUTE

THE MUTE ACTIVATING 
ANOTHER CONTROL
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5.  Next change the Input Count of Mono Channels from 8 to 256. 

6.  Notice that not only has the number of inputs in your Control Panel changed, 

you also now have a new area at the top, the Input Bank, that lets you select 

the range of inputs currently visible (since 256 would certainly not fit on the 

screen at once). 

7.  Change Label Controls to Yes, and 

each output and input now has a label 

field which you can use to type in names 

for each of  your channels.

8. If you change the 2-D Matrix Panner 

field to Yes, then this component 

transforms again, to a different style of 

mixer that uses a visual representation of 

inputs and outputs for mixing.

You can see that the standard setup 

of a component when it comes out 

of the Schematic Library is just a 

starting point. It’s always a good idea to 

familiarize yourself with the ways any 

component can be reconfigured before 

implementing it into your design, so 

that you know it’s in the best possible 

state for your purposes.

QUESTION:

“What if I have two hundred 

and fifty-seven inputs in my 

design?”

ANSWER: Nice try. Don’t forget 

that you can continue to add 

more mixers to your design 

as long as you haven’t maxed 

out your DSP resources, which 

you can check by pressing 

Shift+F6 or selecting Check 

Design from the File Menu. If 

you’re interested in how many 

actual channels you can have 

in a design, check out Lesson 

11.3: Audio Channels vs. 

Audio Streams (page 160) 

and Lesson 2.16: Maximizing 

Audio Channels (Fan-Out 

Method) (page 58).
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There are still two more main branches of the Schematic Library to look at. 

 

The Control Components, as mentioned earlier, include components you can 

configure to build scripting and logic dialogue between the components in your 

Schematic. Some are simple to use such as the Blinking LED which you can create 

to act as a warning light and the E-Mailer which you can setup to e-mail you when 

certain parameters are met (such as a Core failure). Others require more detailed 

programming knowledge. Control Script, for instance, allows you to write your 

own Lua-based coding directly into the Designer software. The Help file on this 

component contains a complete encyclopedia on Lua scripting. For more information 

on scripting between components, take a look at Chapter Seventeen: Control Script 

(page 226). 

 

The Layout branch includes customizable components that allow you to group parts 

of your Schematic together and route them in different ways. Also included here are 

the Signal Snake Input and Output which you learned about earlier in this chapter, as 

well as some UCI buttons such as Log Off and Clean Screen (which temporarily 

disables a touchscreen so that you can clean it).

2.13

THE USER LIBRARY

After going through all that work to customize your component, you would hate to 

redo that work everytime you create a new design. You can drag any component or 

group of components into the User Library at the bottom of the Right-Side Pane. 

This will create a new device in that Library that is configured exactly the way your 

original was - including the status of all controls inside the components.

This User Library is saved 

as part of the Designer 

software - it is not specific 

to the design you are 

working on. If you start a new design, its User Library will already be populated with 

the custom components you have added to it. If you are changing computers and 

want to bring your User Library with you, you copy the User Library file from the 

directory where Q-Sys Designer is installed.

Note: The User Library can only save virtual objects. Inventory items cannot be 

duplicated by the User Library.

THAT’S 
AMAZING!

We know. Just think of all 

the time this will save you. If 

you have a particular chain 

of processing components 

that you commonly add to 

every microphone channel, 

for instance, you can save 

them as a single object in 

the User Library so that you 

don’t have to rebuild them 

every time. You could also 

build a sophisticated Test and 

Measurement control panel 

that would be useful on every 

design, and then save it to the 

User Library so that you can 

quickly add it to any design 

you create. Check out the Test 

and Measurement chapter 

(page <?>) for ideas on this 

type of control panel.
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EXERCISE 2.14: GRAPHIC TOOLS

At the top of the Right-Side Pane are four Graphic Tools, which you can use to 

customize the appearance of your Schematic and User Control Interfaces.

1. Click on the Text Block icon, which is the first Graphic 

Tool.

2. Click and drag your cursor in the Schematic to create a 

rectangular Text Block.

3. Type your text into your text 

block.

4. When you are done, click outside the 

Text Block, and your text will center 

itself.

5. Click on the Text Block and access 

its Properties panel in the Right-Side 

Pane.

6. Adjust its Fill Color. By default, the fill 

color is completely transparent. You 

will have to slide the Transparency 

fader at the bottom of the color 

selection window to see your Fill 

Color.

7. Adjust the Stroke Color to change the color of your border.

8. Adjust the Stroke Width to change the border size of the Text Block.
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9. Adjust the roundness of the corners of the block by raising the Corner Radius.

10. Adjust the Text Color, Size, and Weight (Normal or Bold).

11. Finally, specify your preferred Horizontal Alignment and Vertical Alignment.

The next Graphic Tool is the Header tool, which has most of the same functionality 

as the Text Block. The Header creates a title bar with a horizontal line extending 

beyond the edges of your text. The Header does not have a border or Fill color, but 

does allow you to change the color and size of the header line it creates.

12. Click on the Header icon, which is the second 

Graphic Tool. 

13. Use the Header like the Text Block tool.

The third tool is the Group 

Box which can create large 

rectangles to organize your 

Schematic.

14. Click on the Group Box icon, which is the third 

Graphic Tool. 

2.14

THINKING 
IN THREE 
DIMENSIONS

When using tools like the 

Text Block or the Group Box, 

remember that the objects on 

your screen exist in “Layers” 

that lie over one another. If 

you make a large box that 

is filled with a color, it may 

obscure the objects “beneath” 

it. You can right-click on the 

box and select Send to Back 

from the Order menu (or by 

using the Tools menu at the 

top of the screen) to send the 

box to the back of your layers, 

preventing it from blocking 

your other components.
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15. Click and drag a Group Box around several components on your Schematic.

16. Type in a label for this Group Box, and notice that this label appears in a tab in 

the top-left side of your box. 

 

17. Adjust the Properties of the Group 

Box. It has most of the same 

customizable properties as the Text 

Box. 

CHOOSE 
YOUR TAB

You can also choose to have 

your tab aligned to the center 

or to the right by adjusting the 

Horizontal Alignment field 

in the Properties panel of the 

Group Box.

The fourth and final tool is the Polygon tool, which allows you to create different 

shapes of your own design. 

18. Click on the Polygon tool, which is the fourth 

Graphic Tool.

19. Click on your design. Continue to click in 

different places, creating a shape with many 

sides. Complete your polygon by clicking the 

first point you created.

20. Adjust the Color of your Polygon.

21. The unique feature of the Polygon 

tool is that you can use it to 

create custom buttons. Check out 

Exercise 4.8: Custom Buttons 

(page 92) for information on 

how to apply a control directly to 

your Polygon.

2.14
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EXERCISE 2.15: THE LEFT-SIDE PANE

The Left-Side Pane has six accordion-style panels that you will need to be familiar 

with.

1. Inventory  - This is where you incorporate items from your physical inventory into 

the digital signal path. You learned how to use this in the beginning of this chapter.

2. Schematic Pages – This allows you to add, name, remove, and delete pages of your 

Schematic, which you learned about in the Wiring module.

3. User Control Interfaces – This creates the User Control Interface, or UCI, that your 

end-user will interact with to control the system. You can add and remove pages 

much like the Schematic Pages.

4. Snapshots – Snapshots allow you to record specific settings for a set of controls and 

then recall those settlings by loading different Snapshots. For a complete look into 

Snapshots, look at the Snapshots tutorial.

5. Named Controls – You can drag controls into the Named Controls library to 

establish controls that can be accessed either by external devices or by various 

control systems within the software. Using the Tools option in the menu bar, you can 

Extract Names Controls to an XML file that will be useful to those external devices.

6. Design Inspector keeps track of broken paths within your Schematic. 

• You’ll notice that your Interface has a Properties panel in the Right-Side Pane. Here 

you can specify what type of panel you are creating. You can use the dimensions of 

the QSC TSC-3, an iPad or iPhone, or your own custom size.

• You can copy any controls or components from your Schematic into your UCI and 

they will retain their functionality. This way you can give the end user as little or as 

much control as you wish.

• You can add images to your UCI by dragging a JPEG, PNG, or GIF from your 

computer and dropping it onto your Interface page.

ACCORDION 
PANELS

If you click on one of these six 

panels, it will expand to let you 

see that panel’s options. The 

panels above will be pushed 

to the top of the page, and the 

panels below will be pushed to 

the bottom of the page.  

2.15
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There are, of course, other areas of the Q-Sys Designer software that you haven’t 

seen yet. As you become more and more knowledgeable with the interface and 

comfortable with designing your audio paths, you will notice some of these areas. 

For now, you are ready to start creating some more complicated designs and learning 

about the specifics of some of the more detailed components that Q-Sys Designer 

has to offer.

You can see how the Design Inspector works by purposefully creating an error: 

1. Drag an Audio Player from the Schematic Library into your Schematic.

2. Double-click the Audio Player to open its Control Panel.

3. Drag the Play button from the Control Panel into the Schematic.

4. Delete the Audio Player.

5. You’ll notice that there is now a red question 

mark over your orphaned Play button, and a 

yellow hazard indicator by your Design Inspector. 

The Design Inspector will list all orphaned 

controls in your system, as well as any signals 

that are not terminated at both ends.

2.15

CONTROL 
ADOPTION

To correct an orphaned 

control, you will have to 

reterminate it to a component. 

In this instance, you would 

first drag a new Audio Player 

into the Schematic. Then 

drag its Play button over your 

orphaned Play button and 

hold the Control key to assign 

its settings. Select Transfer 

Control ID to associate your 

orphaned control with its new 

parent.
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LESSON 2.16: MAXIMIZING AUDIO CHANNELS 
(FAN-OUT METHOD)

Any output pin can be “fanned-out” and wired to multiple input pins. This lets you 

easily send the same audio signal to different destinations, and if used wisely this 

can also keep your design efficient. For instance, every unique channel travelling 

on the network counts against your total available Network Audio Channels. But 

“fanning-out” a single channel to multiple outputs still only uses a single Network 

Audio Channel. In this image, an I/O-Frame with four Line Out cards is using the 

same signal for all 16 outputs, which only uses a single Network Audio Channel. 

Consolidating audio like this is very efficient.

If you had sixty-four I/O Frames and each one of them only received one audio 

channel (which could be sixty-four different channels, or it could all be the same 

channel) you could accomplish this using the Core250i, which has a total of 64 flex 

channels (that can be used for either inputs or outputs). WHERE WOULD 
THE AUDIO 
COME FROM?

QUESTION: If I used all 64 flex 
channels for output channels, 
how would I have any audio 
coming into the system?

ANSWER: Don’t forget that 
this only refers to network 
channels. Your Core still has an 
I/O Card slot (or eight slots, in 
the case of the Core 250i and 
500i), for local audio inputs 
and/or outputs that aren’t 
part of your Network Audio 
Channel count. 

FAN-OUT METHOD 2.16
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Each one of these sixty-four I/O Frames can then fan-out its audio signal over its 

sixteen Line-Outputs, meaning that you have achieved a maximum of 1024 physical 

output channels.

Also, different Cores can handle different loads. Other Cores can handle as many 

as 128 output Network Audio Streams, which could be fanned-out to accomodate 

2048 physical outputs (not to mention the increase of input Audio Channels).

MODEL  TOTAL NAC CAPACITY MAX PHYSICAL OUTPUTS

Core 250i  64 Flex   0 inputs/64 outputs x16 = 1024

Core 500i  128 Flex   0 inputs/128 outputs x16 = 2048

Core 1100 256/256   256 inputs/128 outputs x16 = 2048

Core 3100 512/512   512 inputs/512 outputs x2 = 1024
  (8 NAC per NAS)  512 inputs/128 outputs x16 = 2048

MORE EQUALS 
LESS?

To achieve maximum fan-out, 
a single audio channel is 
being split across an entire I/O 
Frame. While a Core 3100 can 
handle more audio channels, 
the number of audio streams 
is still limited by the network 
bandwidth. If you wanted to 
use all 512 output channels, 
you would need to bundle 8 of 
them into each audio stream, 
limiting the number of times 
they could be fanned out from 
16 to 2. In order to reach 2048 
physical outputs, one audio 
channel could be used in each 
of 128 audio streams and 
fanned out 16 times each.

2.16
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The Q-Sys Configurator lets you manage your physical resources on the network, and 

the Q-Sys Administrator allows you to set up and maintain virtual Q-Sys resources 

such as loading and managing audio files, customizing user access, configuring 

scheduled events, and much more. This chapter will discuss each of these versatile 

functions one by one. 

There may be any number of people within your company who will interact 

with the Q-Sys system, and it’s important that you can give them the 

resources and permissions that 

they need to get their job done 

right (but it might be even more 

important to deny them resources and 

permissions to the areas they don’t 

need to be in). By orchestrating user 

access, scheduling automated events, 

and monitoring all events on your 

system, you know your system will 

always be under proper control.

• Discover your hardware devices with the Configurator

• Explore the six main areas of the Q-Sys Administrator tool

• Learn how to execute administrative tasks, such as creating User 
accounts, loading audio files to the Core, and restricting permission to 
certain UCIs

Configurator
& Administrator

In This Chapter:

NOTE: Parts of this tutorial can not be completed in Emulation Mode and 
require connection to a Core.

CHAPTER MAP
3.1 THE Q-SYS 
CONFIGURATOR         
page 61

3.2  ACCESS THE 
ADMINISTRATOR        
page 64

3.3  COMMANDS       
page 65

3.4  THE COMMAND 
SCHEDULE  page 69

3.5  USERS  page 72

3.6  USER CONTROL 
INTERFACES  page 74

3.7  AUDIO FILES      
page 75

3.8  THE EVENT LOG   
page 77

3.9: ADDITIONAL 
TABS 
page 78

CHAPTER THREE
TRAINING
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LESSON 3.1: THE Q-SYS CONFIGURATOR

Once your devices are properly connected to your network, they’ll be discoverable 

by the Q-Sys Designer software and you’ll be able to integrate them into your audio 

design. To do this, you’ll need to use a simple but vital part of the software: the 

Q-Sys Configurator. The Configurator is a window that lets you manage various 

aspects of Cores, I/O Frames, and other networked Q-Sys devices. 

1. Go to the File Menu and 

select Tools > Show Q-Sys 

Configurator.

The Configurator displays as a tab in the main window, and just like any tab you can 

undock it from the software or split the screen if you desire. Regardless of where you 

position the window, it is divided into two sections - a list of available Q-Sys devices 

on the left, and the properties of the selected device on the right.

If a Q-Sys device is connected to your network and powered on, it should populate 

in the list on the left. This column will be sorted by type of device, and the color of 

its icon will indicate its status. Select any device and its appropriate information will 

display on the right. 

WHAT’S THE 
PASSWORD?

If your device is protected by 
a password, simply enter the 
password on this screen and 
click the Go button.

3.1
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Listed on the right is the device’s Name, its Firmware Version, the name of its 

running Design and how long it has been running (if no design is running, it will 

indicate that the system is Idle). Cores will display their Model number, and I/O 

Slot information will be populated for both Cores and I/O Frames.

At the bottom of the screen you will find information on the device’s Network 

Address for every network it has access to. Most devices have two network ports for 

redundancy labeled LAN A and LAN B, and some devices have additional ports for 

Auxiliary networks. For each network you can choose its Mode from receiving an 

IP Address automatically or manually by selecting Auto or Static. In Static Mode you 

can specify your address in the appropriate field. A network can also be switched to 

Off mode (with the exception of LAN A).

To add a password to your Device, select the Edit Device Password and input a 

new password here. 

If you’ve made any changes to your device you must select Update Settings in 

order to make those changes active.

IDENTIFY 
YOURSELF!

If you click this ID Button, 
then the LED screen of the 
corresponding device will 
flash, letting you easily find this 
device in the real world.

Conversely, if you press the ID 
Button on the front panel of a 
Core or I/O Frame, this device 
will flash in the Configurator. 

For a video of this in action, 
go to www.qsctraining.com 
and select Q-Sys Training 
> Hardware Overview > 
Identify Button.

TEST DRIVE THE 
CONFIGURATOR

Go ahead and change the 
Name of your device and 
select Update Settings. If 
you watch the LED screen 
of that device, you’ll see its 
name change to reflect these 
changes. You can change a 
device’s name to help you 
organize and keep track of 
multiple devices on your 
network.

3.1
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Being able to see and adjust your devices’ settings at a glance is critical to 

incorporating them into your design, but just because the Configurator sees the 

device doesn’t mean that it is part of the Schematic. You must manually add all 

devices to your design by using the Inventory panel in the Left-Side Pane.

2. To properly add a device to your design, click the Plus icon in the Inventory 

panel and select your device.

3. Select the corresponding device in the Q-Sys Configurator to view its settings.

4. Go to the Properties panel of your Inventory device and match its Name to 

that of the settings shown in the Configurator. You may find it easier to simply 

copy and paste the name rather than retype it. For Cores you will also need to 

match the Model number, and for both Cores and I/O Frames you will need to 

properly configure the I/O Card Slots.

Once your Inventory item matches the information shown in the Configurator, the 

design can use that device to its full function and capability.

Understanding the Configurator is the first important step to being able to implement 

a design with actual hardware. Once the inventory is properly configured, your signal 

path will be able to use those inventory items.

3.1

DON’T FORGET THIS STEP!

This is very important! If you 
don’t match the name of the 
Core in your design to the 
name of the actual Core, then 
nothing will happen when you 
attempt to run your design!
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EXERCISE 3.2: ACCESS THE ADMINISTRATOR

You’ll need to start off by launching Administrator. This can be done in one of a few 

ways, but is only available while running a design on Core Hardware or in Emulation 

Mode. 

1. Save your design to the Core and run by pressing F5 or select File > Save to 

Core & Run. 

 

There are three ways to open Administrator:

If you would like to adjust the 
Administrator settings for a 
design that is already running 
on your Core, you would select  
Load from Core & Connect.

WHAT ABOUT 

MY RUNNING 

DESIGN?

A. Select the Administrator icon in the upper 

right corner.

B. Go to the File menu and select Tools > 

Show Q-Sys Administrator.

C. Download the stand-alone Administrator 

program from the QSC website. Launch 

the program, select File > Administer, and 

select the available running design. 

On the left side of the Administrator interface is a 

column of navigable tabs, each of which controls 

a different aspect of the running design. These 

include Commands, Command Schedule, 

Users, User Control Interfaces, Audio Files, 

and Event Log. If you have a Public Address 

system or Softphone in your design you will have 

additional tabs displayed here. These tabs are 

covered in Chapter Twelve: Public Address (page 

164) and in “Exercise 13.5: The Softphone” 

(page 200).

QUESTION: What is the 

advantage of the stand-alone 

Administrator program?

ANSWER: This application 

provides all of the functionality 

of the Administrator tool 

without having any access to 

the Designer software. This 

means a User could manage 

the system without being able 

to make any changes to the 

actual design. Sometimes it’s 

just best to leave the design 

out of the hands of people 

who aren’t Q-Sys Certified like 

yourself!

Whenever you make changes in Administrator, they will not be applied to the design 

until you click the Update button at the top of the window.

DON’T
FORGET!

If you don’t hit the Update
button, then all your changes
will simply disappear!

3.2
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EXERCISE 3.3: COMMANDS

You can automate a variety of actions by creating a Command. Commands might 

be used to adjust the values of different controls within a component, to launch 

Public Address functions, or to recall system presets saved in your Snapshot Banks. 

Commands can either be scheduled to activate at predetermined times with the 

Command Scheduler, or be launched manually by inputting a code at a Page Station.

There are four types of commands:

Don’t recall how to setup a
Snapshot Bank? Check 
out “Exercise 4.1: 
Understanding the Global 
Snapshot Bank” (page 
80) and soon you’ll be able 
to recall anything 
you want!

PA Page Commands and PA Play Message Commands are both functions 

of the Public Address system, and will be covered in Chapter Twelve: Public 

Address (page 164). Check it out for more information on these two 

Commands. 

Snapshot Load Commands will recall a saved Snapshot in either your Global 

Snapshot Bank or a User-Defined Snapshot Bank. If you would like to make 

a Snapshot Load Command in this tutorial, you will need to have at least one 

snapshot saved in one of these banks.

Control Change Commands will adjust the value of a control, such as toggling 

a button to an on/off state, or adjusting a fader to a predetermined level. In 

order for a control to be available to command, you must first drag it into your 

Named Controls bin in the Left-Side Pane (see Mini-Exercise below).

MINI-EXERCISE: THE NAMED CONTROLS BIN

1. Exit the Administrator, and press F7 to Disconnect (or select File > Disconnect).

2. Drag an Audio Player from the Schematic Library into your Schematic.

3. Double-click its component to see its Control Panel.

4. In the Left-Side Pane, navigate to the Named Controls bin.

5. Drag the Gain Knob from the control panel into the Named Controls bin. This control is  

 now available to be controlled from outside the Schematic by an external controller or, in  

 this case, an Administrator Command.

6. Drag the Pause Button from the control panel into the Named Controls bin as well.

7. Press F5 to Connect to the Core and return to the Administrator tool.

●

●

●
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1. Create a Control Change Command by clicking on the Plus icon in the 

Commands tab and selecting Add Control Change Command.

This settings menu will let you configure the new command.

2. Give the command a Name.

3. Give the command a Code. This can be any numeric sequence you wish. This 

Code can be input at a Page Station to remotely activate your Command.

4. Choose which Control the Command will adjust.

5. Adjust the Value that you would like the Gain to be set to. Gain can be set to 

anywhere in a range from -100 to 20 dB.

6. Adjust the Ramp Time, which determines (in seconds) how long it takes for the 

Gain to transition from its current Value to the one you specified.

7. Press OK to finish your Command.

8. Repeat Steps 2-7 to create another Control Command which will trigger the 

AudioPlayerPause.

Notice that there is no Ramp Time, and that the Value simply states Control will be 

triggered. This is because a Pause button is a momentary button that simply triggers 

the Pause.

MY NAME IS

?

WHAT DO I DO?

You can create any command 
you wish, or to follow 
along you could use these 
parameters:

Name: Gain to Full
Code: 150
Control: AudioPlayer Gain
Value: 20 dB
Ramp Time: 3 seconds

When this command is
triggered, the gain of the Audio
Player will take 3 seconds to
rise to 20 dB.

3.3
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Both of your Commands are now listed here in the main Commands window. If 

you have many Commands saved, you’ll find it useful to arrange them in ascending 

or descending order in each column. You can also adjust the size of each column 

by dragging the margin between them, and you can edit the settings of any given 

command by double-clicking it.

9. Create a Snapshot Load Command by clicking the plus icon and selecting Add 

Snapshot Load Command.

10. Choose a Name and Code for your new Command.

11. Select a Snapshot Bank, and the desired Snapshot Number within that Bank.

12. Select the Ramp Time to load the Snapshot.

13. Select OK to finish your Command.

QUESTION: I only have two
controls in the Named Control
bin, so am I limited to only two
Control Commands?

ANSWER: Nope! You could
make as many different
commands for a single control
as you like. Perhaps you want
separate Commands that set
it to 0 dB, 5 dB, and -10 dB, or
every dB in between! And then
you might want variations of
each of those with longer and
shorter ramp times … there
are limitless possibilities!

Every design starts with a
Global Snapshot Bank,
which by default has 4 Save
slots. You can increase the size
of this bank as well as add new
User-Defined Snapshot Banks
that contain more specific
controls. If you haven’t saved
different Snapshots in these
Slots, then this Command
won’t really do anything right
now. For more information on
how to do this, check 
out “Exercise 4.1: 
Understanding the Global 
Snapshot Bank” 
(page 80).
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The last thing you can do in the Commands tab is assign Tags. Tags are a convenient 

way to group associated Commands together.

14. Click on the Plus icon in the Tags 

column to create a new Tag.

15. Type in a name for your Tag.

16. Drag the Tag onto a Command of your choice.

17. Select a Command, and then click the Plus icon and create a new Tag.

18. Notice that by selecting a Command first, the Tag you created has been 

automatically assigned to that Command.

You can apply a Tag to as many different Commands as you like, and any given 

Command can have as many different Tags as you like.

19. Select the Filter button at the top of the 

Commands window, and check the box for 

one of your tags.

20. You’ll notice that now only the Commands with the chosen Tag are displayed 

in the window. Using Tags to filter your Commands let you easily find the 

Command you’re looking for, as well as other Commands that are associated 

with that Tag.

3.3
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EXERCISE 3.4: THE COMMAND SCHEDULE

The second Administrator tab is the Command Schedule. Here you can schedule 

Commands to be triggered at a predetermined time by creating an Event. In the 

calendar interface you can see all of your upcoming events.

You can toggle between Week View or 

Month View, by toggling the 31 or 7 day 

buttons.

You can browse forwards and 

backwards in the calendar 

using the navigation arrows.

DON’T HAVE ANY 
EVENTS IN YOUR 
CALENDAR?

Nothing to be embarrassed
about! With the Command
Schedule you can appear to
be just as popular as you wish
you were!

3.4
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1. To create a new Event, double-click on a blank area in any date.

2. Create a Name for your Event.

3. Select a Command that this Event will activate.

4. By default, all Events start Enabled. If you would like to disable this Event 

without deleting it, you can change the Enabled field to No.

5. If you would like your Event to only occur once, then leave the Occurs field on 

Once and specify the date and time for the event to occur.

A. If you would like your Event to occur daily, change the Occurs field to 

Daily and specify the time each day for the event to occur.

B. If you would like your Event to occur on specific days of the week, 

change the Occurs field to Weekly and specify the day(s) of the 

week on which the event should occur.

C. If you would like your Event to occur on a specific day of the month, 

change the Occurs field to Monthly and specify the day of the 

month on which the event should occur.

THIRTY 
DAYS HATH 
SEPTEMBER ...

If you select the 29th, 30th, or
31st day of the month, then
this Event will only occur on
months that have those dates.

3.4
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6. Some Commands, such as playing an audio file, you may wish to Loop. If you 

select this option you can choose the time at which the message will cease 

being looped, and how often it will be played during that time. This would be 

useful for recurring announcements.

7. Finally, if you have scheduled your Event to occur daily, weekly, or monthly, 

then you can access the Advanced Settings by clicking the Show Advanced 

Settings box to display more options.

8. Here you can specify how long a repeating Event will occur. You can specify a 

starting date, an ending date (or a maximum number of occurrences for it to 

repeat), as well as fine-tune the period in which it repeats. For instance, you 

can make an Event occur every other day or every three weeks by adjusting the 

Every field.

9. Once you’re satisfied with your Event, select the OK button and you will see 

your event populate in your calendar view .

Be sure to use this Loop
command, and not the Loop
button in the Audio Player.
The Audio Player’s loop button
will keep the file looping
indefinitely, whereas the
Event loop option allows you
to decide how long and how
frequently you would like the
file to be looped.

3.4
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EXERCISE 3.5: USERS

The next tab is the Users tab, which provides a means for allowing access to a Q-Sys 

system via control devices as well as establishing priorities in the Public Address 

System. When you first visit this 

tab, you’ll notice that a Guest User 

is already present, which cannot 

be renamed or deleted, and by 

default has access to all features.

1. Click the Plus icon at the top of the Users window to create a new User.

2. Create a Name for the User.

3. Create a PIN for the User.

In the Access Permissions 

panel, you can restrict the 

user’s access to certain 

functions. Some may say 

Enabled in Guest Account. 

This is because every User will 

have access to the features 

that the Guest account has 

access to. If you would like 

to restrict areas from certain 

users, then you must first deny 

those privileges to your Guest 

account.

4. Click OK to finish your New User.

5. Double-click the Guest User.

6. Change the Adminsitrator Permission to No.

7. Change the External Control Protocol Permission to No.

WHAT’S YOUR 
NUMBER?

This PIN (or Personal
Identification Number) is a
numeric code that the User can 
input to log on to a restricted 
Page Station or UCI.
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8. Click OK to 

finalize your 

changes.

9. Double-click the 

New User that 

you created. 

Now that your Guest has restricted access to your system, you can also choose to 

restrict those areas to your Users as well.

10. If you want, 

you could 

now choose 

to restrict the 

External Control 

Protocol from 

this user, since 

it is no longer a 

globally-available 

function.

11. Click OK to 

finalize any 

changes you 

made. 

12. Create a Tag for your User (or use one that you’ve already created). Much like 

Commands, you can assign tags to Users, and you can filter your view by using 

these tags. If you would like to edit multiple User permissions at once, select all 

the Users you like and double-click one to edit them simultaneously.

FILE 
MANAGEMENT

If a User has access to the
Administrator, then they
automatically have access to
File Management Protocol.
However, if a User is denied 
Administrator privileges they 
can still get access to the File 
Management through external 
devices, so you may need to 
specifically decide whether 
or not they should have 
permission for this separately.
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EXERCISE 3.6: USER CONTROL INTERFACES

The next tab is the User Control Interfaces tab, or UCI. Here you’ll see a list of all of 

the UCI pages you’ve created in your design, including the default Inventory Status 

UCI. In the Administrator. You can select which Users have access to each UCI.

1. Double-click a UCI (Inventory Status will be the only one in a new design)

2. Change the Require User Logon field to Yes.

Here you can personally select which Users should be given permission to access 

the UCI by checking the box next to a User’s name, or select all Users with similar 

tags by checking that Tag. If you select a Tag, you cannot uncheck a User with that tag 

as long as that Tag is checked.

3. Select OK when you’re finished.

Now when a User attempts to access this UCI they will be presented with a 

password protection screen like this one.

LOCK IT UP!

Creating an intuitive UCI is an
easy way to give your End User
control of the system at their
fingertips, but it might also
be an easy way to let a nosy
passerby hijack your sound
system! It’s a good idea to
require a User Logon for any
UCI that’s accessible in public
areas.

3.6

UCI Viewer Touchscreen



75Q-SYS TRAINING CHAPTER THREE: CONFIGURATOR & ADMINISTRATOR

EXERCISE 3.7: AUDIO FILES

The fifth tab in the Administrator is for managing your Audio Files. The files can be 

stored in several unalterable directories.

You can use the Audio Player component in your design to playback files in any of 

these directories. You can upload audio to the Core from your desktop.

1. Double-click the Audio folder to open the directory.

2. Click the Plus icon at the top of the window.

3. Browse for files on your computer and select Open to upload them to the Core.

The media you select will be copied to the Core’s internal media drive. You can 

see the progress displayed at the bottom of the screen, and once an audio file is 

displayed in the window you can listen to it over your computer’s loudspeakers by 

pressing the Play button next to its name.

To delete a file simply press the Delete key, or right click the file and select Delete.

The Audio folder is for all general audio, which you can 
organize however you like.

The Messages folder is for storing audio files that will be 
played by the PA Play Messages Command.

The Page Archives folder collects the audio of pages 
sent via the Paging system.

The Preambles folder is for audio that is played using 
the PA Page Command, usually a short attention-
grabbing signal that a Page is about to begin.

AUDIO 
FILES ...

These audio files are saved
directly to the Core and are 
not contained within your 
Designer file, so if you were to 
design a system on one Core 
and then deploy it on another, 
you’ll have to load the same 
audio files you used to the 
same directories on that Core. 
It’s also worth mentioning that 
if you’re using a redundant 
Core, any file uploaded via the 
Administrator is automatically 
kept in-sync between the two 
cores. For more information 
on the sizes of available media 
drives and how to upgrade 
your Core’s capacity for 
playing back simultaneous 
tracks, check out “Exercise 
5.2: Audio Player Tracks” 
(page 106).

NOTE: This section requires a Core. You cannot access the Audio Files tab in Emulation Mode.

3.7
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You can also create Playlists of your audio files in a few ways.

4. Click the Plus icon in the Playlists window.

5. Create a Name for your Playlist.

6. Drag several audio files over the name of the 

Playlist, and release the mouse button.

This Playlist will now play your audio in the order 

they appear. You can drag the files around to 

reorder them, and you can always delete or add 

files to the playlist. Deleting them from the Playlist 

does not delete it from your Core.

7. Another way to create a playlist is to select the files you desire first, and then 

drag them into the Playlist window. The playlist you create will automatically be 

populated with the files you had selected.

Audio Players are capable of playing Playlists as well as individual files, but you must 

be sure to configure them to do so.

8. Disconnect from the Core by pressing F7 or pressing File > Disconnect.

9. Click on the Audio Player you have in your Schematic.

10. Go to its Properties panel in the Right-Side Pane.

11. Change the Playlist Capable field to Yes.

Your Audio Player is now capable of playing Playlists. If you select your Playlist in 

the Audio Players’ control panel, then it will play all of the songs in that list in order 

whenever you activate the Play button.

I DON’T HAVE 
AN AUDIO 
PLAYER IN MY 
SCHEMATIC ...

That’s because you didn’t
follow every step. You didn’t
do the Mini-Exercise on page 
65, did you? I’ll bet you 
didn’t read the instruction 
manual to your TV before 
you turned it on either. Go 
add an Audio Player to your 
Schematic. I’ll wait here. And 
you’re on your own as far as 
setting up your TV’s clock.

3.7
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EXERCISE 3.8: THE EVENT LOG

The final tab in the Q-Sys Administrator is the Event Log. This window will keep a list 

of all notable events that have taken place in your running design.

1. Click on the Event Log tab of the Administrator.

At the top of the main Event Log window are two buttons: Reload and Clear Log. 

Reload will update the Log to any new events, and Clear will wipe the Log clean. The 

Events in the Log are listed in several columns, and you can sort or filter the log by 

clicking on any of these column heads to find what you are searching for.

Certain Events in a Log will repeat – for instance, if a device’s status drops from OK 

then an Error message will log, and will be repeated again in 10 minutes, 6 hours, 

12 hours and every 12 hours thereafter until the problem is corrected. The log will 

specify how long the problem has persisted, making it easy to find and correct any 

errors.

Severity : You could filter by Normal events or Error events. 

Source: Specify the source of events you would like to view. 

Category: You could filter by Connection events, Control events, Status updates 

of your Hardware, information on Pages both successful and failed, execution 

of Scheduled events, Security logs, the initialization of design to your System 

(which will also include a record of Clearing your Log and Opening your Log), User 

information which you can create using Lua scripting, or Telephony events. 

Date: This will list the events in chronological order.

BACK IN 
MY DAY ...

How long can you access the 
Events of this log? This log 
will remain until you upload 
a new design or change the 
version of the current design. 
If the total log is larger than 
ten megabytes, or has entries 
older than 31 days, then the 
oldest log entries will be 
deleted until the log is under 
ten megabytes and only has 
entries less than 31 days old.

NOTE: Certain elements of the Event Log will only work when running on a Core. 3.8
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3.9: ADDITIONAL TABS

You may have also noticed the SNMP tab (Simple Network Management Protocol), 

which allows you to monitor devices on the network using a third-party MIB browser. 

There are other tabs that may appear as well, depending on whether or not you have 

particular components in your design:

The PA Global Settings, Page Stations, and PA Zones tabs are part of the Public 

Address system. They let you manage the priority and settings of different types 

of page and message commands, as well as customize the functionality of each 

Page Station and establish your target zones. These tabs will be covered in detail 

throughout the chapter on “Public Address” (page 164).

The Softphones tab allows you to configure your Softphone component to connect 

over your network as part of a teleconference system. This tab is covered in detail in 

“Exercise 13.5: The Softphone” (page 200).

3.9

The Dynamic Pairing tab is only available when you have enabled Dynamic 

Pairing on at least one of your inventory items. For more information on how 

to pair a device in your inventory with a future addition to your 

network, check out Chapter Eighteen: “Dynamic Pairing” (page 235). 
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The first section will cover Snapshots. Snapshots are a simple but powerful 

way to recall, or switch between, saved presets of your design. Setting up 

a Snapshot is quick and easy, and the ways in which it can be useful in an 

installation are countless.

So what is a Snapshot? A Snapshot is a memory, which recalls the settings 

of one or more controls. It can apply to a single control, or multiple controls 

in multiple components, or to every control in the entire design. When you 

save a Snapshot, the Snapshot serves as a “picture” of what these controls 

look like at that moment in time. Then when you load that Snapshot 

sometime in the future, all of the controls will revert to the setting they were 

at in the Snapshot. Since Snapshots can be taken of nearly anything in your 

Schematic, they can be very useful for bringing a series of controls to a state 

that you know you will use more than once.

• Create and recall different types of system Snapshots

• Explore various types of Controls and how to customize them

• Create unique User Control Interfaces that let the end user have access 
to specific elements of the design

Control Overview
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EXERCISE 4.1: UNDERSTANDING THE GLOBAL 
SNAPSHOT BANK

1. Go to the Left-Side Pane and 

select the Snapshots panel.

2. Drag the Component in 

the Global branch into your 

Schematic.

3. Double-click the Snapshot 

Controller Global component 

to open its Control Panel.

PINLESS!

“Hey! That component doesn’t 

have any pins!” The Snapshot 

Bank doesn’t need to be wired 

to anything. The component 

simply gives you access to its 

Control Panel.

CUSTOMIZE IT!

If you select the Snapshot 

component and look in its 

Properties panel, you’ll note 

that you can change the 

Snapshot Count field. It is 

currently set to 4. You can save 

up to 24 different Snapshots in 

every Snapshot Bank.

In the Control Panel you will 

see two rows of buttons. The 

green buttons on top will 

Load a Snapshot, and the red 

buttons on bottom will Save a 

Snapshot. By default, this bank 

has a capacity of four different 

Snapshots. The button on the 

left, Load Previous, will load 

the Snapshot to the left of the 

one your design is currently 

in, and the button on the 

right, Load Next, will load the 

Snapshot to its right. 

 

In order to see these in action, you’ll need something in your design that you can 

make changes to.

4. Go the Schematic Library, select Audio 

Components, then Mixers.

5. Drag a Matrix Mixer into your Schematic.

4.1
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6. In its Properties panel, change the 2-D 

Matrix Panner field to Yes. ❶

7. Double-click the Mixer 8x8 

component to open its Control Panel.

8. Enter Emulation Mode by pressing F6 

or selecting File > Emulate. ❶

Now you can adjust the controls of the Matrix Mixer and save different 

Snapshots. The 2-D Matrix Panner is a highly visual way of adjusting a mixer’s 

gain, so this will be a good tool for seeing the Snapshot feature at work.

9. Press the Save 1 button in the Snapshot Controller 

Global control panel.

10. Make some arbitrary changes to the locations of the green 

microphone icons and yellow speaker icons in the interactive section 

of the Matrix Mixer.

Congratulations! You’ve 

already made your very first 

Snapshot. You’re a regular 

shutterbug.

4.1
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11. Press the Save 2 button in the Snapshot Controller Global control 

panel.

12. Press the Load 1 button and notice how the Mixer’s controls 

return to their original design.

13. Press the Load 2 button and notice how the Mixer’s controls 

revert to your arrangement.

14. Use the Load Next and Load Previous buttons to toggle back and forth 

between these two Snapshots.

15. If you like, feel free to adjust other parts of the Mixer as well, such as the Gain 

Faders and the Solo, Invert, and Mute buttons, and save a third and fourth 

Snapshot in your Global Bank. 

4.1
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EXERCISE 4.2: CUSTOMIZING A USER-DEFINED 
SNAPSHOT BANK

Now that you understand how a Global Snapshot works, it’s time to apply it on a 

smaller scale. For most installations, there won’t be a lot of times that you would 

want to recall the settings of every single control in your entire design; more 

likely you will want to recall a Snapshot for one element of your design and leave 

everything else as it is. To do so you’ll need to create a User-Defined Snapshot 

Bank. This Snapshot Bank behaves the same way as the Global Bank, but only 

applies to specific controls or components that you assign to it.

1. If you are still in Emulation Mode from the previous exercise, Disconnect by 

pressing F7 or selecting File > Disconnect.

2. Go to the Snapshots panel in the Left-Side Pane, and click on the Plus icon to 

the right of the word Snapshots.

3. Select Create New Snapshots Bank from the drop-down menu (the other 

option should be inactive).

4. Drag the Component for the new Snapshot Bank you have created (Snapshot 

Bank 1) into your Schematic.

5. Double-click the Snapshot Controller Snapshot Bank 1 component to open 

its Control Panel.

ALTERNATIVE

An alternate way to make a 

Snapshot Bank is to start by 

selecting the element that you 

want to be recorded, such as 

the Matrix Mixer, and then 

clicking on the Plus icon in the 

Snapshots panel and selecting 

Create New Snapshot Bank 

From Selection. This will 

make a new Snapshot Bank 

that is already populated with 

the control(s) or component(s) 

that were selected.

4.2
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You’ll notice that this component looks much like the Global Bank component with 

a few exceptions. By default it has eight Snapshots instead of four, although both 

components are customizable from 1-24 in their respective Properties panel. 

This component also has another section in its Control Panel where you see the 

Ramp Time knob. This knob adjusts the amount of time it takes to fade from one 

Snapshot to another. When you changed between Snapshots in the Global Bank 

the change was instantaneous, but with this Bank you can adjust the change to take 

place over a period from 0-60 seconds. 

 

Before you can use this new Snapshot Bank, you need to tell it which controls to 

record. You can do this simply by selecting the control or component that you would 

like the Snapshot to record, and dragging it into the Snapshot Bank in the Left-Side 

Pane. This does not move the component or control, but simply lets the Snapshot 

Bank know to record its settings as part of each Snapshot.

6. Drag the Mixer component onto the Snapshot Bank 1 Bank in the Snapshots 

panel.

7. Notice when you release the mouse button you’ll see that Mixer 8x8 (All 

Controls) appears in your Snapshot Bank branch. 

Now you have a new Snapshot Bank with the Mixer component loaded into it. 

Any Snapshots you make with this bank will only record the settings of the Mixer, 

and nothing else in your design.

You can move an individual 

control, multiple controls, an 

entire component (and all 

of its controls), or multiple 

components at a time into a 

Snapshot Bank. If you want 

to remove an element from a 

Snapshot Bank, simply select 

its name in the Bank branch 

and press the Delete key. 

This won’t delete the element 

from your Schematic, it simply 

removes it from the list of 

what the Snapshot Bank is 

recording.

“I don’t have anything else 

in my design!“ Of course you 

don’t – right now. But this is 

only an example. In a complete 

design, this would be very 

useful.
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You can rename this Snapshot Bank to keep your different Snapshot Banks 

organized. You can rename it either by double-clicking its name in the Snapshots 

panel, or by selecting the Name field in its Properties panel.

This Snapshot Bank has an 

additional field in its Properties 

Panel – the Mode select. There 

are three different modes:

Normal Mode: 
This mode behaves exactly as the Global Snapshot Bank does.
 
Scene Mode:
This mode will automatically save your Snapshot when you load another one. For 
example, if you have loaded Snapshot 3 and made some changes, then load Snapshot 4, 
the changes you made to Snapshot 3 will save even though you did not press the Save 3 
button.
 
Write Protect Mode: 
This mode will create a new button in the Bank’s Control
Panel that disables all of the Save buttons. You can re-enable 
Save functionality by pressing the Write Protect button. Note 
that the Write Protect button is also present in Scene Mode.

8. Enter Emulation Mode by pressing F6 or selecting File > Emulate.

9. Make some changes to the Mixer’s controls, and save several different 

Snapshots.

10. Adjust the Ramp Time knob, and notice its effect on the time it takes to transfer 

from Snapshot to Snapshot.

11. Be sure to experiment with the different modes of the Snapshot Bank.
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EXERCISE 4.3: COMPETING SNAPSHOTS

What if you have a control in a component that is part of multiple Snapshot Banks?

1. Using the knowledge you now have, create a new Snapshot Bank that only 

controls the Input 1 Gain Fader in your Matrix Mixer.

2. Make several Snapshots of this Fader in different positions.

3. Using the Snapshot Bank 1, make several Snapshots of the entire Mixer that 

involve adjusting the Input 1 Gain Fader to different positions.

Which Snapshot will control the Fader in this circumstance?

4. Load different Snapshots in both Snapshot Bank 1 and Snapshot Bank 2 

(the Bank you created that only controls the Fader).

You’ll notice that both Snapshots can control the Fader. When you load a Snapshot 

that controls the entire Mixer, it will adjust the Fader as well. When you load a 

Snapshot that only controls the Fader, the Fader will move but the rest will not be 

effected.

One of the big advantages of 

using Snapshots is that you 

can integrate them with your 

Command Schedule in the 

Q-Sys Administrator. This 

tool lets you schedule your 

Snapshots to be automatically 

loaded at predetermined 

times, such as to reset your 

system every morning from 

any adjustments of the 

night before. For complete 

instructions on how to use the 

Command Schedule, check 

out   “Exercise 3.4: The 

Command Schedule” (page 

69).

THE POWER OF 

SNAPSHOTS
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7. Make several copies of this fader, either by using the Copy and Paste tools, or 

by dragging more instances of the SAME fader from the Control Panel. You’ll use 

these copies in the next exercise.

REMEMBER ...

This does not remove the 

control from the component, 

but actually clones the control 

so you can move it around 

while still retaining full 

functionality.

EXERCISE 4.4: ADDING CONTROLS TO YOUR 
SCHEMATIC

Leaving Snapshots behind, it’s time to take a closer look at Controls in general.

If you double-click on any component in your schematic, the component’s control 

panel will pop up. You can drag any desired control from the control panel into your 

Schematic.

1. In the Right Side Pane, open the Schematic Library.

2. Select Audio Components. 

3. Select Mixer.

4. Drag a Matrix Mixer into the Schematic.

5. Double-click the Matrix Mixer to open its control panel.

6. Drag an Input Gain fader from the bottom of the control panel and drop it into 

the Schematic.
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EXERCISE 4.5: ADJUSTING POSITION, SIZE, AND 
COLOR

Once a control is dragged out of its control panel, you can alter its appearance in 

many ways, as well as position it in your design however you would like.

1. Select a fader from the previous exercise.

2. Adjust its position by dragging it around the Schematic.

3. Readjust the control’s dimensions by adjusting the blue dots in the control’s 

bounding box.

4. Adjust the dimensions of at least one of your faders so that its width is greater 

than its height.  Notice how the control automatically turns into a horizontal fader 

rather than a vertical fader.

Selecting any control in the Schematic will give 

you access to the Control Properties panel in 

the Right-Side Pane. 

5. Select a new color for your control by clicking 

on the color bar in the Fill field and selecting 

a new color.

6. Give each of the faders its 

own size and color.

7. Enter Emulation Mode 

by pressing F6 or selecting 

File>Emulate, and 

adjust the faders at will. 

Notice how all of them move in unison. Even though you have changed their 

appearance, they have the same functionality because they are all linked to the 

same element of your Matrix Mixer. 

8. Exit Emulation Mode by pressing F7 or selecting File>Disconnect.

You can also nudge the 

component around using 

your keyboard arrow keys, 

or manually change its 

coordinates with the Position 

field in its Properties panel.

You’ve probably already 

noticed the bounding box 

around the fader represented 

by several blue dots. You can 

drag any of these dots to resize 

the fader. If you hold Shift 

while doing so, it will keep its 

proportions consistent.
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EXERCISE 4.6: CHANGING CONTROL STYLES

Changing the style of a control will alter the way you interact with it, which may also 

change the way it functions. A control’s default setting is best suited for its needs, but 

you can change it however you would like.

1. Select one of your faders, then go to its Properties panel in the Right-Side Pane, 

and click on the drop-down menu in the Style field.

2. Change the style of one of your faders to a Button.

3. Change the style of one of your faders to a Knob.

A button simply toggles its value between two options, usually off (0%) or on (100%). 
However there are still different types of buttons:

• Momentary (only active while you’re holding the button)
• Off button
• On button
• String button (adjusts the control to the value in the Button String field)
• Toggle button that switches between on and off.

If you want to change the button’s Off Color, you can click the Unlink icon 
(which toggles between a linked or unlinked chain) and select a new color.

You can adjust the appearance of the button by adjusting the Margin field to create a 
border, and the Corner Radius to round its corners.

If you set the Corner Radius 

high enough, you can create a 

circular button.

4. Change the style of one of your faders to an LED.

An LED simply indicates the status of its value, but does not let you adjust it. A Normal 
LED will turn on and off (on for above 50%, and off for below 50%), while a TriColor 
LED will give you a gradient color to represent its level.

A knob works much like a fader but shows its value as a radius that travels clockwise 
as it increases. To move a fader, simply click its center and drag your mouse up or to 
the right to increase its value, and down or to the left to decrease its value. Like most 
controls, you have the option to Reverse its action to change these directions.

4.6

Add an Icon! In the Properties 

panel, you can assign one of 

many icons to a button, or 

you can even assign your own 

custom image to create a new 

icon. Once you add an icon, 

you can adjust that icon’s color 

and alignment as well.
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1. Change the style of one of your faders to a Meter.

2. Change the style of one of your faders to a Text Field.

Like the fader, you can resize the Meter to make it vertical or horizontal. 
 
The Meter will display its value but, like the LED, does not allow the user to 
adjust that value. The Meter is for monitoring only. 
 
You can toggle the presence of a Text Box that gives the exact value of the 
control. 
 
You can also adjust the Meter Style field to fit your needs (Standard, 
Gain, Level, or Reduction).

3. Enter Emulation Mode by pressing F6 or selecting File>Emulate, and familiarize 

yourself with the way each of these controls works. Again you’ll notice that they 

are all still linked and represent the same signal, even though they have varying 

appearances and functionality. 

This provides an exact textual display of the value of your control. You can also adjust the 
Font Size, Background Color, and Word Wrapping options.

COMBO BOX

You may have noticed a few 

other control Styles, such as 

the Combo Box and List 

Box. There are certain fields 

you’ll come across, such as 

the Root field in an Audio 

Player, that will require you 

to select from a few available 

drop-down options. These 

controls are called Combo 

Boxes. These options have 

been automatically populated 

by the component and are 

not customizable except by 

using Lua scripting. Otherwise, 

it would not serve you any 

purpose to change a control’s 

style to Combo Box as it would 

not have any available options 

in its drop down menu.
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EXERCISE 4.7: TRANSFERRING CONTROL

Once you’ve found a style that you like, you can easily transfer its properties to 

another control.

1. If it’s not already open, double-click your Matrix Mixer to open its control panel 

and drag a different fader into your Schematic (one from a different input than 

you used in the previous example).

2. Drag one of your stylized controls and hold it over your new target fader. You’ll 

see a pop-up text field which will suggest you hold the Control key. Doing this 

will allow you to transfer properties between controls.

3. Hold Control and release your mouse button. A new window will pop up asking 

if you’d like to transfer Control Style or Control ID.

4. Select Transfer Control Style.

5. Notice that your new fader has transformed into your stylized control but is still 

linked to its original signal. You can use this method to quickly and easily give all 

of your controls a uniform design.

6. If you select Transfer Control ID, it will remap the target control to the stylized 

control’s signal, without changing its appearance. This way you can keep a 

stylized control you’ve already created but have it control something new.

“I would like to transfer your 

style to me while retaining my 

own identity, please.”
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EXERCISE 4.8: CUSTOM BUTTONS

What if you don’t like the design of any of the available buttons? You can actually 

make your own custom unique buttons using the Graphic Tools.

1. In the Right-Side Pane, select Graphic Tools.

2. Select the Add Polygon to Design button. 

3. Create your custom-shaped polygon in the Schematic. It can be as simple as a 

triangle to a replica of your company’s logo!

4. Double-click the Matrix Mixer, and drag a fader on top of your custom polygon. A 

text field will suggest you hold the Control key to assign the control to this region. 

Hold the Control key on your keyboard and release your mouse button.

5. Now you have a custom shape that acts as a button, with all the functionality of 

a regular control button.
BONUS 
EXERCISE!

Spend a few hours creating 

replica buttons of everyone 

in your office. Don’t forget to 

label them! Then transfer a 

Mute control to each button, 

and find out if it works!

REAL-LIFE APPLICATION:
You could import an image of your venue’s 
groundplan, and create unique buttons that 
represent each of your rooms. Use this in 
conjunction with the Room Combiner component 
to create an intuitive interface for joining audio in 
multiple rooms. Check out Chapter Seven: Room 
Combiner (page 123) for more information on 
how to do this.
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EXERCISE 4.9: THE USER CONTROL INTERFACE (UCI)

A User Control Interface provides a means by which a User can control 

defined parts of a Q-Sys design via a networked device such as the Q-Sys 

Touch Screen Controller (TSC), Windows based PC, Apple iPad, iPhone, and 

others. The UCI is created in Q-Sys Designer, and has one or more pages 

that can contain controls, indicators, and graphic objects. Graphic objects and 

images can be inserted directly into UCI pages by dragging and dropping, or 

copying and pasting from other applications. UCIs can be simple or complex, 

but most importantly they make navigating and controlling designs much 

easier. Setting up a UCI is quick and easy, and can be rewarding with a lot of 

room for creativity and customization.

BE CREATIVE!

A slick, well-organized UCI 

isn’t just visually impressive 

to clients and guests, it can 

make your design intuitive 

and easy to use for people 

who have never used the 

software before. Customizing 

the controls of your design 

can add a lot of value for the 

end user.
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1. In the Left-Side Pane, expand the User Control Interface panel.

2. Add a new UCI by clicking the Plus icon and selecting New User Control 

Interface.  It will create a new UCI called “Interface 1”.

Each UCI defaults with a single page, but you can add as many pages as you 

like.

3. To add a new page to your UCI, click the Plus Icon and select Add page to,  

then select your new UCI.  When you do this, Page Tabs will appear in your UCI 

Schematic. You can use these tabs to navigate between the pages of your UCI.

By default there is always an 

uneditable UCI nested here 

titled Inventory Status that 

displays the status blocks of 

every item in your inventory.

The Swipe function is primarily 

for iOS devices and larger 

touchscreens. To disable the 

Swipe function, click Yes in the 

Swipe Disabled field.

SWIPE FUNCTION:

UCI PANE:

4. Select ”Interface 1” to begin configuring your UCI in the User Control Interface 

Properties located in the Right-Side pane.

5. In the User Control Interface Properties, you can change the UCI ‘s Title.

6. You can change the Font Size 

of the Page Tabs, as well as their 

position. You can change the 

position of the Page Tabs to 

the bottom, left, right or top. You 

could also select None to make 

them disappear. Instead, you 

could change pages by swiping 

back and forth on your output 

device, or you could create 

custom buttons to change to a new page.
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It’s important to select a Panel Type that best fits the dimensions of your 

device BEFORE starting to create a design. If not, there could be problems 

with the design fitting properly on your device.

When choosing a panel type there are a few different options: The TSC-3, iPhone, 

iPhone5, iPhone6 and iPhone6 Plus, iPad, iPadMini, a Generic 4:3, Generic 

16:10, Generic 16:9, and the Custom setting. The Custom setting allows the 

user to create specific dimensions using the Horizontal Resolution and Vertical 

Resolution fields that most appropriately fit the device being used. 

7. To create a page button within your UCI, drag the page into your UCI Schematic.  

For this example, drag Page 1 & Page 2 into the UCI Schematic. (Note: You will 

have to drag and drop using your right mouse button in order for this to work!)

8. Select a Panel Type that best fits your needs. Changing the Panel Type will 

automatically change the dimensions of your layout page. 

 

It would be very good practice to change this field first everytime you create a 

new UCI. Knowing your UCI’s destination will affect its properties and layout.

10. By selecting Yes in the Private Field, 

your UCI will be hidden from iOS and 

Windows UCI viewers on the network.  

You will only be able to view this UCI 

on the touchscreens connected to your 

Q-LAN network.

4.9

If you are on Page 1 of your 

UCI and you attempt to drag 

Page 2 into the workspace 

to create a button, the act of 

clicking on that Page with your 

left mouse button will navigate 

you to Page 2. Then you’d 

have a button for Page 2 when 

you’re already on Page 2, and 

you’ve have to copy and paste 

it to get it over to Page 1. The 

programmers have instead 

given you the ability, in this 

rare situation, to drag an object 

using your right mouse button 

to avoid this headache. Thanks, 

helpful programmers!

WHY THE 

RIGHT MOUSE 

BUTTON?
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1. To navigate back to the Schematic, click Schematic in the left side pane, then 

click Page 1.

2. Next, drag an Audio Player from the Schematic Library and double-click the 

component to open its Control Panel.

3. Select the controls you would like to bring into your UCI. To select multiple 

controls, hold Shift.  (For this example, select PLAY, STOP and PAUSE.)

4. To copy these controls, press Ctrl+C.

5. Next, navigate back into the 

UCI by selecting your UCI 

under the User Control 

Interfaces.

6. Press Ctrl+V to paste the 

controls and select a position 

on the Schematic for these 

controls.

EXERCISE 4.10: CUSTOMIZING A USER CONTROL 
INTERFACE

Now that you know the basic steps for creating and managing your UCI, it’s time to 

add your own content. You can customize your UCI by adding any controls, indicators 

or graphic objects that you might find useful. You may also want to add your own 

custom images from other applications (i.e. Adobe Photoshop, Adobe Illustrator). For 

this example, we will create a UCI that will control an Audio Player.

You can’t drag entire 

components into a UCI, but 

you can have full control of 

the component by copying its 

controls and pasting them into 

the UCI.

UCI COMPONENT 

CONTROL:
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Accecptable file types are:  

JPG, PNG, GIF;  Q-Sys does 

not accept native Adobe file 

types.

FILE TYPES:

You also have the option to customize these buttons using polygon tools.  For more 

information on this, turn back to the Custom Buttons exercise (page 92). 

You can stylize your buttons by using your own custom graphics (if you’re savvy in 

image-editing software) to create custom button shells for your polygon button and 

then import them into your designs. (If you choose to make custom buttons with 

transparencies, you MUST export these buttons or designs as PNG files or Q-Sys will 

not recognize them).

If you don’t have access to image-editing sofware, some sample button shells are 

available on the QSC Training website as examples for this tutorial.

Drag one of your button shells into your UCI Page. You can resize and move your 

custom buttons and designs around the page.

7. Click the Polygon tool under the Graphic Tools pane in the right side pane.

8. Use the Polygon tool to create an outline of the button’s center (keep in mind 

this does not need to be perfect).

9. Now assign your Component controls to the polygon you’ve just created, by 

clicking and dragging the control over the polygon and then pressing Ctrl and 

releasing.

4.10
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10. Send the polygon button to the back by right clicking the polygon and selecting 

Send to Back.

Similarly, dragging a Custom Background into the UCI will also give you a lot of 

creative control. If you don’t have one on hand please visit the QSC Training website 

to download free premade backgrounds.

11. Drag your background into your UCI Schematic. 

12. Right-click your background image, and in the Order Field, select Send to 

Back.

13. To keep things organized, you can click and drag from the top or left margin 

to create guidelines that will help snap your design objects into place while 

moving them around the page. These lines are for reference purposes only and 

won’t be visible in the final design.

This command can also be 

found under Tools >Order 

>Send to Back.

REMINDER:

The last step will be to load your UCI onto a QSC Touchscreen, iOS device or Q-Sys 

UCI viewer (which is running on a PC on the same network).   

4.10
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If you are using a QSC Touchscreen:

A. Go to the Inventory pane located on the left, click the PLUS icon.

B. Click Peripherals.

C. Select the model of Touchscreen.

D. Click the Touchscreen’s Component and select the appropriate UCI in the 

UCI field under Touch Screen Controller Properties panel. It should be 

assigned to Inventory Status by default, simply change it to your UCI’s name.

To access the UCI on a networked PC:

A. Install the Q-Sys UCI Viewer that can be easily downloaded from the QSC 

website.

B. Run that program, and there will be a list of available UCIs that can be 

accessed. Select the desired UCI and it will appear on screen. 

(Your design will need to either be running on a Core or in Emulation Mode 

for the UCI to appear.)

For an iPhone/iPad: 

A. First you need to install the free Q-Sys App from the Apple Store onto your 

device. 

B. Next connect to the wireless network that your Q-Sys system is located on 

and head into the Q-Sys App and the available UCIs will appear on screen.

To enter Emulation Mode 

click File >Emulate or use the 

keyboard shortcut F6.

EMULATION MODE:

4.10
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EXCERCISE 4.11: UCI ADVANCED CONTROLS

This background is designed to look like a physical mixer deck, with labeled plates 

around the faders, and some fake labeled masking tape with hand-drawn labels that 

really add to the live show feel. The functionality of the UCI below is fairly simple 

and whether you know just a small amount of Photoshop or Illustrator or if you’re an 

expert, you’ll have lots of creative control and freedom. 

Now that you know how to create and deploy a User Control Interface, let’s 

cover the more advanced controls. We will be reviewing a few premade UCIs that 

are available on the QSC Training website. Feel free to open these premade sample 

Designer files and follow along.

EXAMPLE 1:

The illuminated “SOLO” buttons were created using transparencies, similar to the 

button shells from the previous exercise. The word “SOLO” is transparent, and the 

Solo button is beneath the image. The end result is that when the “SOLO” word 

appears to illuminate when the button is selected.

Should you decide to 

create your own buttons it’s 

important to remember to save 

your file in the PNG format to 

preserve any transparency.

REMINDER:

4.11
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This example employs a ground plan of the areas needed to be controlled. 

For the ground plan above we’ve built a series of polygons for each section that can 

be used to mute or activate specific sections of your design.

There’s a handy component for UCIs in the Layout branch of the Schematic Library 

called the Popup Button. When you click on the Popup button, a new workspace 

appears or disappears, like a miniature page imbedded into a button. You can add 

any controls you like into a Popup window, you can change its size, shape and color 

as well. For a design like the one above, you could put a Popup button in each 

section of the arena so that a User can easily touch the area they want to adjust and 

then the controls for that section will show up in front of them - all without leaving 

the blueprint page.

EXAMPLE 2:

You can either create 3D layouts of your own using your favorite CAD program or 

Google SketchUp, or you can download pre-existing designs from the internet.

4.11

EXAMPLE 2:

USE A POP-UP!
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Now that you know how to create custom buttons, you can take this idea even 

further by using custom layouts and designs with transparencies.

1. Download a layout or 3D file (or if you’ve created your own that works too).

2. In your 3D CAD program, select an angle that you like.

3. Now export an image file from your 3D program, as a JPG or PNG and import 

that image into an image editing program.

4. Create polygon cutouts of the areas you’d like to have act as buttons or controls.

5. Turn the transparency down on these cutouts.

6. Now export them as PNG files with transparencies.

7. Drag the new images into the Q-Sys Designer UCI page.

8. Create custom buttons using the Polygon tool and position them under the 

transparency area of your PNG file.

The designs shown here 

were created with a popular 

3D drafting program called 

SketchUp. A free version is 

available at sketchup.com.

NEED HELP?

EXAMPLE 3:

4.11
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The Audio Player is one of the most popular components in the Q-Sys 

Designer software. The Audio Player does exactly what its name describes: it 

can play audio files which have been uploaded to the Core’s internal media 

drive. These files can be in the form of MP3, WAV, or FLAC files. The Audio 

Player could almost be considered a virtual CD player or iPod™ that lives 

inside the Core.

While most people are quite familiar with the simple buttons that operate any 

media player, there are a few techniques you should be familiar with when 

integrating Audio Players into your Q-Sys design. This chapter will show both 

the very basics of how to operate the Audio Player as well as highlight a few 

features that may not be immediately evident.

• Learn the basic functionality of the Audio Player component

• Monitor your design’s Audio Player Channel Count

Audio Player

In This Chapter:

CHAPTER MAP

5.1  THE AUDIO PLAYER 
COMPONENT  page 104

5.2  AUDIO PLAYER 
TRACKS  page 106

5.3  PLAYLISTS page 108

5.4  AUDIO RECORDER 
page 109

5.5  TIMELINE page 110

CHAPTER FIVE
TRAINING

NOTE: Parts of this tutorial can not be completed in Emulation Mode and 
require connection to a Core.



104Q-SYS TRAINING CHAPTER FIVE: AUDIO PLAYER

EXERCISE 5.1: THE AUDIO PLAYER COMPONENT

1. In the Schematic Library, open the Audio Components branch, and drag an 

Audio Player into your Schematic from the Audio Players sub-branch.

By default it has two output pins, which represent two tracks of an audio file; for 

most users these will be the left and right channels of a stereo music track. It doesn’t 

have any input pins because its audio source is the file you select from the onboard 

Q-Sys Media drive.

2. Run your design to the Core by pressing F5.

3. Double-click the Audio Player component to open its Control Panel.

4. Select a file on your Core to play using the Root, Directory, and File fields. The 

Root field selects the primary audio folder, the Directory field selects a subfolder 

(if you have created one), and the File field selects the file name. 

WHY AM I
RUNNING?

Running is an excellent 
cardiovascular exercise that 
promotes good health. Also, 
running your Q-Sys design to 
the Core is the only way that 
you can process its audio. 
While you can accomplish 
many administrative or 
configuration tasks in design or 
Emulation mode, you need to 
be running on a Core in order 
to access any active audio 
such as the output of an Audio 
Player.

WHAT IF THERE 
ARE NO FILES TO 
SELECT?

You can learn how to upload 
files to the Core in “Exercise 
3.7: Audio Files” (page 
75).

5.1
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5. Start the file by clicking the Play button.

6. You can Stop or Pause the file using the appropriate buttons, or set the file to 

play again whenever it is finished by activating the Loop button.

Note: if you are using a Scheduled Event to trigger an Audio Player and you wish 

that event to repeat, use the Repeat and Loop options within the Event and not the 

Loop button in the Audio Player. The Audio Player Loop will cause the file to repeat 

indefinitely, which would cause your Event to never stop.

7. If you select the Auto Play button, this file will automatically play whenever the 

design is loaded to the Core.

8. Adjust the file’s gain using the Gain Knob, or use the Mute button to mute the 

audio without stopping it.

The Time indicator shows the elapsed time of the currently playing file, and the 

Status field displays pertinent information about the active file. If you are not sure if 

your file is a stereo or mono file, this information is displayed. If the file is invalid or 

corrupt, the Status bar will notify you as such.

Q: Why can’t I hear the music?

A: Well, approximately 12% 
of the population suffers 
from some sort of hearing 
impairment. But more likely, 
you can’t hear the file because 
your Audio Player isn’t wired 
to any loudspeakers. You 
can hover your mouse over 
the output pin and click the 
Unmute button to listen in 
on this component. For more 
information on this Hover 
Monitor, check out “Exercise 
6.2: Understanding the 
Test and Measurement 
Components” (page 113).

5.1
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EXERCISE 5.2: AUDIO PLAYER TRACKS 

By default, each Core can simultaneously play up to 16 tracks via one or more 

Audio Players. For most users, this would commonly be divided amongst eight 

different Audio Players playing eight different stereo files that are sent to different 

destinations at the same time. It could also be distributed amongst up to 16 Audio 

Players playing mono files, or various combinations of the two.

Advanced users may be playing multi-track WAV files that have three or more tracks, 

such as a master recording where each instrument or vocal is on its own track. You 

can adjust the number of tracks that an Audio Player uses by selecting the Audio 

Player and going to its Properties panel. Simply change the Track Count field to 

the appropriate number.

16 TRACKS 16 TRACKS

16 TRACKS 16 TRACKS

It’s important to note that any Audio Player in your design will use part of your 

maximum Track capacity regardless of whether or not audio is being currently 

played, even if the component is not wired to any audio destination. Thus, if you are 

using an Audio Player to play a mono file, it is a good idea to change its Track Count 

to 1 so as not to waste one of your available tracks.

TRACKS ARE 
TRACKS, NOT 
MIXES!

If you have a stereo file, you 
can’t cheat the system to try 
and gain an extra Track by 
dropping the Audio Player’s 
track count to 1. This will 
not sum your left and right 
channels and output a mix – it 
will simply only play the first 
track of your stereo file and 
leave half your music behind. 

Similarly, if you play a mono 
file from an Audio Player 
with two tracks, the second 
output pin will not duplicate 
the first pin’s signal, because 
it represents a nonexistent 
second track and will remain 
silent.

5.2
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At any point you can go to the File Menu and select Check Design (or select 

Shift+F6) to find out how many of your audio tracks are currently in use.

If you exceeded your audio track capacity, you will be presented with a warning on 

this screen.

Remember that you can fan-out 

any or all of your sixteen tracks as 

many times as you’d like throughout 

your signal path without using any 

additional available Audio Player 

Tracks.

UPGRADE YOUR TRACK CAPACITY!
If 16 tracks isn’t enough for your venue, don’t worry! You can upgrade your Core to handle 

up to 128 simultaneous tracks. When you order your Core from QSC, simply select this 

option to be sure you can handle all your installation’s audio needs. You can also elect to 

upgrade the storage capacity of your onboard media drive. Note that you are required to 

upgrade the media drive if you select the 128 multi-track option.

1 TRACK

5.2



108Q-SYS TRAINING CHAPTER FIVE: AUDIO PLAYER

EXERCISE 5.3: PLAYLISTS

A single Audio Player isn’t limited to playing only one file –  you can also set up 

playlists.

1. Select the Audio Player and go to its Properties panel in the Right-Side Pane.

2. Change the Playlist Capable field to Yes.

3. Double-click the component to open its Control Panel.

By enabling Playlist Capable, a new field will be accessible in the Control Panel that 

allow you to load a playlist rather than a just single file. You can create and customize 

your playlist in the Audio Files tab of the Q-Sys Administrator.

At the bottom of the Control Panel are additional controls for the playlist. You can 

choose to randomize the list by selecting the Shuffle button, you can set the playlist 

to Repeat, return to the First file, or advance to the Previous or Next file in the list 

with these buttons. 

EXPAND YOUR
KNOWLEDGE!

Learn all about creating 
Playlists, loading audio to your 
Core, and even creating Events 
to automatically trigger your 
Audio Players in Chapter 
Three: Configurator & 
Administrator (page 60).

5.3



109Q-SYS TRAINING CHAPTER FIVE: AUDIO PLAYER

EXERCISE 5.4: AUDIO RECORDER

The Administrator isn’t the only way to put audio onto the Core for playback. You 

could also use the Audio Recorder component, which is available in the Schematic 

Library. You could use this device to record the audio of an event in your venue, or to 

record announcements that could be played by an Audio Player or a Public Address 

system.

You can adjust the number of tracks the Audio 

Recorder will record in its Properties panel. All 

other adjustments are made in its control panel.

Here you can specify 

the destination folder 

for your recorded 

file, as well as input a 

prefix for its file name 

and choose to includ 

the Date, Time, or 

Sequence number as 

part of its name as 

well. You can choose 

from any of the three 

file formats as well 

as variable bitrate, 

sample rate, and 

maximum file length.

If you choose Continuous Recording Mode, you may also want to select 

Quantize Rollover Time. This option will align the maximum file length with an 

appropriate time stamp of the clock: so if your maximum file length is 1 hour and 

you start recording at 3:55, then the first file will last from 3:55 to 4:00, then you’ll 

have a new file for the 4:00-5:00 hour, another for the 5:00-6:00 hour, and so on.

Finally, you can choose whether or not you’d like these recorded files to be cleaned 

up and removed from the media drive, based on their age or size.

5.4
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EXERCISE 5.5: TIMELINE

Advanced user may wish to explore the Timeline 

component (which, at the time of this publication, is still 

in BETA). The Timeline allows you to play multiple audio 

tracks simultaneously, orchestrated in a synchronized 

multi-layer audio environment. Timeline is only available 

while running on a Core.

The majority of the Timeline will show the various tracks of your Timeline, layered 

horizontally. You can place audio files from the directory browser on the left-side of 

the window onto any track, to start or stop at any point you desire. If the visual wave-

form of the track does not appear, you can double-click the track to have it analyze 

the track and populate the wave-form. Each track has yellow handles at its in- and 

out-point that let you adjust its fade-in/fade-out time. If you double-click the yellow 

handle, the style of its fade will toggle between linear, bezier, slow, or fast.

You can add Markers in the top track that launch specific functions, such as jumping 

to another point in the timeline, pausing the timeline, adjusting a Named Control, 

or loading a Snapshot. This means that virtually any control in your design can be 

managed by the Timeline, giving your creativity full control over how the entire 

design can behave during the Timeline’s deployment.

To add a Marker, simply double-click at a point in the top track, and then select the 

Marker to adjust its settings. You can even create a Control Track to manage a 

specific control’s settings over the course of the Timeline.

Keep an eye for a video Timeline tutorial on www.qsctraining.com when this 

component exits BETA mode and is ready for full deployment.

5.5
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The Q-Sys Designer Software provides you with several useful tools to test 

your system’s functionality and measure its signals. In this exercise you’ll 

familiarize yourself with these components within a test system to better 

understand how you can integrate these tools in an active system.

It’s an all-too-familiar experience: checking a microphone and hearing 

nothing. Although it’s probably only a minor problem that can be quickly 

fixed, you might spend an hour of frustration before you find out exactly what 

that minor problem is. Is it a bad microphone, or a cable unplugged? Is it 

muted somewhere along the line, or being sent to the wrong amplifier? With 

the Test and Measurement tools in the Designer software, you can narrow 

down the possible problems in mere moments.

• Simulate a broken audio path and use the Test and Measurement tools 
to troubleshoot and identify the problem

• Learn about advanced Test and Measurement tools in the software.

Basic Test
and Measurement

In This Chapter:

DON’T GO CRAZY!

Before you start rewiring anything, jump into the 

Designer to troubleshoot the problem with the 

Test and Measurement tools.

• NOTE: You will need to be linked to an active Q-Sys Core to complete this tutorial.

CHAPTER SIX

CHAPTER MAP

6.1  CREATE A SIMPLE 
SIGNAL PATH  page 112

6.2  UNDERSTANDING 
THE TEST AND 
MEASUREMENT 
COMPONENTS           
page 113

6.3  TEST AND 
MEASUREMENT IN 
ACTION  page 117

6.4 ADVANCED TEST 
AND MEASUREMENT 
page 120

TRAINING
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EXERCISE 6.1: CREATE A SAMPLE SIGNAL PATH

In order to test a signal, you need to create a signal path.  

1. In your Schematic Library, select 

Audio Components.

2. Drag an Audio Player into your 

Schematic.

3. Drag a Meter into your Schematic.

4. Select Equalizers and Filters.

5. Drag a Parametric Equalizer into 

your Schematic.

6. Wire the output pin of the Audio 

Player to the input pin of the 

Parametric Equalizer.

7. Wire the output pin of the Parametric 

Equalizer to the input pin of the Meter (which will now be displayed as a True 

Peak/RMS Meter).

STEREO VS 
MONO

QUESTION: The Audio Player 

has two output pins, but the 

Parametric Equalizer only has 

one input pin. How can I test a 

stereo signal?

ANSWER: Good question. If 

you click on the components 

of the Parametric Equalizer 

and the Meter, you can 

change their Channels Type 

to Stereo in the Properties 

panel of the Right-Side Pane. 

Then you can wire stereo lines 

between all three components.

Now you have a very basic signal path. Audio is played from the Audio Player, which 

is sent to a Parametric Equalizer for adjustment, and terminates at the Meter. For the 

sake of this exercise, the Meter represents the audio being sent to a loudspeaker. In 

a real system, this would be done by sending the audio to an I/O Card which would 

then send it to an amplifier and then a loudspeaker. We’ve used a meter so that we 

can see the audio that we would be able to hear in a real-life situation.

6.1
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EXERCISE 6.2: UNDERSTANDING THE TEST AND 
MEASUREMENT COMPONENTS

1. In your Schematic Library, select Audio Components.

2. Select Test and Measurement.

3. Drag an RTA into your Schematic.

4. Drag a Signal Injector into your 

Schematic.

5. Drag a Signal Probe into your 

Schematic.

6. Drag a Pink Noise Generator 

into your Schematic.

7. Drag a Sine Generator into your Schematic.

8. Drag a White Noise Generator into your Schematic.

That’s a lot of components to grab at once! Don’t worry, these tools are easy to 

understand and simple to use, so you can learn about a few of them at a time.

9.  Move your White Noise Generator, Pink Noise Generator, and Sine Generator 

next to each other.

6.2
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These three components create different signals that can be useful in testing your 

system. Their properties are simple: you can adjust their color and the number of 

output pins (Mono, Stereo, or Multi-Channel to add up to 256 output pins).

• The Pink Noise Generator produces 
random frequencies that are distributed 
uniformly in each octave band.  

• The White Noise Generator produces 
random frequencies across the entire 
audio spectrum. 

• The Sine Generator produces a sine 
wave of variable frequency, which the 
user can select.

If you double-click on any of these components you will have access to their Control 

Panel. Each one has a Mute button to mute the signal and an RMS Level knob that 

lets you adjust the decibels of the signal. The Sine Generator also has a Frequency 

knob that adjusts the frequency of the sine wave.

You’ll use these tools to create a digital signal in your system, one that will create 

continual reliable noise so that you can search for breaks in your signal path.

“TESTING. ONE TWO 

THREE. TESTING. SIX 

HUNDRED ...”

This should be a little more 

reliable than droning on 

endlessly into the microphone.

6.2
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Next we’ll look at the RTA (or Real-Time Analyzer) which gives you a visual 

representation of your signal. The RTA has only one input pin, which is the signal you 

want it to analyze.

10. Double-click the RTA to open its Control Panel.

❶ The Response graph shows the magnitude of the input signal over the  
 audio frequency range. 

❷  RMS Response Time adjusts how quickly the RTA responds to changes  
 in the input levels.

❸ Max Hold Time adjusts how long the maximum magnitude displays are  
 held before refreshing.

❹ Infinite Hold button holds the display until you disengage the   
 button. While held, the RTA will only update if a higher magnitude is   
 detected than the held response.

❺ Clear Response button clears the display.

❶

❷

❸

❹

❺

In order for these tools to work, they’ll need to be inserted into your signal path. 

That’s where the Signal Injector and Signal Probe come in to play. 

11. Wire one of your Generators to the 

input pin of the Signal Injector.

FEELING 
BOLD? SEE IT 
IN ACTION!

Rather than just read about 

what these buttons do, check 

it out for yourself! Wire a 

noise generator or even your 

Audio Player to the RTA, save 

your Design to the Core, and 

experiment with what each 

button does to the Response 

graph. Once you’re done, 

disconnect from the Core and 

proceed with the exercise.
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12. Wire the output pin of the Signal 

Probe to the RTA.

13. Double-click the Signal Injector and Signal Probe components to open their 

Control Panels.

14. Drag the diagonally-labeled Injector and Probe tools from their Control Panels 

into the Schematic.

These two tools can be attached to any input or output pin along the signal path. 

Once your system is active, you can click on the Injector or the Probe tool, and then 

select the input or output pin you would like to attach to. QUESTION: You’re saying 

I can input a signal into an 

output pin. That doesn’t make 

any sense.

ANSWER: First of all, that 

wasn’t a question. Secondly, 

the injector interrupts your 

signal path anywhere you want 

– which could be just after 

the audio player sends out its 

audio. You override this output 

by injecting your own signal.

The Injector will “inject” your new audio source into the 
signal path at the point you select. This will override all 
other input at the point of insertion, and only the audio 
source that is wired to your Injector will proceed along the 
path from there. 

This is a great way to debug a system when you don’t know what’s wrong. If 
you’re not getting any audio output from a microphone and you need to test the 
system, you can attach the Signal Injector to your microphone signal path. By 
digitally injecting in pink or white noise, you’ll quickly troubleshoot if you have a 
broken signal path or a bad microphone.  

The Probe can monitor your signal at any point in the 
signal path. Like the Injector, just attach it to any input or 
output pin to “tap into” the line. Unlike the injector, this 
does not override the outgoing signal. Since you have 
wired your probe to the RTA Meter, this meter will show 
you the signal that the Probe is attached to.

6.2



117Q-SYS TRAININGCHAPTER SIX: BASIC TEST AND MEASUREMENT

EXERCISE 6.3: TEST AND MEASURMENT IN ACTION

It’s time to put these testing tools, well, to the test. 

1. Save your design to the Core and run by pressing F5 or selecting File > Save to 

Core and Run.

2. Double-click the Audio Player to open its Control Panel.

3. Select the File field and select an audio file on the Core to play.

4. Press the Play button in the Audio Player.

You pressed play, but you can’t hear any music, right? That’s because the music is 

playing in your design, but it’s not being sent out to any loudspeakers. In a real-life 

situation your signal path would probably involve amplifiers and loudspeakers, but for 

this exercise we’re only sending the audio to the Meter.  

 

However, you can use your computer 

speakers as a monitor, using another 

testing tool called the Hover Monitor. 

Hover your mouse over the input pin of 

your True Peak/RMS Meter. You’ll see 

a miniature RMS Meter appear over 

the pin. This pop-up is called the Hover 

Monitor, and is available for every input 

and output in your design. 

If you don’t have any audio 

files on your Core, you’ll need 

to load at least one to it now. 

You can go to “Exercise 3.7: 

Audio Files” 

(page 75) to 

learn more about this process, 

or follow these quick steps: 

1) Select the blue Q-Sys 

Administrator icon in the 

upper right-hand corner.

 

2) Select Audio Files.

 

3) Double-click the Audio 

folder.

 

4) Click the Plus Icon, and 

select an audio file (or files) 

from your desktop to load to 

the Core.

STILL CAN’T 
HEAR 
ANYTHING?

Make sure your computer 

audio card is properly 

configured in the Designer 

software by selecting File > 

Preferences and adjust the 

Audio Monitor settings. Press 

the Test button to make sure 

your speakers are working.

6.3
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The Hover Monitor has two interactive features.

Unmute will let you hear this audio through your computer 

speakers. You can click this icon again to return to mute. 

5. Pin open the Hover Monitor of your True Peak/RMS Meter, and Unmute it to so 

you can always hear the end result of your signal path. 

Now that you have audible music playing in your system, you’re going to simulate a 

system failure so you can put your testing tools to use.

6. In the Audio Player Control Panel, toggle the Mute button to 

silence the feed. 

While this is a simple design, there are still many things that could be wrong in a real-

world example. You don’t know if your audio source is broken, if your loudspeakers 

have failed, or if there is a break in your signal path. There are a few ways you could 

use your tools to test this.

7. Select the Probe tool and attach it to the output of the Parametric Equalizer. 

Pin will keep the hover monitor open. If you don’t select this, it 

will disappear as soon as you move your mouse away from the 

meter.  You can click this icon again to allow it to close.

If you are currently thinking 

to yourself, “I could pin this 

open and use my headphone 

jack as the main output for the 

audio in my building” then you 

should probably ask a more 

qualified audio engineer to 

take over your job.

8. Notice that the RTA does not 

show a signal. This means the 

Equalizer is not outputting a 

signal.

QUICK THINKING

6.3
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9. Attach the Probe to the input 

of the Equalizer. There is still no 

signal. This means the Equalizer 

is not even receiving a signal, 

and the problem must be in the 

Audio Player.

10. To prove this, remove the Probe and attach the Injector to the output of the 

Audio Player.

11. Since your Injector is 

connected to one of your 

sound Generators, you should 

now hear noise through the Hover 

Monitor. This way you know that 

your signal path from the Audio 

Player output is working, and you 

have successfully isolated the 

problem.

6.3

With just a few quick clicks, you were able to identify that the problem was in your 

Audio Player. If you opened it to investigate, you would discover that you had left the 

Mute button active. In a simple design like this, it may not have saved you a ton of 

time ... but in a large design, this may save a lot of effort in hunting problems.

Feel free to do another 

exercise. Make some 

terrible distortion in your 

Parametric Equalizer, and 

use the tools to see how 

quickly you could figure 

out where the source of 

the problem is.
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6.4

EXERCISE 6.4: ADVANCED TEST AND MEASUREMENT

You can make your test and measurement tools even more powerful by creating an 

Advanced Test and Measurement hub, where you keep all the tools you may need to 

troubleshoot your design. This exercise shows just one example of how to build one.

To start off with, you’ll need a Router. Drag a Router into your Schematic and rewire 

your Test and Measurement Tools to flow through it:

This lets you choose which type of noise generator you’d like your Signal Injector to 

use without having to disconnect from the Core to rewire it.

With this Router, you’ve just given yourself the ability to route your Signal Probe to your 
Signal Injector. This means that you can now perform a virtual soft patch.

If it’s one minute to showtime and you suddenly need to send a monitor signal to a 
destination that it is not wired to, you would normally have to disconnect from the Core, 
edit the design, and then redeploy. That means taking the audio system temporarily offline - 
which may simply not be an option. Instead, you could attach your Signal Probe to the audio 
source, route it to the Signal 
Injector, and then Inject that 
audio to its new destination.

In essence, this gives 
you the ability to wire 
components together 
virtually using Probes/
Injectors while the design 
is still running. In fact, you 
could create an entire bank 
of Probes/Injectors routed 
to each other as a soft-patch 
repair kit, as seen here:

MAKE A PATCH BAY

In this example, we’ve placed 

our Patch Bay tools inside a 

Container. You can find the 

Container in the Layout section 

of the Schematic Library. It has 

an empty control panel, but 

you can drag anything you 

like in there. If you wanted to 

route audio into or out of a 

container, you can determine 

how many input/output pins 

it has as well - it’s basically 

another Schematic Page 

hidden inside a component! 

Perfect for hiding away things 

like this virtual Patch Bay.

THE CONTAINER
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Next, add some additional audio sources to the Router: the IO Monitor and the 

Loudspeaker Monitor.

The IO Monitor can be found in the Test and Measurement branch of the 

Schematic Library. It has one output audio pin, which you can populate with 

whichever IO channel in your system you like. If you open its control panel, you’ll see 

that you simply need to specify which channel of which device you wish to use.

First choose the 

Location. The options 

here will consist of the 

various locations you have 

defined for your inventory 

items in their properties.

Next select a Device in that location. Any inventory item in the design that has valid 

input or output channels integrated in the design will be available to select.

Finally, choose the Channel. You can choose from any channel of a valid I/O Card, 

or a Mic Lin In channel from an IO-22, PageStation, or other peripheral.

This component lets you quickly select any input or output channel in your design as 

the source of audio to test, so that you can be certain exactly what audio is present 

at the input and output points of your system. And, by routing these signals through 

your Test and Measurement hub, you have the ability to send any signal to a new 

destination via the Signal Injector.

GOOD 
HOUSEKEEPING

The IO Monitor is another 

example of how you can do 

yourself a favor by keeping 

your design organized. It’s 

awfully easy to add Inventory 

items and not define a specific 

Location for each one, and 

let them all group into the 

“Default” location. But if 

you do your homework and 

assign each one its proper 

location, then devices like the 

IO Monitor will be much easier 

to use.

6.4
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The Loudspeaker Monitor, on 

the other hand, will not be found in 

the Test and Measurement tools. It’s 

actually a component of the Core, 

and is thus considered a hardware 

device. You will need to drag it into 

the schematic from the Inventory.

This component also has one output audio pin, with nothing but a gain fader and 

mute in its control panel. In order to produce audio, you must choose to send audio 

to the Loudspeaker Monitor from a specific loudspeaker’s control panel.

This functionality is dependent on using DataPort-enabled amplifiers. You already 

know that using DataPort amplifiers allows you to perform extensive monitoring of 

your loudspeakers (and automatically provide Intrinsic Correction tuning for QSC 

loudspeakers), which means that it can also send you a signal equivalent to the 

actual output of the loudspeaker itself. In any loudspeaker’s control panel (even a 

Generic Speaker) there is a section on the right labeled “Monitor.”

By toggling the Listen button, this loudspeaker will be used as the source for the 

Loudspeaker Monitor’s audio pin. Only one speaker can be active at a time - if you 

select the Listen button on a new loudspeaker, it will deactivate the previous one. 

With this component, you can listen to the output of any loudspeaker, even in a huge 

venue, just by clicking on a single button.

These Test and Measurement tools are great ... 
if you’re connected to the system. But what if 
you’re halfway around the world? If the venue’s 
IT department is able to give you access to the 
network remotely, you can connect to the system 
from anywhere using the Hard Link tool. Simply 
go to the File Menu, select Preferences, and 
select the Hard Links tab. You can manually input 
an IP address of a remote Core so that you can 
troubleshoot a system from anywhere in the world. All of the tools work over this remote 
link, even the Hover Monitor, which will stream MP3 audio back to you in real-time.

HARD LINK - THE ULTIMATE TESTING TOOL

SAVE YOUR WORK!

Once you’ve built this 

Advanced Test and 

Measurement Hub, you don’t 

want to build it every time you 

make a new design, do you? 

Select all of the components 

and drag them into the User 

Library in the Right-Side 

Pane. This Library is saved 

as part of your computer, so 

when you start a new design 

you can drag a single element 

from the User Library into the 

design and you have all your 

Test and Measurement tools 

ready for you! (Note: Since the 

Loudspeaker Monitor is part 

of the inventory, it cannot be 

duplicated by the User Library)

6.4
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If you properly design your sound design and 
couple it with a clever Q-Sys User Control Interface, 
you’ll be able to provide a highly visual way for 
your end user to transform an enormous ballroom 
(left) into separate meeting rooms (right).

USING 
AIRWALLS:

The Room Combiner lets you combine the audio signals to and from multiple 

rooms. Whether your venue has a large hall with airwalls, or multiple meeting areas 

that need to share audio sources in specific scenarios, this component offers a very 

simple way to control the audio sources in those areas.

• Understand how to configure a sound design to allow for combining 
signals from multiple rooms

• Design a sample ballroom with 4 rooms and use the Room Combiner 
component to allow for different sound-sharing capabilities

Room Combining

In This Chapter:

CHAPTER SEVEN

CHAPTER MAP

7.1  UNDERSTAND 
THE ROOM COMBINER      
page 124

7.2  WIRING THE ROOM 
COMBINER  page 125

7.2  DESIGN YOUR 
SPACE  page 126

TRAINING
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The default Room Combiner 
is set to eight rooms, so 
you’ll notice eight input pins 
and eight output pins on the 
component. You can use up to 
256 rooms in a single Room 
Combiner.

1. Open the Schematic Library in the Right-Side Pane.

2. Select Audio Components.

3. Drag a Room Combiner component into the Schematic.

In the Properties panel in the Right-Side Pane, you’ll note that you can 

change the number of Rooms. You can also change the Channels field from 

Mono to Stereo. The Walls field lets you input the number of adjustable 

walls that open or close in your venue. Finally, you can add up to 32 inputs 

for BGM Inputs (Background Music).

4. For this exercise, change the 

number of Rooms to 4, change the 

number of Walls to 4, and change 

BGM Inputs to 2. Double-click the 

Room Combiner to open its control 

panel.

USING ROOMS:

The Input section lets you control the gain for each 

room’s input.

The BGM section lets you control the gain for each 

room’s background music. 

The Output section lets you control the 

combined output gain to each room, or mute 

it entirely. An LED above each gain fader 

indicates which room that room is linked to. 

The BGM Input section lets you control the gain 

or mute of each BGM feed.

The Wall section lets you control which walls are 

open, which will combine the rooms.

7.1

EXERCISE 7.1: UNDERSTANDING THE ROOM COMBINER
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EXERCISE 7.2: WIRING THE ROOM COMBINER 7.2

The point of the Room Combiner is that it creates a point at which multiple signal 

paths can be combined - however, it only combines these paths when and how 

you decide. This means that the entire path of a room can be funneled through the 

Room Combiner rather than creating multiple paths - no need to have a “combined” 

path and an “uncombined” path. Everything flows through the Room Combiner, and 

if the walls are closed then the audio leaves exactly as it entered.

For instance, if the signal path for the four rooms in question consisted of four Audio 

Players being directed to four different I/O Cards like this:

Then the Room Combiner could be integrated like this:

Each of the rooms flows through the Room Combiner to its outputs and its audio 

will only be combined with the audio of another room when the Room Combiner is 

told to. In this scenario, the two BGM pins are still empty, but another audio source 

could be connected to these pins so that any of the four input sources could choose 

between the two potential background music sources.

ROOM 1

ROOM 2

ROOM 3

ROOM 4

ROOM 1

ROOM 2

ROOM 3

ROOM 4

ROOM 1

ROOM 2

ROOM 3

ROOM 4

ROOM 1

ROOM 2

ROOM 3

ROOM 4
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For this exercise, you will create one large square banquet hall that has 

accordion-style dividers that can split the room in half in either direction, 

creating four equally-sized small conference rooms. If you’re feeling 

comfortable, feel free to design a more complicated space, or even one 

based on your own venue.

 

The most important part of the control 

panel is the Wall section at the bottom, 

where you must specify which rooms 

each Wall will combine. But this may be 

difficult to imagine without some sort of 

groundplan first. A groundplan will also be 

useful to the end user, so let’s start there.

1. Draw a representation of each room 

in the design with the Polygon Tool 

from the Graphic Tools. Click on the 

Polygon Creator button, then draw a 

square shape in your schematic.

2. Repeat this process to make four equally sized polygons, arranged in a square 

layout. Leave enough space in between each room to place buttons that will 

represent the walls. Label each room by double-clicking on the polygon and 

typing in a label, such as “Room 1.” 

Right now, these shapes and labels are purely aesthetic – they’re not tied to 

the Room Combiner yet.

3. From the Room Combiner control panel, 

drag the grey Open button that represents 

Wall 1 into your schematic. Place it in the 

empty space between Room 1 and Room 

2. Use the blue bounding circles 

to adjust the shape so that it fills 

the entire space between the 

two polygons.

You might ask yourself... “Why 
can’t I use the Group Box 
instead of the Polygon Tool to 
draw my rooms?” After all, it 
looks easier to use, because 
it will make a box for you 
already. But the Group Box’s 
primary use is for labeling 
and organizing, not creating 
interactive objects. As we’ll see 
later on, you’ll find that making 
your square with the Polygon 
Tool will allow us to apply 
controls to it which will greatly 
enhance your end user’s ability 
to control the system.

BUT WHY 
CAN’T I...

EXERCISE 7.3: DESIGN YOUR SPACE
7.3
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4. Repeat this process to build the other three walls, then label your walls just as 

you labeled the rooms. 

Now that our map makes a little sense, we can go back and configure the walls.

5. Enter Emulation Mode by pressing F6 or selecting File>Emulate.

6. Click on the Rooms field for Wall 1 and type in the numbers of the rooms that 

this open wall will combine, separated by a space. Wall 1 would be  “1 2”. 

7. Repeat the process for each wall. For Wall 2 enter “2 3”, for Wall 3 enter “3 4”,  

and for Wall 4 enter “4 1”. 

 

Now you have an interactive design. Each of those “walls” you created is 

actually a button which combines the two rooms to which it is adjacent.

8. Click Wall 1 button to combine Rooms 1 and 2.

You’ll see in the Room Combiner control panel that their Combined LEDs 

light up the same color. If you click on Wall 3 to combine Rooms 3 and 4, 

their LEDs will light up different colors, indicating they are also combined but 

not to Rooms 1 and 2. 

Don’t forget the space 
when you are entering the room 
numbers into the Rooms field, 
or else in this example you’ll be 
combining Room 12 to … well, 
to nothing. And you don’t even 
have a Room 12 in this example!
You can also use a comma to 
separate values, or you could 
use a dash to combine multiple 
rooms. For instance, entering 
“1-4” would combine all four 
rooms.

POTENTIAL 
ROADBLOCK

7.3
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9. Exit Emulation Mode by pressing F7, or selecting File>Disconnect.

10. In the Room Combiner control panel, drag the Combined LED for Room 1 over 

your polygon for Room 1 but do not release the mouse button yet.

A text box will notify you that if you hold the Control key, you can apply this 

control to your polygon. You want to do this.

11. Repeat this process for each of the rooms.

12. Enter Emulation Mode by pressing F6, or selecting File>Emulate.

Now when you open a wall 

between two rooms, those two 

rooms will light up the same 

color. Feel free to open and close 

different walls now to see this in 

action. You can quickly get an idea 

for how easy this control will be for 

almost anyone to use.

You can create helpful preset 
buttons by adding an additional 
wall and configuring it to 
combine more than one room.  
In our example, add a 5th wall to 
the Room Combiner, then in the 
Rooms field, type: 
“1 2 3 4” (Don’t forget to 
include the spaces)

This will open all 4 walls and 
combine the signals for all 4 
rooms. 

COOL
TRICKS

THE LINK BUTTONS

You may have noticed the pink Link buttons inside the Room 
Combiner’s control panel. You can control the input and 
output gain for each room and background source individually, 
but when the rooms are combined these other controls are 
synchronized as well. If you would like to maintain individual 
control over a parameter even when the room is combined with 
another one, deselect the Link button for that parameter.

Also, when two rooms become combined, the linked controls will take on the value of 
whichever individual control was lower. This means that if one room is muted and it is 
combined with another room that is not muted, both will be muted.

7.3
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Let’s take a look at a couple of the automatic mixers that are built into the 

Q-Sys Designer software. Both the Gain-Sharing Automatic Mic Mixer and 

the Gating Automatic Mic Mixer adjust their output gain to your preferred 

level by automatically gating and adjusting the attenuation of the inputs.

Both of these mixers will allow a number of audio inputs to pass, while 

attenuating others based on their level and frequency. This can be used in 

situations where multiple people are speaking using different microphones, 

such as boardrooms, classrooms, courtrooms, etc. Rather than a technician 

manually adjusting microphone levels, these mixers are signal-activated and 

ensure unity gain at all times.

• Learn the functions of and differences between the Gain-Sharing 
Automatic Mic Mixer and the Gating Automatic Mic Mixer

• Build a sample system to demonstrate both Automatic Mixers in action.

Automatic Mixers

In This Chapter:

• NOTE: You will need to be linked to an active Q-Sys Core to complete this tutorial.

CHAPTER EIGHT

CHAPTER MAP
8.1  BUILD A GAIN-
SHARING SYSTEM      
page 130

8.2  THE GAIN-SHARING 
AUTOMATIC MIC MIXER  
page 132

8.3  ADJUSTING 
THE MIXER’S SETUP           
page 134

8.4  BUILD A GATING 
MIC MIXER SETUP  page 
136

8.5  THE GATING 
AUTOMATIC MIC MIXER    
page 137

TRAINING
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EXERCISE 8.1: BUILD A GAIN-SHARING SYSTEM

1. Open the Schematic Library in the 

Right-Side Pane.

2. Select Audio Components.

3. Select Mixers.

4. Drag a Gain-Sharing Automatic 

Mic Mixer into your Schematic. ❶ 

❶

5. In the Schematic Library, under Audio Components, select Test and 

Measurement.

6. Drag a Pink Noise generator into your Schematic. ❷

7. Make three additional copies of this Pink Noise Generator by either dragging 

multiple instances into the Schematic, or using the Copy and Paste tools.

❷

 

For the purpose of this exercise, 

you’re going to use some pink noise 

to represent different microphone 

inputs.

KEYBOARD 

SHORTCUTS

The Designer software 

supports all the standard 

desktop keyboard shortcuts 

such as:

•  Copy (Ctrl+C)

•  Paste (Ctrl+V)

•  Cut (Ctrl+X)

•  Undo (Ctrl+Z)

•  Redo (Ctrl+Y)

•  Select All (Ctrl+A)

•  Save (Ctrl+S)

•  Find (Ctrl+F)

    and many others.

8.1

A TOOL FOR 
EVERY TASK

How do you choose which 

Mixer is right for you?

The Gain-Sharing Automatic  

Mic Mixer’s primary purpose 

is to balance the mixed output 

signal from all of the inputs, 

which may be constantly 

changing as people start and 

stop talking (or yelling!). 

This mixer will allow these 

microphones to be gated open 

whenever someone speaks 

into them.

The Gating Automatic Mic 

Mixer, on the other hand, 

focuses on delegating which 

inputs are gated open and 

which are denied based on 

the priority you give them 

compared to each other.

Both can be useful, so consider 

them carefully!
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8. Select each Pink Noise Generator and rename it by pressing the Space Bar. 

9. Give each one its own color by changing its Fill field in the Properties pane.

10. Select the Gain-Sharing 

Automatic Mic Mixer. In 

its Properties Panel in the 

Right-Side Pane, change 

the Channels field to 4.

11. Wire the outputs of your four Pink Generators to the four inputs of the Mixer.

These are just four random 

names we picked out of a hat.

12. One by one, double-click on one of your Pink Noise Generators and pull its 

controls into the Schematic just underneath its parent component.

13. Now you have an operable system to learn how the mixer works. You’ll be able 

to select a different volume level for each “person” by adjusting their RMS Level 

knob, and choose to have them start and stop “talking” by toggling their Mute 

button. This could represent four different presenters at a press conference or 

debate. Next you’ll look at how the mixer balances these multiple signals.

Don’t forget that you can 

press F1 to get Help if you 

need someone. Help, not just 

anyone. Help: you know you 

need F1. Help.

8.1



132Q-SYS TRAININGCHAPTER EIGHT: AUTOMATIC MIXERS

EXERCISE 8.2: THE GAIN-SHARING AUTOMATIC 
MIC MIXER

There are a lot of functions and properties to an automatic mixer, but don’t be 

overwhelmed! Simply go through each individually to understand its purpose.

1. Select the Gain-Sharing Automatic Mic Mixer in the Schematic and look at its 

Properties Panel in the Right-Side Pane. You already used this to change its 

channel count, but there are a few other options.

1. The Channels field, as you’ve already discovered, changes the number of inputs 
and outputs in the mixer. The default is set to 8.

2. You may notice that there are currently five outputs on your Mixer. In addition to 
the four channel-level outputs, there is one Mix-level output that combines all the 
channels together. You can change which of these Outputs are available: either 
Channel Only, Mix Only, or  Mix and Channel. 

3. Enabling the Side-Chain Filter will activate a section in the mixer’s control panel 
that lets you specify what type of bandwidth and frequency will be used to measure 
the signal for consideration of being gated open. The signal is not affected, only the 
gate control. 

4. Detector Time helps you avoid momentary non-vocal spikes in a signal that may 
cause a channel to open. When the RMS Detector Level scans the incoming audio, it 
is searching for a certain threshold to gate the channel open. However, if the spike is 
less than the length of your Detector Time, it will not open the channel. There are a 
few options for your Detector Time, and if you select Use Control then it will add a 
knob in your control panel that lets you adjust it manually. 

5. The Graphic Properties (Position, Size, and Fill color) let you adjust the location 
and appearance of the component. 

QUESTION: What’s all this 

talk about gates being opened 

or closed?

 

ANSWER: A gate does exactly 

what it sounds like - it opens 

or closes a path. An audio gate 

in a mixer decides whether  

a particular audio channel 

passes through the mixer or 

not. You probably only want 

a given channel to be gated 

open if someone is speaking 

into the microphone, so you 

can set thresholds and filters 

that help you determine if 

the audio coming through 

the microphone signal is loud 

enough and the right type of 

noise (in this case, a human 

voice), to trigger that channel’s 

gate to open. You’ll learn how 

to adjust this threshold on the 

next page.

8.2
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2. Change the Side-Chain Filter to Yes and the Detector Time to Use Control.

3. Run your design by pressing F5 or selecting File > Save to Core & Run.

4. Adjust the RMS Level of each of your four Pink Noise Generators to varying 

levels to represent people speaking at different volumes. A range between 

-25.0dB and 5.0dB should suffice.

5. Double-click the Gain-Sharing Automatic Mic Mixer component and look at what 

is happening in the Input section of its control panel.

There are four columns which 
represent each input channel. At 
the top is the Open LED which will 
illuminate when the channel is being 
gated open. In this example, Channel 
1 is closed and the others are open.

The Applied Gain meter shows how 
much attenuation is being applied 
to each input. This will vary as the 
mixer compensates for the number 
and volumes of different inputs. 

Priority Gain allows you to increase the gain of each input before it is used for analysis 
by the mixer. This is an easy way to compensate for soft-spoken or loud speakers.

6. Spend some time adjusting the levels of your four channels, as well as toggling 

their mutes, and notice what the mixer does to compensate. Adjust the Priority 

Gain for each channel and notice the difference there as well. You will note that 

when more channels are open, each one is attenuated more than it would be if 

it were the only channel open. This is because the mixer is sharing the total gain 

of all opened channels to keep its output level consistent.

QUESTION: Why isn’t 

Channel 1 gated open?

ANSWER: In this example, the 

mixer has an Open Threshold 

of -20 dB, which means that a 

channel must be louder than 

-20 dB for its gate to open. 

Channel 1 is just beneath this 

threshold. You’ll learn how to 

adjust this threshold on the 

next page.

QUESTION: Didn’t you say 

that last page?

ANSWER: Yup. I lied.
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EXERCISE 8.3: ADJUSTING THE MIXER’S SETUP

Now that you have a grasp on what the mixer does to each of the input levels, 

it’s time to learn about how to adjust the calculations that it performs. The mixer’s 

control panel has a few more sections to it.

The Mix section is pretty simple – this lets you mute 
the Mix output channel, or adjust the total gain applied 
to the output. This is only applied to the Mix output, so 
if you have the Mix and Channel outputs active in the 
component’s properties pane, this will not affect the 
Channel outputs.

The Setup section lets 
you change how much 
attenuation the mixer 
applies, how quickly it 
applies it, and when a 
channel should be opened. 

The Open Threshold determines the Applied Gain Level at which a channel will open. 
If the Applied Gain for any channel is above this Threshold, it will be open. Adjust the 
Open Threshold knob to note how it affects the inputs.

• The Depth determines the maximum attenuation applied to a closed channel. 
Adjust the Depth knob to note how it affects the inputs.

• Rest Gain sets the level of Applied Gain for all input channels when none are 
open. This keeps some amount of input active even when nobody is speaking so 
the audio doesn’t suddenly sound dead.

• The Threshold Level sets the RMS level of the input signal at which the 
Applied Gain begins to move to or from rest. This should be set just above your 
background noise level. 

• 
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• The Attack Time affects the time it takes for a 
channel to reach its Applied Gain once it is open. 
You can see this effect by muting a channel and 
seeing how long it takes to return when you 
unmute it. It only varies from 5-100 ms, but the 
difference may be important. It may be easier to 
think of this as a “Fade-In” time.

• The Hold Time is the amount of time that the 
signal will wait after the RMS level drops below 
the Threshold Level before it closes the channel. 
This helps prevent a momentary pause in speaking from closing the channel. It 
can be set all the way up to ten seconds if you have a particularly contemplative 
speaker who is known for long pauses mid-sentence.

• The Release Time is the opposite of the Attack Time, and could be considered 
a “Fade-Out” time. It determines the amount of time, after the Hold Time has 
been reached, that it takes for the channel to return to the Depth level once the 
presenter has stopped talking.

• If you have the Detector Time option selected in the Properties Panel, you can 
manually adjust the Detector Time here as well. The Detector Time smoothes 
out the analysis of the input audio to compensate for any random peaks that 
may accidentally open the channel.

If you applied the Side-Chain Filter section in your Properties panel, then you can 

adjust the Side-Chain options here as well. These let you select what types of input 

will be used to determine if a channel reaches the Open Threshold. Remember, this 

does not affect the audio at all, simply the way it is analyzed to see if the channel 

should be opened.

If you want to bypass the use of the side-chain, 
simply select the Bypass button.

You have seven different Types of filters you 
can select from, such as Band-Pass (shown), 
and each of them may allow you to manually 
adjust the Bandwidth, Frequency and Gain 
control to customize the filter you would like to 
use.

“An Attack Time of ten 

milliseconds? Must have been 

one of my slow days.”
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EXERCISE 8.4: BUILD A GATING MIC MIXER SYSTEM

The other automatic mixer, the Gating Automatic Mic Mixer, provides you with 

more specific ways of deciding when an input should be gated open. To set up a 

Gating Automatic Mic Mixer in your Schematic, you can simply replace the Gain-

Sharing Automatic Mic Mixer that is already in the design. The following steps should 

be very familiar from the first exercise.

You don’t have to delete the 

wires that connect the Pink 

Noise Generators from the 

Gain-Sharing Mixer if you don’t 

want to. An output pin can 

always be split into multiple 

wires to send that channel to 

more than one destination. An 

input pin, however, can only 

accept one wire.
6. Note the options in the Properties Panel are the same as those for the Gain-

Sharing Mixer.

7. Double-click the Mixer to open its control panel.

8. Run your design by pressing F5 or selecting File > Save to Core & Run.

Don’t let the names of these 

components trick you! Both 

mixers will gate channels open 

or closed, even though the 

word “gate” is only in one of 

their names. The Gain-Sharing 

mixer shares the gain amongst 

all the open channels, while 

the Gating mixer has much 

more specific rules about 

which channels it gates open. 

Be sure to use the one that 

best represents your needs!

ANOTHER 
GATED MIXER?

❸

1. Open the Schematic Library.

2. Select Mixers.

3. Drag a Gating Automatic Mic Mixer into the 

Schematic. ❸

4. In its Properties panel in the Right-Side Pane, 

change the Channels field to 4.

5. Wire your four Pink Noise Generator outputs to the 

four inputs of the Gating Automatic Mic Mixer. SPLITTING YOUR 
OUTPUT PINS
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EXERCISE 8.5: THE GATING AUTOMATIC MIC MIXER

The Gating Automatic Mic Mixer offers more options for the methods in which a 

channel is gated open, although it does not share the gain amongst these channels 

as actively as the previous Mixer. If a Channel reaches its Threshold, then the Mixer 

will consider gating it open, depending on which Mode it is set to.

1. Double-click the Gating Automatic Mic Mixer component to open its control 

panel. 

The first panel on the left is the Input panel. This gives you individual control over 

each input and the Mode to which it is set to be gated open.

The Open LED, much like the previous mixer, indicates whether or not a channel is 
open.

The Manual button will override any other logic and force open a channel’s gate. This 
button only opens a closed channel, it does not manually close an opened channel.

The Mode of a channel determines the rules by which it is opened. There are three 
modes: Automatic, Priority, and Filibuster. The differences between these three 
modes will be detailed on the next page. 

The Priority field is used when a channel is in Priority Mode. A low number has a 
low priority, and a high number has a high priority. See the next section for details.

The Threshold determines the level that a channel must reach in order for it to 
be gated open, regardless of what Mode it is in. If the channel drops beneath its 
Threshold, it will be gated closed until it reaches its Threshold level again (unless it is 
being opened manually).

Here’s an important difference 

between the two mixers: The 

Gain-Sharing mixer has one 

global Open Threshold that 

all channels must reach to 

open, while the Gating mixer 

allows each channel to have a 

personalized Threshold. 

THRESHOLD 
OPTIONS
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Automatic Mode:
This is the simplest mode, in which a channel will be gated open dependent solely on 
whether or not it reaches its Threshold level. Basically, as long as it is loud enough, it 
will automatically gate open when the channel is carrying a signal.

Priority Mode:
In this mode, when a channel reaches its Threshold it will only be opened if it has the 
highest Priority number amongst Priority channels. You can assign each channel an 
arbitrary Priority number between 1 and 10,000 (1 being lowest, 10,000 being highest) 
in its Priority field. If Channel 1 is in Priority and is open, and another channel with a 
higher priority reaches its Threshold, then Channel 1 will close until once again there 
are no higher Priority channels open.

Filibuster Mode:
Filibuster mode only allows one channel to be open at a time, and that channel will not 
close again until it drops beneath its Threshold. As long as the channel remains active 
(such as someone speaking for a long period of time) then it cannot be gated closed.

It is important to remember 

that channels only interact 

with other channels of the 

same mode. While only one 

Filibuster channel can be open 

at a time, channels that are in 

Automatic or Priority Mode 

may also be open according 

to their own rules. Similarly, a 

high Priority channel will not 

gate closed an Automatic or 

Filibuster channel since they 

are operating in a different 

mode. Consider your options 

carefully when constructing the 

proper design for your Gating 

mixer.

The Mix section is the same as the Gain-Sharing Mixer – it lets you mute the output 

Mix channel or adjust its gain. Don’t forget that it only affects the Mix level, not the 

Channel outputs. The next few sections are unique to this mixer:

The Gate section provides additional options:

If you keep Last Mic On highlighted, then the last mic that 
was active will not turn off until another channel is ready to 
open. This will keep the audio from going suddenly silent 
between presenters.

If your microphones are near each other, it’s possible for a 
talker to be loud enough to open multiple channels at once. 
If ID Gating is active, the mixer will identify which channel 
is that talker’s primary source, and only open that channel. 
If you are using the Pink Noise Generators with this exercise, 
ID Gating will make things very difficult for you because the 
Mixer is hearing the same audio on every channel!

The Background Percentage level provides adaptive threshold functionality, as it uses 
the sum of all microphone input signals to determine the percentage of background 
signal used to raise the Threshold levels. 

The Depth controls the amount of attenuation applied to a closed channel.

Hold Time adjusts the length of time after a channel is no longer exceeding its 
Threshold Level before the gate is closed.

Detector Time determines how long a noise must be to qualify as a potential signal.

You can give multiple channels 

the same Priority number. This 

way you can have multiple 

Priority channels able to be 

open simultaneously, and 

all of them would be closed 

if another channel of higher 

priority were to reach its 

Threshold.

MODE 
INDEPENDENCE

WHO IS 
NUMBER ONE?
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The final section, NOM, stands for Number of Open Mics.

The Max NOM number you 
provide will limit the number of 
channels able to be open at once. 
If more channels wish to be open 
than the Max NOM will allow, 
then the channels farthest to the 
left will be opened first. The limit 
of the Max NOM trumps all other 
attempts to open a channel - even 
manually opening a channel will 
not work if there are already the 
maximum number of mics open.

When multiple channels are open, the mixer will attenuate each channel to help keep 
the output level in check. By default, every time a new channel opens after the first, 
one Attenuation Step will be applied to all channels. You can adjust the amount of 
the Attenuation Step, as well as specify a Maximum Attenuation. If you deselect 
the Linear Attenuation button, then an Attenuation Step will be applied every time 
that the number of open mics doubles, rather than every time one is added. The 
Response Time knob adjusts how long it takes for this attenuation to be applied. 
 
On the right side of the NOM panel you can see a display of the current number of 
open mics as well as a Gain Meter showing the current applied attenuation. Feel free 
to open and close some of your channels and adjust the attenuation steps to see this 
attenuation applied in an active system.

Outside of the Designer 

software, NOM is the noise you 

make when you eat. This Max 

NOM is very different than the 

Max NOM in the software. You 

should consult your doctor as 

to what your Max NOM should 

be in real life.

2. As noted in the previous page, deactivate the ID Gating button so that your Mixer 

will not be confused by the Noise Generators you are using in this exercise.

3. Spend some time changing the Modes of your channels and witness the way 

they interact with each other, as well as the way the Max NOM will limit your 

number of channels even when they would otherwise be open. Be sure to 

experiment with using the Manual button to open channels, and to simulate 

people’s conversations by muting or unmuting your Pink Noise Generators. 

Now you should have a solid understanding of the way these two mixers work, and 

why each has its own specific use. 

Your new knowledge is 

power. You can use your 

power for good to greatly 

enhance the audio quality of 

your company’s meetings, 

or you can use it for evil by 

giving your boss the lowest 

Priority channel and not telling 

anyone. The choice is yours.
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There are two components in the Q-Sys Designer software which help 

you automatically adjust your audio level to compensate for varying 

levels of ambient noise: the Gated Ambient Compensator and the 

Continuous Ambient Compensator. Both components detect the 

level of ambient noise using a microphone positioned in the room, 

and use that level to automatically adjust the gain applied to your 

program material. This is a useful application for any public area where 

announcements or music need to be heard above busy background 

noise, without being too loud when the area is quieter. 

Ambient Noise
Compensators

• Distinguish between the Gated Ambient Compensator and the 
Continuous Ambient Compensator.

• Create a design for each component that will let you test its unique 
features and explore its properties.

In This Chapter:

Both of these Ambient Compensators have many of the same functions, 

with one important difference: the Continuous Ambient Compensator 

detects changes in the ambient noise constantly, while the Gated 

Ambient Compensator only detects changes when the Program material 

is not playing. However, the Continuous Ambient Compensator is more 

complicated to setup and fine-tune, and uses more processing power.

• NOTE: You will need to be linked to an active Q-Sys Core to complete this tutorial.

CHAPTER MAP

9.1  BUILD A GATED 
AMBIENT COMPENSATOR 
DESIGN  page 141

9.2  UNDERSTANDING 
THE GATED AMBIENT 
COMPENSATOR          
page 143

9.3  UNDERSTANDING 
THE CONTINUOUS 
AMBIENT COMPENSATOR  
page 147

CHAPTER NINE
TRAINING
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1. Go to the Schematic Library and select Dynamics.

2. Drag a Gated Ambient Compensator into your Schematic. 

EXERCISE 9.1: BUILD A GATED AMBIENT 
COMPENSATOR DESIGN

 

This component has two different input pins, which can be identified by hovering 

the mouse over the pin. The first is labeled Program, which is the desired audio 

to be broadcast over the system. The second is labeled Microphone, which is 

the microphone input being used to monitor the ambient noise of your room.

3. In the Schematic Library, select Test and 

Measurement.

4. Drag two Pink Noise Generators into your 

Schematic.

Next you’re going to drag some Pink Noise Generators into your 

Schematic, which you can use to simulate varying levels of random noise, 

since it would be very difficult to set up a real-life example of a microphoned 

room with fluctuating crowd noise. ...unless you have hundreds 

of friends who are very 

generous with their free time! 

If so, congratulations on your 

popularity!

Question: Train A leaves 
Chicago at 4:00 PM heading 75 
mph. A station engineer sets a 
level for announcements at the 
Chicago train station without 
using an ambient compensator 
while there are no trains near 
the station. When Train B 
arrives from Santa Fe at 5:00 
PM, how many people in the 
station will be able to hear the 
announcements over the noise 
of the train’s engine?

Answer: Zero. 

WORD
PROBLEM:
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It’s important to note that you 
cannot change the number 
of inputs in this component. 
If you have multiple sources 
that you would like to input 
as Program material, you 
will need to put them all 
through a Mixer component 
first and then wire one line 
to the Program input pin. 
Similarly if you have multiple 
microphones recording 
ambient noise in the room, 
they will need to be combined 
before being wired into the 
Microphone input pin.

THINKING
AHEAD

5. Select one Generator and press the Space Bar. Rename it “Program 

Material.”

6. Select the other Generator and press the Space Bar. Rename it “Background 

Noise.”

7. Wire the output pin of your Program Material to the top input pin (Program) of 

the Gated Ambient Compensator, and wire the output pin of your Background 

Noise to the bottom input pin (Microphone).

8. Double-click your two Generators to gain access to their Control Panels. 

 

If you’d like, feel free 

to drag the RMS meter 

and/or Mute button 

from each generator’s 

control panel into the 

Schematic near its 

component to save on 

space. 

 

You can raise or lower 

the Background Noise 

RMS Level to simulate a 

change in the ambient 

noise of the room. Now 

that you have a simple 

design, it’s time to learn 

about the Compensator.

9.1
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1. Click on the Gated Ambient Compensator and look at its Properties in the Right 

Side Pane. 

In-Gain Fader adjusts the gain of the microphone input level.

Mic Filter adjusts the type of filter used to detect ambient noise. 
Depending on which type you select, you can also adjust the Bandwidth, 
Frequency, and Gain. This column of controls is only available when the 
Microphone Filter field is switched to Yes in the Properties panel.

Besides its basic component color and position functionality, you can also toggle 

Microphone Filter on and off. Select Yes to gain access to a filter you can use 

in the Control Panel later to choose what type of ambient noise you would like 

to monitor.

2. Double-click the Gated Ambient Compensator component to open its Control 

Panel. There are many fields here and a large degree of customization, but the 

end result is quite simple.
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Response graph represents the gain added to 
your Program level, based on the ambient level. 
The X-axis of the graph represents the ambient 
level, and the Y-axis represents the amount of 
gain to be applied to the Program. By default 
you can see that as the ambient level rises, the 
gain rises, but it plateaus at a predetermined 
Maximum and Minimum Gain.

The Detector Panel gives more options for 
how the component detects changes in the 
ambient noise.

• Program Threshold is the level at which 
the Ambient Detector is no longer active. 
Basically, once your Program material is 
audible, you want the Ambient Detector to 
turn off since your program material will 
be mixed with the ambient noise by the 

Detector Meter displays the 
ambient level, including any 
program material present. 

microphone.

• Sense Delay is the length of time after the 
program level drops beneath its threshold that the Detector waits before detecting 
again. This is to prevent momentary pauses in your Program from triggering the 
Detector.

• Sensing LED indicates whether or not the Detector is active.
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• Gain Calculation lets you adjust the amount of 
gain or attenuation applied to the program level. 

• Ambient Threshold is the point at which the 
ambient level is loud enough to require gain added 
to the program level.

• Ratio controls the slope of the graph. A higher 
number will apply more gain relative to an increase 
in the ambient noise, and a lower number will apply 

Time Constants let you fine-tune the fade-in and fade-out 
time.

• Attack Time adjusts how quickly gain is applied 
due to an increase in ambient level.
• Release Time adjusts how quickly gain is removed 
due to a decrease in ambient level.

Gain Meter displays 
the total gain applied to 
the program level.

Out Gain Fader lets you 
manually adjust the gain 
of your audio output.

“My brain hurts! That was 

boring!” Sorry! There are 

a lot of knobs to adjust on 

these Compensators, and it’s 

important to know what they 

do. But what does this all 

mean? It means that when the 

room gets louder, your audio 

gets louder. If there are big 

noisy crowds in your venue, 

then your announcements 

will automatically adjust to 

be heard. If there’s only one 

person in your venue, he/she 

won’t be blown away by an 

announcement level that was 

set for a packed room.

less gain relative to an increase in the ambient noise.

• Minimum Gain knob adjusts the minimum gain (probably a negative number, or 
attenuation) applied when the ambient level is beneath the Ambient Threshold.

• Maximum Gain knob adjusts the maximum gain to be applied.
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QUESTION: “That’s great for 

occasional announcements, 

but I want to play background 

music as well. I have to wait 

for the background music 

to be over in order for the 

Compensator to listen to the 

ambient noise in the room?”

ANSWER: What you need 

is the Continuous Ambient 

Compensator. You’re ready 

for the next Exercise.

3. Run your Design by pressing F5 or selecting File>Save to Core & Run. 

4. Mute your Program Material, and raise its 

level to around 3 dB. 

 

 

5. Unmute your Program Material, and 

note how the Ambient Detector has 

turned off. 

6. Raise the level of your Background Noise to 

-20 dB. 

 

 

7. Mute your Program Material, and note that the Detector detects the new 

background noise of the room.

8. If you unmute the Program Material, you can see how much more gain would 

be applied to it than the last time it was active.

9. Experiment with adjusting the Gain Calculation, Time Constants, and Detector 

Controls to see how they change the way that Gain is applied when you adjust 

the ambient noise.
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1. Delete the Gated Ambient Compensator from your Schematic.

2. Drag a Continuous Ambient Compensator into your Schematic.

3. Wire the output pin of your Program Material (Pink Noise Generator) into the 

top input pin (Program) of the new Compensator, and wire the output pin 

of your Background Noise (Pink Noise Generator) into the middle input pin 

(Microphone) of the new Compensator. 

EXERCISE 9.3: UNDERSTANDING THE CONTINUOUS 
AMBIENT COMPENSATOR

“Hey! What’s that third input pin?”
This Compensator has an additional input pin – the Reference pin. This pin is a reference of 
the audio that is being played by your loudspeakers in the venue.

“Why is that important?”
The microphone in the room hears everything - both the ambient crowd noise as well as 
the program material you are playing. The Compensator needs to digitally “subtract” the 
program material from what the microphone receives in order to listen to the changes in the 
crowd noise rather than the swells of a music track.

“What do I put into the Reference pin?”
Since this signal needs to represent the audio that is being played by your loudspeakers, 
you should take your signal from as late in your audio path as possible, after any signal 
processing. If you can take it from the exact same line that feeds the amplifiers, all the better.
A real example might look something like this: 

Notice that the Reference signal is taken from the same audio that feeds the Line Out.

4. Since there is no other signal 

processing in this example, you 

would simply wire your Program 

Output pin around to the 

Reference pin. However, this is a 

rare case, so don’t get used to wiring the program pin back upon itself like this!

IMPORTANT!

The Compensator can only 

model a linear signal, so 

you’ll need to take your 

reference signal after any 

non-linear components such as 

compressors and/or limiters.
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5. Click on the Continuous Ambient Compensator and look at its Properties in the 

Right Side Pane. This Compensator has a few more options here.

6. Double-click the Continuous Ambient Compensator to open its Control Panel. 

This Control Panel is mostly the same as the Gated Compensator, except for 

differences in the Detector Panel :

•  Audio Bandwidth lets you adjust the upper limit of the audio bandwidth used to 
measure for compensation. Most ambient noise is dominantly low frequency, so it may be 
wise to tell your Compensator to ignore higher-frequency material. This will cause your 
Compensator to use less processing power.
 

  •  Relative Venue Size determines the 
size of the system response modeler that the 
Compensator uses. A smaller model uses less 
processing power. You’ll want to choose a 
relative size of your venue based on a scale 
of 1-10, 1 being smallest. If the Compensator 
does not sufficiently remove the program 
material from the microphone signal, you may 
want to increase your Relative Venue Size.

BE REALISTIC!

“Well, relative to the planet 

Earth, my football stadium 

is probably only a 1 or a 2, 

right?”

• Mic/Spkr Distance knob asks you to input the 
distance in meters from the microphone used to detect 
the ambient noise to the nearest loudspeaker. This is 
very important for those complicated calculations the 
Compensator conducts, so be accurate! 

• Program Cancellation meter shows the amount of 
Program Material that has been successfully removed 
from the microphone line.

7. Feel free to adjust the Background Noise and watch the Compensator react in 

real-time, but without a real-world installation you can’t really witness the power 

of this compensator. 

There is one additional feature of the Continuous Ambient Compensator that you 
may have noticed earlier. In addition to an extra input pin, there’s an additional 
output pin as well. This output pin is labeled Ambient, and represents the 
recovered ambient signal. This is the end product of removing the Reference feed 
from the Microphone feed. The Compensator uses this recovered ambient signal to 
raise or lower the gain of your Program feed. If you have any need of monitoring 
the room noise without hearing the background music, you could use the audio 
from this Ambient pin.
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Audio engineers have a task called “ringing out the room” that eliminates 

feedback in the environment. The process involves finding the frequencies 

that naturally create feedback in a room and applying very narrow filters to 

attenuate the sound signal at those frequencies, to prevent the feedback 

from occurring. A Q-Sys system can “ring out the room” automatically using 

the Notch Feedback Controller, or NFC component.

• Understand the control panel of the Notch Feedback Controller

• Eliminate feedback in your room using the NFC component

Notch Feedback Controller

In This Chapter:

CHAPTER TEN

CHAPTER MAP

10.1  THE NFC 
COMPONENT  page 150

10.2  RINGING OUT THE 
ROOM page 151

TRAINING

• NOTE: This tutorial can only be demonstrated with an active Q-Sys Core in a room 
with loudspeakers and at least one microphone input
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EXERCISE 19.1: THE NFC COMPONENT

You can find the Notch Feedback Controller in 

the Schematic Library, under Equalizers and 

Filters. The component itself only has one input 

and one output, as it is intended to be placed in 

your signal path just before an amplifier channel. 

The NFC control panel is composed mostly of a frequency graph❶, as well as a 

few adjustable parameters. To the left of the graph, the incoming signal’s gain can be 

adjusted or muted❷, and the NFC can by disabled entirely by selecting the Bypass 

button❸. You can adjust the maximum desired number for each type of filter❹, as 

well as clear any active filters when the component is in use❺. 

The bandwidth of your notches can be selected from 1/5th octave, 1/10th, 1/20th, 

or 1/80th❻, and you can adjust the Threshold at which feedback is registered❼. 

Finally, you can adjust the minimum and maximum frequency ranges for your 

Dynamic Filters❽, and set the Reclaim Time❾. The Reclaim Time is how long 

a Dynamic Filter waits after not being used before it leaves standby mode and is 

returned to the available filter count.

There are two types of filters: Fixed Filters and Dynamic Filters. A Fixed Filter is one 
based on the acoustics of the room, which will be created when the room is quiet and will 
then remain in place. A Dynamic Filter is one that is needed as a result of the acoustics 
during the live event, which are created and removed as necessary. A Fixed Filter will be 
indicated by an orange triangle on the graph, and a Dynamic Filter will be indicated by a 
blue triangle.

To properly eliminate all 
feedback, each amplifier 
channel in a room should have 
its own NFC component. If a 
mono signal is being converted 
to stereo, the NFC should be 
placed on the mono signal 
before the split.

❶
❷

❸

❹❺ ❻
❼

❽

❾

ALTERNATIVE:
You can also adjust the 
maximum and minimum 
frequency ranges by 
dragging the dotted lines 
with the blue handle. 
These lines are only     
    shown while running  
    on a Core.

WHERE DOES 
IT GO?

10.1
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EXERCISE 19.2: RINGING OUT THE ROOM

1. Set your microphones and loudspeakers in your venue the way they will be 

during your live event, including all gain structure and dynamics processing.

2. Move the Feedback Threshold down to around -46 dB.

3. Set the Fixed-Filter Count to 6.

4. If it is not already, set the Dynamic-Filter Count to 0.

5. Be sure that the room is as quiet as possible, and do not speak into any 

microphones.

6. Slowly raise the gain until the system begins to feedback and the Fixed Filters 

activate. This can be done with the Gain fader in the NFC control panel, or in 

conjunction with the gain of your microphone input signal.

7. Lower the gain back to where you would normally have it for your live event.

8. Raise the Threshold up to around -40 dB.

9. Count the number of Fixed Filters that were activated, and change the Fixed 

Filter Count to that number.

10. Raise the Dynamic Filter Count to around 6.

The NFC is now “tuned” to your room, but will still create Dynamic Filters if feedback 

occurs during your live event. If you notice that too many filters are being set, you 

may want to raise the Threshold level.

10.2

NO MORE 
EXCUSES!

Now that your equipment 
sounds great, the only thing 
keeping you from becoming a 
rock star is talent. This study 
guide cannot help you there.
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Education
TRAINING &

QUICKSTARTS

Q-Sys Quickstarts are modular courses that cover specific components or processes in the Q-Sys Designer software 

that are not required for Q-Sys Level One Certification. These courses are designed to address specific 

installation needs that are not covered in the basic Q-Sys Training. Several of these courses cover topics that are 

part of the in-class Level Two Training. If you are interested in attending a Level Two Training class, look for an event 

coming to your area soon in the Events section of qsctraining.com

SECTION TWO
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Your Q-Sys devices are more than just audio components, they’re part 

of a networked system known as Q-LAN. Instead of creating expensive 

and unique proprietary networking equipment that only works with a few 

products, QSC designed Q-LAN to use the global standard of network 

equipment and protocols. This means that many facilities are already 

equipped to run Q-Sys without upgrades, and new networks can take 

advantage of lower costs and broad equipment choices driven by the global 

IT industry.

In order to understand how Q-Sys operates in a network, this chapter will go 

through a brief overview of networking in general, following the many steps 

and different protocols that a single 

data packet navigates in order to travel 

from one device to another.

• Follow a basic overview of how standard devices communicate with 
each other using international networking protocols

• Understand how Q-Sys exists within a network

• Review the differences between Network Audio Channels, Network 
Audio Streams, and physical channels

• Learn some tips for maximizing your total channel output count

Networking Overview

In This Chapter:

CHAPTER ELEVEN

CHAPTER MAP
11.1  THE OSI 7-LAYER 
MODEL  page 154

11.2  NETWORK 
PROTOCOLS  page 157

11.3  AUDIO 
CHANNELS VS. AUDIO 
STREAMS   page 160

11.4  LOCAL AUDIO 
CHANNELS  page 162

11.5  BANDWIDTH      
page 163

QUICKSTARTS
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LESSON 11.1: THE OSI 7-LAYER MODEL

Whenever two devices (such as a Q-Sys Core and a desktop computer) need to 

communicate with each other, the data transmitted goes through several stages.

Layer 7: Application

Layer 6: Presentation

Layer 5: Session

Layer 4: Transport

Layer 3: Network

Layer 2: Data Link

Layer 1: Physical

EN
CA

PS
U

LA
TI

O
N

DE-EN
CAPSU

LATIO
N

This process is called the Open Systems Interconnection 7-Layer Model. Data is 

encapsulated by the sending device and de-encapsulated by the receiving device by 

processing the data through these seven layers:

SEAL OF
APPROVAL

This model was established 
as the global standard for 
network communication by the 
International Organization for 
Standardization in 1984.

Each layer only communicates with the layer directly above or below it, so that 

as new technologies are developed they can be implemented without having to 

overhaul the entire model.

The Application, Presentation, and Session layers are all software-based, and 

involve taking the data created by an application and preparing it for transport 

outside of the device. When you click “Send” on an e-mail, for instance, the e-mail 

goes through these three layers before it is ready to be sent out of your computer.

?

11.1
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Transport (Layer 4) adds a layer of transport information to your data which will 

identify what type of data it is. This is primarily done by assigning it a port. Different 

ports are reserved for different types of information.

Layer 4: Transport DataTransport

SOME COMMON 
PORTS

Web traffic uses Hypertext 
Transfer Protocol (HTTP) which 
uses Port 80.

Common e-mail servers 
use Post Office Protocol v3 
(POP3) which uses Port 110, 
while Simple Mail Transfer 
Protocol (SMTP) uses Port 25 
(or sometimes Port 587 as an 
alternate). 
 
Q-Sys uses Ports 6516 and 6517 
(Older versions of Designer 
may use Ports 6511-6766 as 
needed). 

Network (Layer 3), is where the majority of communication protocols do their work. 

Communication protocols identify the data’s source and destination by its Internet 

Protocol Address, or IP Address. An IP Address is a set of four numbers that looks 

something like this: 196.162.3.110. These four numbers represent your device’s 

virtual address in the world, the same way your mailing address tells a mail carrier 

how to find you. Instead of using a street address, street name, city, state, and zip 

code, the IP Address uses these four sets of numbers to narrow down your location 

in the virtual world.

Layer 3: Network DataTransportIP Header

Typically, the IP addresses for all devices on the 

same network will be the same except for the 

fourth number, like different apartment numbers 

that share the same building number. You can 

choose your address manually, or you could 

have any device automatically assigned an IP 

address, which is usually handled with a Router. 

Routers specifically deal with transporting data 

from network to network, which is why you need 

one for the devices on your network to access 

other networks, such as the Internet.

Q-Sys devices all have their own IP address (which you can modify with the 

Configurator tool) and stream using IP, meaning that they are Layer-3 and routable. 

Because of this, Q-LAN is considered to be a Layer 3 service.

An IP Address is like a street sign 
for network activity. It may look 

like just a bunch of numbers, but 
they represent increasingly specific 

information, similar to a mailing 
address.

WHAT IS 
THAT?

Unfamiliar with the Q-Sys 
Configurator? Don’t worry - 
it’s covered in “Lesson 3.1: 
The Q-Sys Configurator” 
(page 61).

11.1
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Layer 2: Data Link

DataTransportIP HeaderData Link FCS (Checksum)

Layer 2, Data Link, assigns additional data link tags to the data including a checksum 

which the receiving end will use to confirm that the entire data frame has been 

received. Simple switching and bridging occurs on this level, which is different than 

routing. 

Consider the difference between a Router and a Switch:

A network switch looks at everything that is connected to it and creates a table of 

that information, using the MAC addresses of the devices it finds. A MAC address 

(which stands for Media Access Control Address) is a permanent and unique name 

for a device – the computer equivalent of a social security number. While an IP 

address points to a network location, it doesn’t specify what device is going to be 

found there. A switch compiles a list of the actual devices it is connected to, and 

shares that list with other switches and routers on its network. In essence, the switch 

defines the network and the router shares the network to other networks. 

SWITCH ROUTER

Layer 1: Physical

1101010...

Finally, Layer 1 is the Physical layer – these are the actual wires and cabling that 

connect devices together – and this includes things you might not consider to 

be physical such as wireless signals. But if it carries a signal through the world, it 

operates on this Layer. This is the point 

where your data and all of the information 

that has been added to it along the way is 

broken down into ones and zeroes.

ONES AND ZEROES

From the simplest command to 
the most complicated program, 
the only language any 
computer actually understands 
is “on” or “off”, represented by 
a “one” or a “zero.”

WHEN OUR 
POWERS 
COMBINED ...

Are there devices that perform 
both routing and switching? 
Absolutely - particularly in 
smaller networks such as a 
home or small business.

DataTransportIP HeaderData Link FCS (Checksum)

11.1

MAC ADDRESS 
OVERVIEW

A MAC address is usually 
composed of three groups 
of four hexadecimal digits, 
such as 01AB.23CD.45EF. 
The first six digits (O1AB23) 
represent the ID of the device’s 
manufacturer, while the last six 
digits (CD45EF) represent the 
unique number for the device.
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LESSON 11.2: NETWORK PROTOCOLS

Within the OSI-7 Layer Model, there are several different protocols for sending 

information. Transmission Control Protocol, or TCP, adds acknowledgement and 

sequential delivery information to data that allows the receiving end to confirm 

delivery of each data frame and return that information to the sender before allowing 

the next sequence to be sent.

DataTransportIP HeaderData Link FCS (Checksum)Sequence Confirmation

The sequential information identifies which part of the data is being delivered, and 

the confirmation allows the receiving end to confirm that the data is complete. After 

confirming delivery, the receiving end requests the next section of data. While this 

ensures that there is no loss or degradation of data frames, it also slightly increases 

network bandwidth and delivery time.

TCP

I’m sending one football. 

I have two more footballs 

to send you after this.

TCP 

I have received your

football and will gladly take

another one now.

Because of the reliable delivery, Q-Sys sends most of its vital control information 

using TCP, but it handles its audio streaming using UDP.

User Datagram Protocol, or UDP, does not wait for the receiving end to confirm 

delivery – it simply continues to send all information as it comes in. This ensures that 

the audio is not slowed down by waiting for delivery confirmation. If UDP does end 

up dropping a data packet here or there, the software can correct and cover for that 

missing information and the listener will never know it happened.

TCPUDP

11.2
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In addition, Q-Sys also uses its own multicast protocol known as QDP, which allows 

its devices to identify each other on the network. This is used to discover your  

inventory in the Q-Sys Configurator, which will be the focus of the next lesson.

Why Gigabit?

The speed of the network is important in letting Q-Sys get its task done. In order to 
maintain a complete network latency of less than 250 microseconds, a Gigabit 
network is required. Consider that it takes 12 microseconds for data to travel along a 
cable on a Gigabit network, so it takes ten times that amount to go the same distance 
on a 100Mb network. Going through a switch takes 12 microseconds to enter and 
10 microseconds for the switch to decide where to send the data, for a total of 22 
microseconds. So if there is even one switch hop in a 100 MB network, the audio has 
already exceeded 250 microseconds of latency. Thus, a Gigabit network is required. 

100 MB Network

120 us
+ 22 us

+ 120 us
_______

262 us

Gigabit Network

   12 us
+ 22 us
+ 12 us
_______
   46 us

Network Type

Cable

Switch

Cable

Total Latency

When selecting a switch to use, check for the following requirements:

• Wire-speed non blocking delivery
• At least 40 kb of dedicated buffering per port
• Must support DiffServ, or 802.1p QOS (Quality of Service) - this categorizes and 

prioritizes network traffic, allowing Q-Sys to operate on a shared network without 
segregating audio traffic with tedious VLAN configuration.

All of this information should be readily listed on the spec sheet for your switches and 
routers – and a complete current list of compliancy approved switches are available at 
www.qscaudio.com.

Selecting a Switch

11.2
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Q-Sys also accommodates fully redundant networking configuration, including all 

standard Layer-3 fault-tolerance strategies as well as the Layer-2 protocol known 

as Spanning Tree. Spanning Tree Protocol, or STP, is a method of enabling and 

disabling redundant paths on a network to avoid data loops. A data loop can be 

disastrous to a network as it floods the bandwidth and can bring all traffic to a stop.

Spanning Tree establishes the quickest way to get data through each switch on a 

network and disables the alternate paths.

Then, if a connection fails, it dynamically changes which paths are open to create a 

new path, while still protecting from signal loops that could lead to infinite flooding or 

a broadcast storm.

ACTIVITY 
TIME!

Place your finger on the switch 
at the bottom of the network, 
and trace a path to the switch 
at the top of the network. How 
many different routes could 
you take without backtracking? 

In the first figure, there are 
an infinite number of ways 
to make this path, which is 
why an open network like this 
is prone to data loops and 
broadcast storms.

In the second figure, try the 
same task while only using 
green arrows. There is only 
one path to get from the 
bottom switch to any other 
switch. The grey paths still 
exist, but have been disabled.

In the third figure, there is a 
failure on the red path, so the 
configuration of the enabled 
and disabled connections 
has adapted to create a new 
efficient path to each of the 
switches.

11.2
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LESSON 11.3: AUDIO CHANNELS VS. AUDIO STREAMS

AUDIO SOURCES

Microphones, Video-Conferencing, Mixers, 

Laptops, DVD/CD Players, etc.

When discussing a Core’s capability of handling audio across the Gigabit network, 

there is some similar terminology that could be easily confused. The difference 

between Local Audio Channels and Network Audio Channels is as important as 

the difference between Network Audio Channels and Network Audio Streams.  

If you have an I/O Frame with four Line-In I/O Cards, each of those cards has four 

inputs. If you plug a physical device into each of these inputs, then you have sixteen 

channels feeding into your I/O Frame.

This information is all digitized and sent over the Gigabit network to the Core in one 

Network Audio Stream (NAS). This one singular NAC contains sixteen Network 

Audio Channels (NAC), which are the sixteen input channels of your I/O Frame.

16 Audio Input
Channels

I/O Frame

1 NAS
16 NACs

Core 500i

11.3
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You can check your design at any time 

in the Q-Sys Designer software to find 

out how many Network Audio Channels 

you are using. You can press Shift +F6, 

or go to the File Menu and select Check 

Design.

This menu will tell you the percentage of Signal Processing you are using, the 

number of Network Audio Channels that are being used, as well as how much 

Bandwidth is being used by Input and Output Streams.

MODEL   TOTAL NAC CAPACITY

Core 250i   64 Flex

Core 500i   128 Flex

Core 1100  256 inputs/256 outputs

Core 3100  512 inputs/512 outputs (when   

   sending 8 or more channels per NAS)

The model of your Core determines how many Network Audio Channels can be 

handled at a time.

The Core 250i and 500i have flex channels, which can be used as either input 

channels and output channels. 

While the Core 3100 can 
handle up to 1024 Network 
Audio Channels, it cannot 
handle 1024 Network Audio 
Streams. In order to use 1024 
channels, you would need to 
package at least 8 NACs into 
each Network Audio Stream.

WITH PROPER 
PLANNING ...

11.3
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LESSON 11.4: LOCAL AUDIO CHANNELS

The chart on the previous page isn’t the limit of how many audio channels a Core 

can handle - those are simply its Network Audio Channels. Every Core also has its 

own Local Audio Channels via the I/O Cards located on the Core. This audio 

enters or leaves the Core without traveling over the Gigabit network, and therefore 

does not count against the Core’s NAC capacity.

The Core 250i and 500i 

can each hold up to eight 

I/O Cards. If you packed 

a Core 250i with AES3 

Cards, which allow 4 

inputs and 4 outputs each, 

then you would have 32 

input channels and 32 

output channels in addition 

to its 64 network flex 

channels.

More importantly, keep in mind that you can have far more physical output channels 

than network output channels. Since output channels can often carry the same 

information when you send your audio to multiple amplifiers and loudspeakers, they 

can use the same audio source and share a network channel. This was covered at 

the end of the Software Overview course, “Lesson 2.16: Maximizing Audio Channels 

(Fan-Out Method)” (page 58).

11.4
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LESSON 11.5: BANDWIDTH

The Q-Sys system can use up to 900 Mbps of bandwidth, so most applications 

should never be in danger of running out of network bandwidth. However, if the 

Gigabit network is shared with other devices outside of Q-Sys, bandwidth efficiency 

may be important when building your system. 

Input Network Bandwidth: 26 Mbps

Output Network Bandwidth: 26 Mbps

Input Network Bandwidth: 28 Mbps

Output Network Bandwidth: 28 Mbps

EXAMPLE ONE

EXAMPLE TWO

Every Network Audio Stream 

to or from an I/O Frame 

takes up some of the network 

bandwidth. In both examples 

shown, there is one Core 

and two I/O Frames. In 

both examples, sixteen audio 

channels enter the Core 

and sixteen exit the Core. 

However, the first example 

has one Frame handling all of 

the inputs or outputs, while 

the second example has each 

Frame handling half of each.

The first example is only 

using two Network Audio 

Streams: one from I/O Frame 

1, and one to I/O Frame 2. 

The second example is using 

four Network Audio Streams, 

because each I/O Frame is 

both sending and receiving an 

NAS to the Core. Even though 

these two designs have the 

same inventory and audio 

channel count, the second 

example is using more 

bandwidth because it is 

using more audio streams.

11.5

Don’t forget! If you’re using 
a redundant Core, you’re 
also doubling the amount 
of bandwidth your design is 
using!
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The Q-Sys Designer allows you to create a 

robust Public Address System that integrates 

sophisticated paging and messaging services 

along with customizable Zones, Priorities, and 

Command features. The tools to set up a 

complete Paging system are easy to use, and 

offer almost limitless flexibility so your design 

will behave exactly how you want it to.

From a small restaurant to an international 

airport, public address systems are an 

integral tool for most businesses. Whether 

it’s broadcasting a person’s voice live over 

the loudspeakers or launching prerecorded 

messages, an efficient PA system is critical for 

announcing information throughout your venue. 

Controlling the manner in which different 

announcements are sent to different areas is 

the key to configuring the perfect system for 

your purposes.

• Build a comprehensive public address system in the Q-Sys Designer 
software.

• Configure your Public Address Commands, Zones, Priority, and Queuing.

Public Address

In This Chapter:

CHAPTER MAP
12.1  BUILDING A BASIC 
SYSTEM  page 166

12.2  ZONES  page 171

12.3  PUBLIC ADDRESS 
COMMANDS  page 172

12.4  PRIORITY  page 
174

12.5  QUEUING page 
178

12.6  PAGE STATIONS 
& COMMAND BUTTONS  
page 180

12.7  THE PA 
ROUTER COMPONENT             
page 182

7.8  THE VIRTUAL PAGE 
STATION  page 184

7.9  DUCKING  page 187

7.10  CORE-TO-CORE 
PAGING page 188

CHAPTER TWELVE
QUICKSTARTS

NOTE: Parts of this tutorial can not be completed in Emulation Mode and 
require connection to a Core.
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INTRODUCTION TO PAGING

The basic components of a Public Address system involve the following terms:

Page Station: This is the source of all announcements. At its 

simplest, a Page Station provides an audio input, such as a 

microphone, and a set of controls which determine where the 

announcement is sent. In Q-Sys, a Page Station may be either a 

physical device or a Virtual Page Station that is used through a 

User Control Interface (UCI). 

 

Page: A Page is a live broadcast created by a user speaking into 

a microphone at a Page Station. 

Message: A Message is a prerecorded announcement issued 

from a Page Station.

 

Zone: A Zone is an output destination for a Page or Message. 

Typically this would be one or more amplifiers and loudspeakers 

that are in a specific area of your venue.

Priority: Pages and Messages are assigned different levels 

of Priority, so that the more important announcement will be 

played if two or more are competing to be played in the same 

Zone simultaneously. Announcements that are blocked or 

interrupted by higher-Priority announcements are managed by 

the Queuing system.

Queuing: The Queue is a line of announcements that 

are waiting to be broadcast in a Zone. Once the current 

announcement is complete, the next announcement in the 

Queue will be played. Announcements’ behavior within the 

Queue can be specified by the User.
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EXERCISE 12.1: BUILDING A BASIC SYSTEM

THE PAGE STATION

QSC has a few different models of Page Stations. Shown below is the PS1600H. It 

features:

❶ 12-button keypad 

❷ Hand-held microphone

❸ 4 customizable Command Buttons 

❹ LED screen for basic information.

❶❷ ❸

❹

Different models may have 
different button layouts, or 
a Gooseneck microphone 
(shown above).

PageStations are connected to Q-Sys with a basic CAT5 cable, 

and require a POE connection (Power Over Ethernet). If 

the switch or router the Page Station is connected to is not 

POE enabled, a Gigabit POE injector could be used.

Once a Page Station is on the same 

network as the Core, it is discoverable by 

the Q-Sys Configurator. 

1. Open the Q-Sys Configurator by 

going to the File menu > Tools > 

Show Configurator.

Model PS-1600H

Model PS-1600G

12.1
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Here you can see the name of the Page Station and any vital information about it. 

Next you will need to add a software proxy of this Page Station to your design.

A

2. In the Inventory Panel of the Left-Side Pane, press the Plus icon.

3. Select Peripherals > PS-1600 (or, if you have a different model, select your 

model).

4. Select the new Page Station that 

has populated your Inventory and 

go to its Properties Panel in the 

Right-Side Pane.

5. Change the Name of your 

Page Station here to match the 

name of the device as shown in 

Configurator. 

Now that the Page Station in your Inventory is linked to your physical Page Station, 

you can integrate it into your design.

It has five different components, including 

a Status Component for monitoring 

the device and input/output components 

for other devices connected through the 

Page Station, but the primary functional 

component is labeled Mic/Control.

A

A

MY NAME IS

?

PS-1805, OR 
STEVE?

You can name your device 
anything you wish. Q-Sys 
Designer requires each device 
on the network to have a 
unique name, but the name 
you select is for you to be able 
to keep track of which is which. 
To change the Page Station’s 
name, simply enter a new 
name here in the Configurator 
and select Update Settings. 
The Page Station will 
reinitialize with any changes 
you’ve made.

WHY DO I 
HAVE TO DO 
THIS?

In an example such as this, 
it may seem odd that the 
software can’t “figure out” 
that your Page Station proxy 
should be linked to the Page 
Station on your network. To 
appreciate why you have to 
match their names, consider a 
more realistic example that has 
five Page Stations. You want 
to be in control of linking the 
software and hardware devices 
so you know which is which, 
without Designer deciding for 
you and renaming devices in 
your design.

12.1
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6. Drag the Mic/Control component from the Inventory into the Schematic.

This component has two output pins labeled Microphone and Station Control. 

These will be wired to the PA Router, which handles the logic for all Paging, 

Priorities, Zone routing, and Queuing. 

7. In the Schematic Library under Audio 

Components > Public Address, drag a 

PA Router into the Schematic.

8. Wire the Microphone pin and the Station 

Control pin of the Page Station Mic/

Control component to the first two input 

pins of the PA Router.

9. Click on the PA Router and go to its 

Properties panel in the Right-Side Pane.

Here you can adjust the number of Page 

Stations and Zones in your design. Each 

Zone is represented by an audio output pin 

on the right. You can also add extra input 

pins for Background Music (BGM).

10. If you are configuring your own system, 

input the fields that satisfy your system. 

Otherwise, follow along with this tutorial: 

Change the Station Count to 2, the 

Zone Count to 2, and the BGM Input 

Count to 2 as well.

The other properties, Remote Source and 

Remote Destination count, will be used 

in the final exercise in this course, which 

covers Core-to-Core Paging.

YOU’LL ONLY 
NEED ONE!

You can only have one PA 
Router component in your 
Schematic, but it can handle 
up to 256 Page Stations and 
512 Zones!

12.1
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OPTION:

You may wish to apply some signal processing to the microphone line. Feel free to 

apply any desired effects or dynamics to the signal before it reaches the PA Router. 

In this example, a simple 

compressor is applied 

between the Page Station 

and PA Router.

11. Wire your Zone outputs to their destinations. In this example, two Line Out cards 

that go to two different destinations.

12. Drag two Audio Players to the Schematic from the Schematic Library.

13. Change each Audio Player’s properties so it only has a single track, and wire their 

outputs to the two BGM inputs of the PA Router.

Since there is only one physical Page Station networked on this system, the second 

Page Station will be represented by a Virtual Page Station component.

14. In the Schematic Library under Audio 

Components > Public Address, drag a Virtual Page 

Station into the Schematic.

12.1
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15. Wire the Station Control pin of the Virtual Page Station to the Station 2 Control 

pin on the PA Router.

A Virtual Page Station provides most of the same functionality as a physical Page 

Station, but is designed to be operated on a UCI. For a full walkthrough of this 

component, go to Exercise 8 of this tutorial. For now, all you have to do is attach your 

own microphone input to the Router. In this example, a Microphone is plugged into 

the Line In I/O Card on the Core, and has been wired to the Microphone pin of the 

PA Router.

Your system is now operable and ready to be configured. Most of this configuration 

will take place through the Q-Sys Administrator, so first you’ll have to push your 

design to the Core.

16. Run your Design by pressing F5 or selecting 

File > Save to Core & Run.

17. Launch Administrator by pressing the 

Administrator icon in the top right corner or by 

going to Tools > Show Administrator.

IS THIS 
THING 
ON?

The microphone on a Page 
Station is always active, even 
when it is not broadcasting 
and the button isn’t being 
depressed! If you push your 
design to the Core now and 
double click the Mic/Control 
component, you’ll see that it is 
detecting noise. You may want 
to adjust the Analog Gain so 
that your voice gives a strong 
signal (without clipping!) so 
you know your pages will be 
audible.
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EXERCISE 12.2: ZONES

You’ve configured the sources for all your announcements, so now it’s time to 

configure their destinations. 

1. In the Administrator, go to the PA Zones tab.

Here you will see a list of all of the Zones that your Router is configured for. Since 

you set your Router’s properties to have a Zone Count of 2, there are only two Zones 

listed here. In a real situation these might represent the lobby and the bar, or inside 

seating and outside seating, etc. If you are able to, set up your system so that you 

can hear speakers from both Zones so that you’ll be able to hear your system in 

action during the rest of this tutorial. 

You should rename each Zone to represent its physical location. Simply click on the 

name of the Zone and type in a new name.

2. Rename your Zones. In the example below, they have been labeled as part of a 

theater lobby.

Much like Commands and Users, Zones can be given Tags to help filter them or 

group them together. 

3. Create a new Tag by clicking the Plus icon in the Tags window and giving it a 

label.

4. Apply your Tag to any appropriate Zones. In the example below, a Tag is created 

that will apply to all Zones.

12.2

ZONE FAN-OUT

Remember that a Zone could 
be any size! A single Zone 
pin could be fanned out to as 
many destinations as you like, 
or it could be as basic as a 
single loudspeaker. 
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EXERCISE 12.3: PUBLIC ADDRESS COMMANDS

When a PA Router is present in the design, you can create PA Commands in the 

Commands tab of Administrator. There are two types – PA Page Command, which 

initiates a Page, and PA Play Message Command, which launches a Message. 

1. Click the Plus icon 

in the Commands tab 

and select PA Play 

Message Command.

2. Configure the 

Command so that it 

will play a Message 

to one of your 

Zones. You can edit 

its Name, give it 

a numeric Code 

that will launch it, 

select the Message 

File that will be 

played, choose your 

Command’s Priority 

Level, and adjust 

the Gain for this 

message. Finally choose which Destination Zones it will play to by selecting 

either individual Zones or Tags.

In this example, a high-priority 5-minute warning message will be played to the Main 

Lobby of the theater when a User inputs the code 105 at a Page Station.

3. When you’re finished, click OK. 

4. Create a second Command that will play a different Message to your second 

Zone.

WHERE ARE MY 
MESSAGES?

The only files you can select 
here are those that you have 
uploaded to the Messages 
folder. To add more files, 
select the Audio Files tab of 
Administrator, double-click the 
Messages folder, and click the 
Plus icon to begin adding your 
prerecorded Messages. If you 
would like to create some new 
Messages using Q-Sys, you 
could use the Audio Recorder 
component to record them to 
the Core. Check out Exercise 
5.4: Audio Recorder (page 
109) for more information.

WHICH 
PRIORITY 
LEVEL 
SHOULD I 
USE?

QUESTION:
You didn’t teach us about 
Priority yet! I don’t know which 
Priority level I’m supposed to 
choose! What am I supposed 
to do!? Help me! Oh no!

ANSWER:
Settle down. You’ll learn about 
Priority in the next Exercise. 
And you can always make 
changes to your Commands 
by double-clicking them to 
reaccess this Settings window.

12.3
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Creating a Page Command is very similar to creating a Play Message Command, with 

a few different options.

5. Click the Plus icon 

and select PA Page 

Command.

6. Much like the Message 

Commands, here you 

can configure its Name, 

Code, and Destination 

Zones. 

ARE YOU 
MESSING 
WITH ME 
NOW?

I don’t know what any of 
that meant! What is Global 
Priority Mode?

It will all make sense once 
you learn more about Priority 
in the next Exercise. But you 
wouldn’t have been able to 
learn about Priority if you 
didn’t have some Commands 
to work with!

WHAT 
DOES THAT 
MEAN?!?!?

Relax, Queuing options will be 
covered in Exercise 5.

7. Select your Command’s Queuing Mode as Live, Delayed, or Automatic.

8. Select a Preamble. A Preamble is usually a short musical tone that announces 

the beginning of the page, or perhaps a prerecorded announcer’s voice (such 

as “Your Attention Please”) that is used to get the public’s attention and notify 

them that a page is beginning. Much like the Messages folder, you can only 

select from the Preambles that you have loaded to the Preambles folder 

in the Audio Files tab. If you would like to audition the Preamble you have 

selected, simply press the Play button next to its name and it will play over 

your computer’s loudspeakers. 

9. When you’re finished with your Command, press the OK button.

10. Like all changes in the Administrator, be sure to click the Update button at the 

top of the screen to apply your new settings to the design.

You should also see an option that says Override Source Priority Level, but leave 

it alone for now. In the next exercise you’ll see that this allows the Page Command 

to override the Priority of the Page Station it is sent from. However, if your Global 

Priority Mode is set to Command Priority Mode, then you will not see this option 

and instead you will simply be able to choose its Priority Level just as you did with the 

Play Message Command. 
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EXERCISE 12.4: PRIORITY

When multiple Messages or Pages are sent to a Zone simultaneously, the one that is 

played first is determined by its Priority Level. Priority Levels can be configured in 

the PA Global Settings tab of the Administrator.  

At the bottom of the page you will see the five default Priority Levels that come with 

some generic titles:

1. Rename a Priority Level to something appropriate for your venue.

2. Click the Plus icon to create a new Priority Level and name it appropriately.

3. If you wish, reorder the Priorities by either dragging them to a new position 

inside their panel, or by selecting one and nudging it using the up and down 

arrow.

4. Delete an unwanted Priority by selecting it and pressing the Delete key on your 

keyboard.

THE CHAIN OF 
COMMAND

CAN I ASSIGN 
A PAGE TO THE 
“TERMINAL 
MESSAGES” 
PRIORITY?

You can add as many Priority 
Levels as you wish, to make 
sure that every possible 
action in your system has a 
specific order in your Priority 
hierarchy. 

Absolutely. These five default 
names are examples only. Just 
because it says “messages” 
doesn’t mean that only 
messages can be assigned this 
Priority. Feel free to rename 
these priority levels.

WHO’S 
NUMBER 
ONE?

Remember that #1 is the first 
Priority, so higher numbers 
mean lower priorities. 

12.4



175Q-SYS QUICKSTARTSCHAPTER TWELVE: PUBLIC ADDRESS

It’s possible to assign a Priority Level to every Page Station, User, Page, and Message 

in your design, but you must also decide which Priority will be used in any given 

circumstance. For instance, if a Priority 1 User issues a Priority 3 Command from a 

Priority 5 Page Station, which Priority will be used?

The simplest way to decide this is to choose your design’s Global Priority Mode. 

You’ll find this option at the top of the PA Global Settings.

There are two options: Station/User Priority, and Command Priority.

In Station/User Priority Mode, it is the Priority of the Page Station that is used 

to determine the Priority of an action. However, if a Page Station requires a User 

logon, the User may be given the option to override that Page Station’s Priority.

In Command Priority Mode, it is the Priority of the Command that is used to 

determine the Priority of an action.

Since the design is currently on Station/User Priority, you can establish the 

Priorities for your Page Stations and Users:

5. Go to the Page Stations tab in the Administrator.

Here you’ll see a list of all the Page Stations in your design, sortable by their Name 

and Priority. 

6. Double-click a Page 

Station to edit its 

Settings.

7. Select a Priority Level 

for your Page Station.

12.4
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Your next step is to establish a Priority level for your Users:

1. Go to the Users tab of the 

Administrator and double-click a User to 

edit its settings (if you have not created 

a User yet, use the Plus icon and create 

a new one now).

Most of these settings will 

be familiar to you from 

the Administrator tutorial, 

except the section on 

Paging at the bottom. 

2. Change the Override 

Page Station settings 

to Yes. 

3. Select a Priority Level 

for your User. 

 

 

4. If you wish, you may also restrict which Commands the User can access 

by selecting Yes for Limit available commands and then check which 

Commands you would like the User to be authorized to issue.

The final piece of your Priority system is creating Overrides. No matter which Mode 

your Global Priority Mode is on, you could assign a User, Page Station, or Command 

to have Override authority which would negate the Global Priority Mode for that 

object. Since the design is still in Station/User Priority Mode, this means you could 

give a Command Override authority, and it would retain its own Priority regardless 

of which User or Page Station activates it.
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5. Return to the PA Page 

Command you created 

in the last exercise. You’ll 

remember there was an 

option here called Override 

Source Priority Level. If 

you change this to Yes now, 

the Command will always 

retain its own Priority, which 

you can now define.

THE OTHER SIDE OF THE COIN...

In Command Priority Mode, all of the areas you looked at would be reversed. 

Your Page Command would not have an option to Override Source Priority, because 

its Priority is already retained– instead you would simply select its Priority.

However, both Page Stations and Users would have a new option to authorize 

Override. Instead of having access to choose Priority, you will see a field to enable 

the Override Command Priority Level option:

For Users, you still need to Override Page Station settings before you have this 

option:

Remember – just because 
a Command is Overriding 
the source priority doesn’t 
mean it has High Priority. 
If the Command’s Priority 
Level is set low, then it will 
still Override the Page Station 
and potentially keep a lower 
Priority than the Page Station 
would have given it!
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EXERCISE 12.5: QUEUING

Pages that are sent to unavailable zones (or cut off by messages of higher Priority) 

are placed into the Queuing system, and will be played at the next opportunity. 

Queuing behavior can be fine-tuned in the Global Settings tab.

The Queue Timeout setting determines how long an action will live in the Queue, 

which by default is indefinitely, but could also be set between 1 minute and an hour.

The Cancel Delay will create a buffer between the time the command is issued by 

a User and when it is sent to its Zones. The default is none, and it could be set to 5, 

10, or 15 seconds. This gives the User a short window to cancel their action before 

the announcement goes out over the system.

The Retry Count sets the number of times (0-4) that an action will be requeued if 

it is consecutively interrupted. Note that a page may reach its Queue Timeout before 

it achieves all of its retry attempts. This will only apply to actions at a Priority level that 

are designated to Retry (see below).

WAIT YOUR 
TURN ...

If there are multiple actions in 
the Queue already, they’ll be 
placed behind any action that 
has equal or higher priority, 
but before any action that has 
lower Priority.

Next to each Priority level are three check boxes – Retry, Archive, and Split.

If Retry is checked it will allow the announcement to be requeued if it is interrupted 
before completion.

(continued on next page)
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If Archive is checked, an MP3 version of Pages at this Priority level will be created 
and stored in the Page Archives folder on the Core. These files can be found in 
the Audio Files tab, 
and played using the 
Play button next to 
their name. A Log will 
also be created of this 
event and you can see 
information and listen 
to the archived file in 
your Event Log.

If you would like your 
saved pages to be 
exported elsewhere, 
you could check the 
Enable Archive 
Export box, where 
you can specify an FTP 
server and directory 
to export your pages 
to. Be sure to input the User Name and Password for that location if necessary. 
Archives are not created for Messages, only Pages.

If Split is checked, then it will allow the announcement to queue in each of its Zones 
individually rather than wait for all Zones to be available. When Split is unchecked, if 
the announcement is sent to multiple Zones and even one of them is unavailable, it 
will wait until all Zones are free before being played. Split allows the announcement 
to play in the available Zones and be queued in the unavailable Zones. 

(continued from previous page)

When you created a Page Command, there were three Queuing options:

Live mode sends a page directly over the loudspeakers in real-time – but only if the 

zones are available. If they are unavailable, the Page will be unsuccessful. Live pages 

cannot be requeued.

Delayed mode will record a Page before it is sent to its destination Zones. If the 

Zone is available it will be played, and if it is unavailable it will be Queued. 

Automatic mode combines the other two modes – if the zone is available then 

it will be broadcast in real-time, and if the zone is not then it will be recorded and 

Delayed. 

SPLIT DECISION
 
When you Split a Command, 
consider it like you have sent 
the same message to every 
Zone individually. Each will 
abide by that Zone’s queue 
regardless of what the other 
Commands are doing. If your 
destination Zones have an 
overlapping audio space, 
you may not want to Split a 
command, because it could 
result in the same message 
being heard with a slight delay 
between Zones.
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EXERCISE 12.6: PAGE STATIONS & COMMAND 
BUTTONS

You briefly visited the Page Stations tab earlier to establish a Page Station’s Priority, 

and now it’s time to look at a few other options in this window.

1. Navigate to the Page Stations tab and double-click a Page Station to access its 

Settings.

In the general Settings section, there are a few options regarding the Revert 

Selected Command preferences. When a User issues a Command from the Page 

Station, by default that Command will remain selected on the LED screen and can 

be issued again by pressing the Talk/Start button. You might prefer the LED screen 

to revert away from this command. You can specify this to happen either after a 

certain amount of time has passed by adjusting the after Timeout field, or to 

happen when the Command is complete by toggling the after Executing field. You 

can then choose whether you would like the screen to revert to a neutral state (no 

Command) or to Command Button A.

Here, you can also specify the Maximum Page Duration for an outgoing Page, 

from 30 to 240 seconds, or not limited at all.

TO REVERT 
OR NOT TO 
REVERT ...

If the LED screen doesn’t revert 
from the Command you just 
issued, you can send it again 
by just pushing the Talk/Start 
button, which may be only 
an accidental bump away! 
Reverting your screen away 
from the Command ensures 
that you have to type in the 
launch code every time you 
issue the Command. On the 
other side, if you send the 
same Command constantly 
from the same Page Station, 
you could save a lot of time by 
leaving the Command selected 
and not reverting elsewhere.

12.6



181Q-SYS QUICKSTARTSCHAPTER TWELVE: PUBLIC ADDRESS

In the Command Buttons section, you can assign a Command to each of the Page 

Station’s Command Buttons.

2. Assign the Commands you’ve created to the 

Command Buttons of your Page Station by selecting 

one in the drop-down menu.

On the Page Station, you’ll see that the Ready light next 

to each assigned Command Button is now illuminated.

3. Press a Command Button on your Page Station and then press the Talk/Start 

button. Your Command will automatically be sent to its appropriate Zones. 

On a model with a keypad such as the PS1600, there are two more tabs in the Page 

Station settings – Keypad Commands and Security. Keypad Commands refer to 

launching a Command by inputting its code with the numeric pad.  You can choose 

to limit the available commands that can be summoned at that Page Station.

In the Security tab, you can set whether or not a User must logon to gain access to 

the Page Station, how long that User will be logged in before being automatically 

logged off, and which Users are allowed to have access at all.

NOW I 
REMEMBER!

You can browse the 
Commands’ numeric codes on 
your Page Station’s LED screen 
by pressing the zero button 
and cycling through available 
Commands.
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EXERCISE 12.7: THE PA ROUTER COMPONENT

The most important component of the Q-Sys 

Public Address system is your PA Router 

component in the Schematic. It must 

exist in your design for the aforementioned 

Administrator tabs to be available, and it is 

responsible for applying your settings. It routes 

all pages and messages from Page Stations 

to their appropriate zones, it delays, queues, 

and sorts pages based on priority and zone 

availability, as well as mixes background music.

1. Double click the PA Router to open its Control Panel.

The Control Panel shows each of your Zones represented by a row of Controls, 

grouped into different sections.

The first section, Output, 

lets you Mute the Output to 

each Zone, adjust the Output 

Gain, and choose a Squelch 

Priority. You can use the 

Squelch option to block all 

incoming announcements 

that do not have a high 

enough Priority. Pages and 

Messages will only be played in your Zone if it has a Priority higher than the Squelch 

Priority you specify here.

At the bottom of this section you will also see a Buffer meter, which shows you the 

percentage of your PA Router audio RAM in use.

THE BRAINS 
OF THE 
OPERATION

Don’t forget - the PA Router 
is where you determine how 
many Page Stations, Zones, 
and Background music 
channels you have in your 
design. Everything has to be 
properly wired through the 
Router or else all your work 
will be for nothing!

12.7

The Squelch command 
silences all incoming audio 
that doesn’t meet a certain 
criteria - in this case, a Priority 
level. It’s like the bouncer at an 
exclusive night club: it doesn’t 
matter how nice you dress up, 
you don’t get in if you’re not 
on the list!
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The Status section gives information on what is currently happening in each Zone. If 

an announcement is being Squelched, the Squelch LED will be on, and if the Zone 

is currently in use the Active LED will be on. In this case, the Source will display 

the Page Station number that is issuing the playing Command as well as its Priority. 

Here you can also Cancel All commands, or Cancel all Queued Commands, 

which would allow the active announcement to complete.

The Page section lets you mute or adjust the gain to Pages in each Zone. 

The Message section lets 

you mute or adjust the gain to 

Messages in each Zone, as well 

as displays the name of the 

Audio File of the active Message.

The Background section 

lets you mute or adjust the 

Background music in each Zone, 

as well as select which BGM 

source is being used in each 

Zone. Alternately, you could 

choose to mute or adjust the 

gain of the BGM source input by 

using the Input controls in the 

lower-right corner.

The BGM Ducker controls the manner in which the BGM is attenuated during 

an announcement. Attack Time defines how long it takes for the music to be 

attenuated, the Depth is the amount of attenuation applied, and the Release 

defines how long it will take to fade back to its normal volume.
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EXERCISE 12.8: THE VIRTUAL PAGE STATION

Now that your entire Public Address system is functioning the way you like it, it’s time 

to look at how a Virtual Page Station accomplishes some of the tasks you’re now 

familiar with.
❶

1. Double-click the Virtual 

Page Station component 

to access its Control 

Panel.

 

The biggest operational 

difference in a Virtual Page 

Station is that, rather than 

recall saved Commands, 

you must manually choose 

the configuration for each 

announcement you make. 

To do so, start in the 

Configuration section. 

 

2. First, select which type of announcement you’d like to make by choosing one 

from the Mode drop-down menu. You can make a Live Page, Delayed Page, 

Automatic Page, or play a Message.

3. Select the Priority of your announcement.

4. For Pages, you may select a Preamble from the second Preamble field (If you 

have sub-directories within your Preamble folder, you may select one of these in 

the first Preamble field).

5. For Messages, select your Message from the second Message field (If you have 

sub-directories within your Messages folder, you may select one of these in the 

first Message field).

6. For Pages, set the Maximum Page Duration.

7. If you would like your announcement to have Split, Archive, or Retry active, 

then highlight the appropriate button, and specify its Retry Count number.

❷ ❸

❹ ❺

❻ ❼

❽
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8. Finally, select your destination Zones for your announcement in the Zones 

selection section. You can select All Zones or Clear All to quickly toggle on or 

off all the available Zones.

You may notice that the Zones are labeled Zone 1 and Zone 2, even though you 

have renamed these Zones in the Administrator. Since these buttons are still inside 

the component’s Control Panel, they cannot be altered from their default status. 

However, if you drag these buttons into your Schematic or, more likely, to a UCI, then 

you can rename them to reflect your Zone names.

Once your announcement is properly configured, you can issue it from the Control 

section. The three LEDs will notify you if the destination Zones are Busy, if the Page 

Station is Ready, or Recording your announcement.

9. When you are ready, press the Talk/Start button (it will display Talk for Pages, or 

Start for Messages).

10. The text field in the middle of this section will display a more detailed message 

about the status of your announcement, similar to the information you would 

receive on the front LED panel of a physical Page Station.

11. The Virtual Page Station is designed to be 

used with a UCI such as an iPad or a QSC 

Touchscreen controller. You can drag all of 

the controls from the component’s control 

panel onto a UCI page and then have access 

to your PA system wherever you wish. 

Don’t forget that to make Pages you need 

to connect a microphone on your own and 

route that to your PA Router as well.

WHERE ARE 
MY TAGS?

There aren’t any buttons to 
select Tags here, which you 
created in the Administrator to 
help you quickly select multiple 
Zones. If you would like to be 
able to select your Tags rather 
than your Zones here, then 
you’ll need to edit the Virtual 
Page Station’s properties in 
the Right-Side Pane and add a 
Zone Group. This will create a 
drop-down menu in the Zones 
selection section from which 
you can select a Tag.

WANT TO 
MAKE SOME 
GREAT UCIs?

Check out “Exercise 4.9: 
The User Control Interface 
(UCI)” (page 93) to learn 
lots of great tricks for creating 
compelling User Control 
Interfaces. 
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12.8

Even though the Virtual Page Station doesn’t have a numeric keypad, it can still 

launch the Commands that have been built in Administrator. Just like a physical 

Page Station, you can assign those commands to Command Buttons.

12. Go to the Virtual Page Station’s 

properties and change its Command 

Button Count to 4. A Virtual Page 

Station can be configured to have up 

to 26 Command Buttons.

There will now be a new section in the Virtual Page 

Station’s control for these buttons. Once you assign 

a Command to each button in the Administrator 

(which you can do the same way as a physical Page 

Station), then the button will be able to be launched. 

Once you have selected a Command Button, you 

can press the Ad Hoc button to return to the manual 

method of creating a page/message.

`

ADVANCED PAGING CONCEPT:

The only way to launch a Command from a physical Page Station is to actually touch the 
button on its surface. But a Virtual Page Station could be directed to launch a command 
remotely, either from within Q-Sys or by a external third-party controller, by activating its 
Control Pins. After assigning a Command to the Virtual Page Station’s Command Button, 
all you have to do is remotely activate that Command Button and then the Talk button.

In the example here, a button has been wired to the Command Button A control pin to 
load the Command. Once the Command is loaded, the Virtual Page Station’s Ready LED 
will activate. We have wired that LED, via the “READY GO” signal name, to activate the 
Talk button. Now a single input signal will both load and issue the command.

This Page Station has also been configured in the Administrator to “revert to no Command 
after executing.” If this were not active, then the Ready LED would illuminate again when 
the message was finished, which would trigger the message to be played again over and 
over! 
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EXERCISE 12.9: DUCKING

When you integrate the output Zone audio with the rest of the program material, the 

program material’s volume must lower so that the paging audio can be heard, and 

then rise again when the page is over. This is called ducking.

You’ve already seen that the PA Router provides one option for ducking with its BGM 

inputs. These inputs are mono channel only, but if your destination Zone is in mono 

then there is no reason not to use them.

This image shows a 

simple signal path 

for two zones using 

mono channels.

Here you see how 

these Zones could be 

routed through the 

BGM inputs of the PA 

Router to provide the 

automatic ducking.

The program material of each Zone flows into the BGM pin and directly through 

the PA Router unaffected, until a Page or Message is issued. Then the Router 

automatically lowers the BGM volume and sends the PA audio on the same output 

pin, and raises the BGM audio again when it is complete. This is a very simple way to 

accomplish ducking. However, as mentioned, it only applies to mono signals.

If the program material is stereo (or more), then the Priority Ducker should be 

used. It can be found in the Dynamics branch of the Schematic Library. It allows all of 

its channels to pass peacefully through it until any audio is detected on its final input 

pin, the Priority pin. 

Then, it will attenuate 

all of its channels and 

replace their audio with 

the audio from this 

Priority pin. 

Your public address system is 
only useful if you can actually 
hear it! If the music that’s 
already playing in a room stays 
at the same level it’s at, it will 
be very difficult to understand 
the PA audio that plays at the 
same time!
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EXERCISE 12.10: CORE-TO-CORE PAGING

In extremely large venues, there may be different Cores handling different areas. 

Audio can be easily streamed between these Cores, but paging audio needs to 

be handled more specifically than a basic audio stream. When sending a page 

from one Core to another, this audio must still be treated as a page in order to be 

managed by the receiving Core’s PA Router to be queued properly according to its 

Zone assignment and priority. This involves telling the PA Router in each Core how to 

communicate with each other properly.

The Core that is sending the pages needs 

to add a new unique destination: a Remote 

Destination. This can be done in the 

PA Router’s Properties panel. Once a 

destination has been added, you can specify 

the Type of connection, (Q-LAN will be 

most common) and provide this connection 

a unique Name.

Unsurprisingly, the Core that is receiving 

the pages must add a Remote Source for 

their PA Router. The Name and Type of the 

connection must match the information 

used on the sending Core. This is because 

it is possible to set up multiple connections 

with multiple Cores, so each connection 

must be clearly defined.

Both PA Routers will now have tabs within their control panels. The first tab holds the 

standard controls for their local zones, and the new tab shows information about the 

audio that is being sent/

received, as well as the 

communication status of 

the connection between 

the Cores.

SENDING CORE

RECEIVING CORE
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12.10

There will now be a new option in the PA Zones tab of the Administrator. You can 

click the Plus button to add a new Remote Tag to add Zone destinations that will 

be sent on the Core-to-Core connection you have defined. These tags must be 

relabeled to exactly match the name of a Local Zone on the Receiving Core. If the 

name does not match a Zone on the receiving Core, then any page/message sent 

there will be dropped.

If the Receiving Core is using tags to group multiple Zones together, then the 

Sending Core can also send its messages to this tag’s name to be delivered to all 

of the applicable zones. Simply create a new Remote Tag on the Sending Core and 

match its name to the name of the desired tag on the Receiving Core.

If both PA Routers need the ability to send paging audio to each other, then both 

sides will be both a Sending and Receiving Core, but this uses a different connection. 

The second connection must be given a unique name in the Properties panel. 

SENDING CORE

SENDING CORE

RECEIVING CORE

RECEIVING CORE
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The Acoustic Echo Canceler (or AEC) is a component in the Schematic 

Library that processes the audio in a conference scenario and eliminates 

the echoes of the talker’s voices. This can be used in conjunction with the 

SoftPhone component that uses Voice Over Internet Protocol to manage 

your telephone audio through your Q-Sys design.

Q-Sys AEC can be used for multiple conference rooms in your venue and is 

surprisingly simple to configure and operate. This tutorial will walk through the 

internal mechanics of the AEC component to help you understand everything 

that is involved in reaching such a seemingly simple but necessary end result.

• Understand the importance of Echo Cancelation

• Learn about the internal processes that allow the AEC component to 
dynamically remove echoes in a live telephone signal 

• Connect and configure the Softphone component

Acoustic Echo Canceler
& SoftPhone

In This Chapter:

CHAPTER MAP
13.1  WHAT DOES AEC 
DO?  page 191

13.2  HOW DOES AEC 
WORK?  page 193

13.3  THE AEC 
COMPONENT  page 198

13.4  THE AEC CONTROL 
PANEL  page 199

13.5  THE SOFTPHONE 
page 200

13.6  ALTERNATIVES    
page 204

13.7  BEST PRACTICES 
page 208

CHAPTER THIRTEEN
QUICKSTARTS



191Q-SYS QUICKSTARTSCHAPTER THIRTEEN: ACOUSTIC ECHO CANCELER & SOFTPHONE

CHAPTER 13.1: WHAT DOES AEC DO?

In AEC terminology, the two end points of a telephone are called the Far End 

and the Near End. The Near End is where the AEC system is set up, typically in a 

conference room that has at least one microphone and at least one loudspeaker in 

the table or in the ceiling to broadcast the conversation. The Far End consists of the 

remote caller, who may be anywhere (in a car or a hotel, etc.).

The problem with this phone call is that 

the Far-End caller’s voice is broadcast 

from the loudspeakers in the Near-End 

room and travels directly back into the 

microphone to be re-transmitted to the 

Far-End. In addition, this direct path is only 

one of many ways the voice can re-enter 

the microphone: it could bounce off the 

walls, people, objects, or any combination 

of these and still eventually make it to 

the microphone. These paths are known 

as acoustic reflections, or echoes. As 

these reflections travel through the air 

they become distorted, and different 

frequencies are absorbed and attenuated 

as they bounce off of various surfaces. 

And, since they have different physical 

lengths, they arrive in the microphone at 

different times, resulting in a multitude of 

distorted echoes with various lengths of 

delay being sent back to the Far-End caller.

NEAR END CONFERENCE ROOM

The average latency of telephone audio is about 50 ms in one direction, so all of 

these echoes of the Far-End talker’s voice will be returned to the Far-End about 

100 ms later (50 ms + 50 ms), which is guaranteed to make anyone tongue-tied.

CONFERENCE 
ROOM TO 
CONFERENCE
ROOM

The Far End could also be 
another conference room, 
which would use a second 
AEC system. This is known as 
a full-duplex system. While 
there are many different 
possible ways to set up a 
system involving multiple 
microphones, loudspeakers, 
and AEC systems, this tutorial 
focuses on how the AEC does 
its job, so the setup has been 
simplified to one loudspeaker 
with one microphone in one 
conference room. 

ALL I 
HEAR ARE 
ECHOES!

Without echo canceling, 
your Far End caller will never 
be able to get through a 
conversation.

13.1
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BRAINSTORMING
So what is a simple solution to this problem? To 

prevent the Far-End caller’s voice from re-entering 

the microphone, an easy fix might be to turn 

off the Near-End microphone while the Far-End 

is speaking, and turn it back on 50 ms later. 

However, this means that the Near End would 

have to wait for the Far End to finish talking before 

saying anything: unable to comment, interject, 

or react. While this may seem like common 

courtesy, the reality is that attempting this makes 

an engaging, productive business meeting almost 

impossible. Try to have an efficient conversation 

using walkie-talkies, and you’ll quickly see how 

this type of one-at-a-time communication is a poor 

alternative. This is where AEC comes in. AEC is 

able to send the Near-End talker’s voices to the Far 

End without sending any of the Far End’s echoes 

along with it.

Sending the Near-End talker’s voices and ignoring the Far End talker’s echoes may 

sound simple, but remember that both noises are mixed together when they’re 

received by the microphone. Separating the two takes quite a bit of work and 

involves some complicated calculations, which is very easy to take for granted once 

it’s finished - considering that the end result is the same thing you’re used to hearing 

on a regular telephone call. Most speakerphones on a home telephone are half-

duplex systems which only allow one talker to speak at a time, but AEC systems can 

be seen in programs such as Skype on a desktop with computer loudspeakers.

AEC isn’t a new technology, but most network audio systems require external devices 

or expensive upgrades to integrate it into a design. All Q-Sys systems (equipped with 

Q-Sys Designer 3.0 or higher) include AEC at no additional cost with no additional 

hardware to setup or purchase. 

DON’T GET
SWINDLED 
BY THE 
OTHER 
GUYS!

“Can I interest you in a 
telephone? I’ll throw in 
speaker-phone capability for 
only an extra $200!”
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CHAPTER 13.2: HOW DOES AEC WORK?

FROM FAR-END CALLER

TO FAR-END CALLER

TO NEAR-END LOUDSPEAKER

FROM NEAR-END MICROPHONE

Although you’ll never interact with them, it may be helpful to know about all the 

different processes that take place within the Acoustic Echo Canceler. The diagram 

below shows a signals path within the component, as it travels through the Adaptive 

Algorithm and Adaptive Filter, Double-Talk Detection (DTD), Non-Linear 

Processing (NLP), Noise Reduction (NR), and Comfort Noise (CN).

Ultimately, AEC’s goal is simply to perform a subtraction operation: subtract the 

sound of the Far-End caller’s signal from the Near-End microphone feed. The 

component knows what the Far-End caller’s signal sounds like, because that signal 

travels through the component on its way to the Near-End loudspeaker. However 

it’s not enough to only subtract this signal from the microphone feed, because this 

wouldn’t address the acoustic reflections of that signal during its travel through the 

Near End room. AEC needs a way to predict what the signal will sound like by the 

time it is picked up by the microphone. 

If a sharp, impulsive noise such as a loud click is broadcast from the loudspeaker 

(and nothing else in the Near-End is making any noise), then AEC can record the 

resulting noise to understand how the room has affected the signal.

13.2
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The resulting signal would look something like the image below. There is a large 

peak at the beginning, which represents the signal that took a direct path from the 

loudspeaker to the microphone. Subsequent spikes occur as the signal bounces 

around the room, becoming distorted and attenuated along the way, and eventually 

making it to the microphone. This image is known as the room impulse response, 

and is a predictive map of what would happen to any noise on its journey from the 

loudspeaker to the microphone.

This room impulse response is used to create a Finite Impulse Response Filter 

(or FIR Filter) which can be applied to any signal to transform it into what it would 

sound like if it had traveled through the Near-End room. This is the work of the 

Adaptive Filter in the AEC signal path.

The incoming signal is sent both to 

this Adaptive Filter and the Near-End 

loudspeaker. If the FIR Filter is accurate, 

then the signal that comes from the 

Near-End microphone should be the same 

as the original signal after it goes through 

the adaptive filter. Then, when the AEC 

conducts its subtraction operation, the 

result should be silence.

The magic is that, if someone else in 

the room were speaking, this extra noise 

would not be subtracted, letting this caller’s 

voice continue along, free of any echoes.
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THE BUTTERFLY EFFECT

There is one major problem with this model, which is that the 

room impulse response constantly changes. If someone bumps the 

microphone, or opens a door, sits down, even turns their head, 

the surfaces of the room have changed. This means that the 

acoustic reflections of the room have changed, 

so the room impulse response has 

changed. The Adaptive Filter 

needs a way to keep up 

with these constant 

changes.

To compensate for the changing room 

impulse response, AEC uses an Adaptive 

Algorithm that monitors the result of the 

subtraction operation to determine how 

effective the Adaptive Filter is towards 

canceling out the echoes. If the result is 

silence, as it should be, then the Adaptive 

Algorithm will simply continue to monitor. If 

there are residual echoes left in the signal, 

then the Algorithm will determine how the 

Filter should be adjusted to compensate for 

these echoes, and dynamically apply these 

changes to the Adaptive Filter.

However, this Algorithm can only do its job if the Far-End is speaking and the Near-

End is silent. Since it is attempting to help make the subtraction operation equal 

silence, it won’t work if the Near-End is speaking because the subtraction operation 

will preserve that noise. Similarly, if the Far-End is not speaking then there is nothing 

to monitor at all. So how does the Adaptive Algorithm know when it should be 

working and when it shouldn’t be?

13.2
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This is a job for the Double-Talk Detector. The DTD monitors both the audio 

from the Far End as well as the audio from the Near-End microphone, and 

determines whether or not someone is speaking. If the Far-End is speaking and 

the Near-End is not, the DTD allows the Adaptive Algorithm to continue doing its 

job. In any other instance (if the Far-End is silent, or if the Near-End is speaking) 

then it will temporarily deactivate the Adaptive Algorithm and the existing Filter will 

continue to be used until the system has another chance to update it.

With this help from the Double-Talk Detector, the output of the Adaptive Filter is 

subtracted from the Near-End signal. The remaining audio is sent back to the Far-End 

caller, but before it gets there it will be sent through a few remaining processes to 

help clean up the signal and remove any residual echoes.  

Because of the difficulty in keeping the FIR 

filter constantly converged with the room 

impulse response, there are bound to be 

some remnants of the Far-End voice still 

present after the subtraction operation. Most 

of these remnants may be inaudible over 

the desired voices from the Near End, but 

may still be detectable when the Near-End 

is silent. The Non-Linear Processor is 

responsible for attenuating these leftovers.

DOUBLE-TALK 
DETECTOR

“Double-Talk” is also a phrase 
that means nonsensical 
speech. Unfortunately, the 
DTD does not protect you from 
listening to a conversation that 
goes on forever and never 
makes any sense. 
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At any given instant, the Non-Linear Processor, or NLP, analyzes the signal to 

determine whether or not it is made up only of residual echoes. If there is no other 

audio besides these echo remnants, the NLP further attenuates the signal. As soon 

as there is additional audio again, the NLP ceases this attenuation.

Even though the echoes have 

now been effectively removed, 

there is still some fine-tuning to 

be done on the audio signal. First 

is the Noise Reduction process, 

which listens for low, steady, 

sustained noise in the signal and 

then reduces it. 

Then there is the Comfort Noise block, 

which reintroduces a small amount of 

soft background noise into the signal. This 

comfort noise gives the Far-End a small 

amount of noise even when the Near-End 

is silent, which helps enforce the feeling of 

an open telephone line. Without this noise, 

the line could go completely silent when 

the Near-End is not speaking, and give the 

impression that the line has been cut-off. 

This is, basically, the result of AEC doing its 

job too well!

WHAT DOES 
THIS DO?

Wherever you are, close 
your eyes and listen to 
the environment. You can 
probably hear the hum of an 
air conditioner, or a computer 
running, maybe wind outside 
the window. All of this noise 
can be targeted by the Noise 
Reduction and reduced from 
the signal.
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CHAPTER 13.3: THE AEC COMPONENT

Setting up an AEC component in the Q-Sys Designer software is surprisingly simple. 

It can be found in the Audio Components branch of the Schematic Library. To 

integrate it into the design, simply drag it into the Schematic. 

As would be expected, the component has two inputs and two outputs:

• Microphone is the input from the Near End microphone(s).

• Reference is the input from the Far-End caller.

• Conference is the output to the Far-End caller. 

 

An additional output pin, Reinforcement, may be enabled in the Properties panel, 

which carries the Local Mic feed minus the Far End Call, useful if this mic feed needs 

to be sent to a PA system in the local room.

The Reference and Conference signals would both be typically connected to a 

SoftPhone component which handles routing telephone audio over a network. The 

Microphone and Reinforcement signals would both be wired to I/O Cards in your 

system that are connected to the appropriate devices (although they may be wired 

through various other signal processing along the way).

You can add additional channels to your AEC component in its Properties panel. Here 

you can also adjust it’s Tail Length from 100ms to either 200ms or 400ms. Every 

time the tail lenght doubles, the number of possible AEC channels your Core can 

handle is halved. Extending the tail length would only be necessary for rooms that 

are so large they have echoes that last beyond 100ms.

“WHERE IS THE 
SCHEMATIC 
LIBRARY?”

If you don’t know how to add 
components to your design 
yet, you’re in the wrong 
place! Go back and read up 
on basic Designer navigation 
in Chapter Two: Software 
Overview (page 26).

HOW MANY 
CHANNELS DO I 
HAVE?

Higher-capacity Cores can 
handle more AEC channels:

Core 250i = 32 channels
Core 500i = 48 channels
Core 1100 = 96 channels
Core 3100 = 192 channels

HOW DO I 
CONNECT A 
SOFTPHONE?

This will be covered at the end 
of this chapter.
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CHAPTER 13.4: THE AEC CONTROL PANEL

Despite all the different processes that happen within the AEC component, there 

are only a few controls that aren’t completely automated. If you double-click the 

component, you’ll see its control panel, and you’ll notice there aren’t very many 

controls here for you to adjust.

The AEC Bypass button turns off all AEC functions and lets audio pass through the 

component untouched. The Noise Reduction Enable button toggles on or off 

the use of Noise Reduction, and you can also adjust the gain Amount by which it 

is reduced. Similarly, you can toggle on or off the Comfort Noise with the Comfort 

Noise Enable button, and adjust the Level of comfort noise added.

The only remaining control is the Echo Return Loss Enhancement meter, which 

indicates, in decibels, how much the Far-End echoes have been successfully 

attenuated from the signal. The meter will only be accurate when the Far-End alone 

is speaking. Although a nominal level for this meter will fluctuate based on the 

distance between your loudspeakers and microphones, this gives a good impression 

of how effectively your AEC is working.

If you are interested in exploring Acoustic Echo Canceling in even greater detail, 

or in examining more complicated setup scenarios involving multiple channels or 

instances of the AEC components, click on the AEC component and press F1 or 

select Help from the File menu. The Help file, along with the QSC White Paper 

on AEC (linked in the Help file) will provide you with all the further detail you may 

desire on this complete speech enhancement system.
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EXERCISE 13.5: THE SOFTPHONE

The Softphone component gives you access to high-quality distance conferencing 

capabilities. Softphone connects Q-Sys to any Voice-over-Internet Protocol (known as 

VoIP) device using SIP, including FXO gateways connected to a standard telephone 

line, or a fully digital SIP method running on the existing network. Much like AEC, this 

feature is implemented in the software and is included at no extra cost. Furthermore, 

multiple Softphone components can be used simultaneously, making it simple to 

create multi-room systems within a single Core.

1. Go to the Inventory panel and click the “Plus” icon.

2. Select Streaming I/O.

3. Select Softphone. 

You’ll notice that a Softphone has now 

been added to your Inventory, and that it 

has three components that you can drag 

into your Schematic.

4. Drag the Status/Control component into 

the Schematic. This will provide you with 

functional control over the Softphone.

5. Drag the In component into the Schematic. 

This lets you route the incoming telephone 

signal.

6. Drag the Out component into the 

Schematic. This lets you route your 

microphone audio to be sent to the 

remote caller.

WHY IS IT 
CALLED 

“SOFTPHONE”?

Softphone simply means that 
it is the software version of a 
phone, not that it’s a squishy 
comfortable phone. This also 
makes it one of only two words 
in the English language that 
has the letters “ftph” together 
(the second being “ftpht” 
which is the sound of my cat 
coughing up a hairball).
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To complete the signal path, the In and Out components must be properly 

connected – to a loudspeaker and a microphone, for example.

In this diagram, a Mic/Line In 

Card has been wired to the Out 

component, and a Line/Out Card 

has been wired to the In component. 

7. Use the I/O Cards of your Core to connect to the Softphone components. If you 

are not operating on a Core, feel free to replicate the cards shown above.

As discussed earlier, if this phone line is being used as part of a conference system, 

AEC will be needed for each Softphone to remove the echoes coming from the 

Near-End loudspeaker.

8. Drag an Acoustic Echo Canceler into the Schematic from the Schematic 

Library.

9. Wire the Mic/Line In to the Microphone pin of the AEC instead of the 

Softphone Out component.

10. Wire the Conference pin of the AEC to the Out component.

11. Drag a second wire from the In component to the Reference pin of the AEC.

The next step is to properly configure the Softphone to work on the network, which is 

done in the Administrator. 

12. Press F5 or select File > Save to Core & Run to load this design to the Core.

13. Access Q-Sys Administrator using the icon in the upper-right hand 

corner or by selecting Tools > Show Q-Sys Administrator.

WHAT DOES 
THIS DO?

Remember that the AEC can 
only do its job if it knows what 
is being broadcast from the 
Near-End loudspeakers, so that 
it can try to delete the echoes 
of that audio which re-enter 
the microphone. 
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14. Select the Softphones 

navigation tab.

This panel has two columns. All the Softphones in your inventory are listed in the 

left-hand column, and the available Audio Codecs are listed in the right-hand 

column. At the top you’ll see the Interface field, which lists the network connections 

for your Core.

15. Select your interface that has VoIP available. These connections correspond with 

the network labels on the back of your Core – LAN A, LAN B, AUX A, and for 

larger Cores, AUX B.

16. Double-click your Softphone to 

access its Edit Properties.

17. Input your User Name and Proxy, 

whether or not you would like to 

register with the proxy, and input 

your Authentication ID and 

password. 

18. Select OK.

19. Select Update at the top of Administrator to keep your changes.

WHERE DO 
I GET THAT 
INFORMATION?

Either your IT technician or 
your VoIP carrier should be 
able to provide you all the 
settings you need to access 
your VoIP. Some carriers will 
double the User Name as the 
Authentication ID.
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20. Return to your Schematic and double-click your Softphone component to access 

its control panel.

The control panel has features that should be fairly familiar to any phone-user.

21. Test it out! Input a number and press Dial. Don’t forget that if your business 

requires you to dial 9 for an outside line, this rule still applies to your Softphone.

A

B C

E

H

I

J

K F G

D

(A) There is a keypad for entering an outgoing number, which you could  

 also type into the Outgoing field. (B)

(C) You can delete a digit or clear this field as well.

(D) The Incoming field shows the status of an incoming call.

(E) You can click the DND (Do Not Disturb) button to block incoming calls.

(F) If you are connected, you can click the Hang Up button to cancel the  

 connection.

(G) After inputting a number, click Dial to connect.

(H) When the line is Off Hook or Ringing, the corresponding light will   

 illuminate.

(I) Click Auto Answer to have the line automatically receive an incoming  

 call after the designated number of rings (J).

(K) The Status bar provides critical information on the Softphone’s current  

 activity.

HISTORY 
LESSON!

Back when your grandparents 
were young and the dinosaurs 
were just starting to die off, 
telephones had dials instead 
of buttons. Get this: it wasn’t 
even a dial on a touchscreen, 
it was an actual physical dial. 
It took enormous amounts 
of time to dial a number and 
people were very thankful 
for their friends whose 
phone numbers sparingly 
used the numbers 9 or 0. 
Since then, there have been 
technological improvements 
so vast they would make 
Alexander Graham Bell’s brain 
melt (which, some people 
argue, cell phones may do 
anyway), but we still use the 
verb “dial” to make telephone 
calls in honor of all our rotary 
ancestors.
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13.6: ALTERNATIVES

There are a few other options you may want to incorporate with your Softphone 

setup. For instance, some basic signal processing applied to your incoming line can 

help keep a constant comfortable gain level regardless of who is on the other line.

1. Delete the wires from the In Component.

2. Drag an Automatic Gain Control 

(AGC) from the Schematic Library (in the 

Dynamics branch of Audio Components) 

into the Schematic.

3. Wire the In Component to the Automatic 

Gain Control.

4. Drag a Parametric Equalizer from the 

Schematic Library (in the Equalizers and 

Filters branch of Audio Components) into 

the Schematic.

5. Wire the AGC to the Parametric Equalizer.

6. Wire the Parametric Equalizer to both the Line Out card as well as the Reference 

pin of the AEC.

These two components will keep the incoming audio comfortable, and you can 

adjust the settings of both components to your preference. 

WHY IS THIS 
NECESSARY?

Don’t forget that you want 
your AEC’s Reference signal 
to represent the audio 
that is broadcast from the 
loudspeakers, which means 
splitting it from as late in your 
signal path as possible. If you 
kept your original Reference 
wired to the Softphone In, this 
wouldn’t reflect the changes 
that the AGC or Parametric 
Equalizer perform on your 
audio, and the AEC wouldn’t 
be able to do its job as well.
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You may have noticed that the only notification the user receives when there is an 

incoming call is the Ringing LED in the Softphone’s control panel. However, you 

can configure an Audio Player to play an audio file from the hard drive to act as a 

ringtone.

1. Drag an Audio Player from the Audio 

Components branch of the Schematic 

Library into the Schematic.

2. Click the Audio Player 

and go to its Control 

Pins panel in the Right-

Side Pane.

3. Check the Play Trigger 

and Stop Trigger 

Control Pins.

4. Click the Softphone component and go to its Control Pins panel in the Right-Side 

Pane.

5. Check the Ring 

(trigger) and Ringing 

(state) Control Pins.

The Audio Player will play any audio file that you have uploaded to your internal 

Media Drive using the Administrator tool. If you have a very short beep or ring that 

you would like to use as a ringtone, then you can use the Softphone’s ring trigger to 

play a file:

6. Wire the Softphone’s Ring (trigger) Control Pin to the Audio Player’s Play Trigger.

THE MORE 
YOU KNOW ...

If you’re unfamiliar with 
loading Audio files to the Core, 
check out “Exercise 3.7: 
Audio Files” (page 75).
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Alternately, you may want to play a longer file such as a song or announcement. 

In this case you would need the audio player to stop when the line has been 

connected. So you could use the state of the Ringer to trigger two different options.

7. Wire the Ringing (State) 

Control Pin to the Play 

Trigger Control Pin. Now 

when the Softphone’s 

state changes to Ringing, it 

will initiate the Play button.

8. Drag a Control Functions 

component from the 

Control Components 

branch of the Schematic 

Library into the Schematic.

9. Select the Control Functions component (it may be labeled Value Sum) and go 

to its Properties panel in the Right-Side Pane.

10. Change the Function field 

to Logic NOT. To simplify 

the component for this 

exercise, change the Input 

Count to 1.

11. Wire the Ringing (State) Control Pin to the input of the Logic NOT component.

12. Wire the output of the Logic NOT component to the Stop Trigger of the Audio 

Player. Now when the Softphone’s state changes to not ringing (because the 

caller has disconnected, or because you have “picked up” the phone), it will 

initiate the Stop button, ending your ringtone.

EXPLORE THE 
CONTROL 
FUNCTIONS

The Control Functions 
component has a wide variety 
of built-in functions that can 
be used in your design to help 
you control the logic of your 
commands or combine values 
together in different ways. 
Click on your Control Functions 
component and press F1 to 
see its Help file which defines 
all the different functions it can 
execute.

13.6

Depending on the length of 
the file you use as a ringtone 
in this scenario, you may want 
to open the Audio Player’s 
control panel and engage the 
Loop button so that it will play 
more than once.
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Your creativity can lead to any number of ways to customize your Softphone. In the 

design below, a Speed Dial has been built out of custom text fields that the User can 

assign, which have been wired to a Lua Scripting block that will populate the Dial 

String field of the SoftPhone with the associated Speed Dial entry and subsequently 

trigger the Dial button.

This Speed Dial could be put into a UCI and accessed remotely on a touchscreen. 

This project file is available to download at qsctraining.com.

GOING THE 
EXTRA MILE

Q: So I could use a UCI 
running on my iPhone as 
part of my Softphone design 
to initiate a phone call from 
my Q-Sys Core over VoIP and 
then speak with a microphone 
attached to an IO Card and 
hear the response from a 
loudspeaker over my audio 
system? 

A: Yes you could! But in this 
scenario, you should probably 
just use your iPhone to make 
the call yourself.

13.6
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13.7: BEST PRACTICES

13.7

The possibilities of a complete AEC system extend well beyond the basics taught 

in this chapter. For a more detailed look at the finer points to creating your system, 

including how to approach multiple microphones, loudspeakers, or AEC systems 

on both ends of a call (a Full Duplex system), see the Q-Sys Acoustic Echo 

Cancellation page of the Q-Sys Help file. Here are a few good practices:

1. Adjust the gain of the AEC reference input so that it is approximately the same 

level (within 6 dB) as the AEC microphone input. You could use a gain or mixer 

unit to adjust the reference gain in order to reach this balance.

2. Place all signal processing modules, especially compressors and limiters, outside 

the signal loop of the AEC system. For instance, if you would like to add any 

processing to your local mics, attach them to the Conference signal that leaves 

the AEC component before it is sent to the Telephone feed, rather than in 

between your mic input and the AEC microphone input. Any processing used 

there would be interpreted as part of the room impulse response by the AEC 

component and may result in inadequate echo cancellation.

3. If you enable the AEC’s sound reinforcement pin, be sure to only use it in 

situations where you can tolerate a 20-millisecond delay. Otherwise, use the 

local microphone signals directly for sound reinforcement.

4. For rooms with multiple microphones, use a multi-channel AEC component with 

one channel per microphone and use a shared reference signal. 

INCORRECT

CORRECT

WHY STOP 
HERE?

There are even more examples 
and best practices that can 
be found in the Help File of 
the Q-Sys Designer software, 
as well as an even more 
in-depth look at Acoustic Echo 
Canceling. Simply press F1 
anywhere in the software and 
search for the page titled “QSC 
Acoustic Echo Cancellation 
(AEC)” Happy reading!



209Q-SYS QUICKSTARTSCHAPTER FOURTEEN: E-MAILER

The Q-Sys Designer lets you monitor your system and track any potential 

issues in a variety of ways: you have constant access to the Status of all 

Inventory items through the UCI, and the Event Log records all notable 

activity on the network. With the E-Mailer component, the Core can also be 

configured to send out notifications to keep the User instantly apprised of 

changes in the system. 

The most common use for this component would be in the event of 

inventory failure. If a Core or Amplifier’s status drops beneath OK, it can 

trigger a sequence of events that will culminate in the E-mailer component 

sending a message to your system’s technician. In essence, it allows the 

system to call out for help, rather than hope that someone is watching at the 

moment something goes wrong.

• Learn the basic functionality of the E-Mailer component

• Use Control Pins to automate your E-Mailer to notfiy you when the 
system detects an Inventory Status fault

E-Mailer

In This Chapter:

CHAPTER MAP

14.1  THE E-MAILER 
COMPONENT  page 210

14.2  AUTOMATIC 
E-MAIL ALERT  page 211

14.3  VARIATIONS      
page 215

CHAPTER FOURTEEN
QUICKSTARTS
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EXERCISE 14.1: THE E-MAILER COMPONENT

1. Go to the Schematic Library, 

open Control Components, and 

drag an Emailer component into 

your Schematic.

2. Double-click it to open its Control 

Panel.

This looks much like any common e-mail software, in which you input the important 

information such as: To (Recipient’s E-Mail address), Subject, and Message. When 

you are ready, you can click the Send button to deliver the mail. The Status bar 

will indicate whether or not the mail was successfully sent, and will give a message 

indicating the reason for an unsuccessful message. The bottom half of the control 

panel lets you configure your outgoing e-mail settings. 

3. Input your e-mail address in 

the From field (If the recipient 

of your e-mail replies to the 

message, it will be sent to the 

address you input here).

4. Input the password for 

your outgoing mail into the 

Password field.

5. Input the IP address of your 

outgoing SMTP mail server in 

the Server field.

6. If your mail service requires SSL, enable the SSL button.

The E-Mailer component has no editable properties aside from its Position and Color. 

Don’t forget that it will only work while running on a Core, and it can only send an 

e-mail if your Core is properly networked to an Internet connection.

Do not use a server name 
unless your Core is configured 
to use DHCP and the DHCP 
server provides a name server 
address. In this case you can use 
an outgoing SMTP mail server 
name rather than an IP address. 
If you need to change the port 
of your server from the default 
of 25, simply add a colon and 
the new port number (such as 
“smtp.gmail.com:35”)

You can enter multiple e-mail 
addresses by separating your 
recipients with a comma, space 
bar, or semicolon.

SERVER 
NAME OR IP 
ADDRESS?

STEVE, AMY; 
FRED BOB

14.1
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EXERCISE 14.2: AUTOMATIC E-MAIL ALERT

The real power of the E-Mailer lies in your ability to automate an event to send an 

E-Mail to you or your end user based on circumstances within the Q-Sys system. For 

instance, if an inventory item such as a Core or an Amplifier’s status drops from OK 

to Fault, you can configure the E-Mailer to automatically notify you so that you can 

investigate the situation as quickly as possible.

1. From the Inventory 

panel, add an Amplifier 

to your Schematic. This 

example uses a PL380. 

2. Drag the Status 

Component for your 

Core and Amplifier from 

the Inventory panel into 

the Schematic.

3. Select the Core Status 

Component, go to its Control Pins 

panel in the Right-Side Pane, and 

activate the Core Status Control Pin.

4. Select the PL380 Status Component, 

go to its Control Pins panel in the 

Right-Side Pane, and activate the 

Status Control Pin.

With these pins activated, you have the ability to send 

the status information of your inventory’s components to 

another control, which will begin a sequence of events 

that leads to an e-mail being sent. While you could 

create an individual sequence for each of your inventory 

items, it would save time to combine all of your status 

indicators in a single place. You can do this with the 

Status Combiner component.

PREPARING 
FOR FAILURE

This test example is only 
connected to a Core - the 
PL380 Amplifier doesn’t 
actually exist in the system. 
It’s been added to the design 
so that its status will register 
as a Fault when the design is 
run on the Core at the end of 
this Exercise. If you have some 
actual peripherals in your 
design, you could simulate 
a similar Fault by simply 
unplugging a Peripheral.

14.2
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5. Drag a Status Combiner 

from the Control Components 

branch of the Schematic Library.

6. Wire the Status Control Pins 

of your inventory items to 

the input pins of the Status 

Combiner. 

7. Double-click the Status Combiner to look at its Control Panel.

In this Control Panel, the worst 

status from all the available 

inputs is presented. If you’d 

like, you can label each of your 

inputs. If all Statuses are OK, 

the OK LED will illuminate. If 

one or more are Compromised, 

the Compromised LED will 

illuminate, and if one or more is 

in a Fault then the Fault LED will 

illuminate. For this exercise, the 

goal is to initiate an e-mail if the 

Fault LED ever illuminates.

8. Select the Status Combiner, go 

to its Control Pins panel in the 

Right-Side Pane, and activate the 

Fault Control Pin.

When the Fault LED illuminates it stays on, but you wouldn’t want to deliver a 

constant signal to your E-Mailer’s Send button. The next step is to convert this 

constant signal into a momentary trigger.

9. Drag a Custom Controls component 

into your Schematic from the Control 

Components branch of the Schematic 

Library.

AS MANY AS 
YOU NEED ...

You can edit the number 
of Input pins on the Status 
Combiner to however many 
you find appropriate.

WHAT IS A 
COMPROMISED 
STATUS?

Compromised Status 
indicates that audio is still 
good, but a potential problem 
has occurred. This could be a 
non-fatal hardware issue such 
as a fan running too slow or 
temperature being higher than 
expected. It could also indicate 
that at least one redundancy 
mechanism is active, such as 
if one of the two LANs goes 
down.

14.2
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10. Select the Custom Controls component and go to its Properties panel in the 

Right-Side Pane. Change its Group 1 Type to Momentary Button, and keep its 

Count at 1. 

11. Wire the Fault LED 

Control Pin to 

the Momentary 

Button Input 

Control Pin.

The trigger is almost 

complete, but there is 

one more step before it 

can reach the E-Mailer.

12. Drag a Control Delay component into your Schematic from the Control 

Components branch of the Schematic Library.

13. Wire the Momentary Button Output Control Pin to the Control Delay 

Input Pin.

14. Select the E-Mailer 

component and go to 

its Control Pins panel 

in the Right-Side Pane. 

Activate the Message 

and Send Control Pins.

WHAT AM I 
WAITING FOR?

Why use the Control Delay? 
Well as you’ll see in just a 
moment, you’re going to use 
the Event Log to form the body 
of your E-Mail’s message. 
To ensure that your system 
has enough time to compile 
a complete log of your Fault 
event before the e-mail is 
composed, it’s recommended 
to add a short delay into 
this path. The Control Delay 
can delay the signal up to 10 
seconds, which is its default 
setting. You can leave this 
setting at 10 seconds for this 
exercise.

14.2
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15. Wire the Control Delay Output 1 Control Pin to the E-Mailer Send Input 

Control Pin.

The system is now properly wired to send an e-mail whenever there is a fault 

with an inventory item. All that remains is to put the correct information into the 

Message of the e-mail.

16. Drag an Event Log Component 

into your Schematic from the Control 

Components branch of the Schematic 

Library. 

17. Select the Event Log Component and 

go to its Control Pins panel in the 

Right-Side Pane. Activate the Last Entry 

Control Pin.

18. Wire the Last Entry Control Pin to the E-Mailer Message Input Control 

Pin.

Any inventory’s status fault will create a log in your Event Log, and the last entry of 

the Event Log will now be used for the body of your E-Mail message. You can test 

this for yourself. Run the Design to the Core by pressing F5, and the PL380 Amplifier 

you added that does not actually exist will register a Fault. This will start the chain of 

events, and in a few seconds you should see an e-mail waiting in your inbox.

THE EVENT 
LOG

Unfamiliar with the Event Log? 
It’s a record of recent notable 
events on your system - check 
out “Exercise 3.8: The Event 
Log” (page 77).

Make sure your network 
is configured to access the 
Internet and you have properly 
input your e-mail settings in 
the first Exercise, or else you 
won’t get very far!

14.2
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EXERCISE 14.3: VARIATIONS

The last exercise was just one of many ways that you could use the E-Mailer. There 

are any number of possibilities for controlling the E-Mailer’s fields from elsewhere 

in your design. There are several Designer project files available to download from 

www.qsctraining.com in the E-Mailer lesson. For instance, if you would like the 

user to be able to dynamically control who receives e-mail alerts from the system, 

you could drag the “To” text field from the E-mailer into a UCI that the User can edit. 

If you don’t want the recipients of your E-Mail to be part of a mass mail, you could 

use the Control Delay block to relay its signal to multiple separate E-Mailers that each 

have their own recipient. With this method, you could potentially personalize each 

e-mail. This project is titled Example-Multiple Recipient on the website.

As with many areas of Q-Sys, knowledge of Lua scripting lets you use the Control 

Script component to write your own logic code that can let you truly personalize 

how your components interact. In the example below, the Control Script component 

receives various inputs from the Status Combiner, analyzes that information, and 

customizes the e-mail’s message and subject to reflect exactly what that Status 

Combiner is reporting, rather than simply exporting the Event Log’s last entry. This 

project is titled Example-Lua on the website.

Download these free project 
files to take a closer look at 
how they work and get some 
great ideas for the potential 
of the E-Mailer in your own 
design.

14.3
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Core-to-Core Streaming allows the streaming of audio from one Core to 

another. This application comes in handy for large installations when audio 

streams need to be processed on one Core and shared with another.  For 

instance, imagine that you are designing a theme park and each land of your 

theme park has its own Core.  If you want to share the final mix from a stage 

production in “Treasure Island” to people waiting in line for a ride in “Zombie 

Village”, you would need to use the Q-LAN Transmitter and Receiver to 

stream audio between Cores. 

•  Configure your Virtual Q-LAN Transmitter on one Core to send audio. 

• Stream audio to the Virtual Q-LAN Receiver on a second Core.

Core-to-Core Streaming

In This Chapter:

o NOTE: You will need access to two separate Cores to complete this tutorial.

CHAPTER FIFTEEN
QUICKSTARTS

CHAPTER MAP

15.1  SYSTEM SETUP  
page 217

15.2  CONFIGURING 
THE RECEIVER            
page 219

15.3  CONTROL LINK     
page 22
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EXCERCISE 15.1: SYSTEM SETUP

This exercise will demonstrate streaming several audio streams from one Core to 

another. Let’s use two Audio Players to simulate those streams. 

1. Under Audio 

Components, drag 

two instances of the 

Audio Player into 

the Schematic.

2. Configure the Audio Players by adjusting the Name and Track Count. For this 

example, the Track Count will be 2 and the Name will remain unchanged.

Since you’ll be streaming audio from one Core to another, you need to configure the 

system’s domain so that the Cores will be looking for each other. 

3. Add a Transmitter to the design by clicking the Plus icon in the Inventory pane, 

click the Streaming I/O tab, and select the Q-LAN TX Transmitter. This 

transmitter is in charge of streaming the audio from one Core to another.

4. Drag the Transmitter component into the Schematic.

5. Configure the Q-LAN TX Transmitter by clicking on the Component and finding 

the Q-LAN Transmitter Properties panel located in the Right-Side pane.

6. Name the Transmitter and change the Channel Count to match your Audio 

Player’s channel count (which, in this example, is 2).

Keep in mind that most Cores 

only allow 16 Audio Player 

tracks (unless you have 

upgraded to MTP-128). It’s 

important to configure the 

Audio Player to fit the source. 

For more information, check 

out Chapter FIVE: Audio 

Player (page 103).

AVAILABLE AUDIO 
PLAYER TRACKS:

15.1
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When the Dynamic Stream 

Name is enabled on both the 

transmitting and receiving end, 

it will allow a single receiver to 

receive streams from multiple 

transmitters, whether you 

have multiple streams or not. 

You should always consider 

enabling this feature because 

you can always add streams 

later should you decide you 

need them.

7. Enable Dynamic Stream Name by clicking the dropdown and selecting Yes.

8. Repeat this entire process (or simply copy and paste) so that you have a second 

Q-LAN Transmitter in the design, and wire an Audio Player to each one. Be sure 

that each Transmitter has a unique name.

9. Wire the Audio Players to the Transmitters, and then Save to Core and Run 

by pressing F5.

10. Play an audio file in both Audio Players 

by selecting a File and pressing the Play 

button. Press the Loop button as well 

to ensure that these Audio Players will 

continue to stream audio while you work 

on the Receiving Core’s design.

11. You can double-check that the Transmitter 

is sending audio by opening its control 

panel and watching its meters.

DYNAMIC 
STREAM 
NAME:

WHAT DO THESE RED BOXES MEAN?

You may have noticed that after 

sending your design to the Core, 

the Transmitter Components 

located under the Inventory 

Panel are Red. Don’t worry about 

this for now, it simply means 

the Transmitters are not finding 

any available corresponding 

receivers on any other Cores in 

the Domain.

15.1
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Now that the Transmitting side has been configured, switch over to your other design 

so that we can set it up to receive our audio streams. Much like before, we need to 

configure the receiving Core, and make the streams discoverable.

1. Add a Q-LAN Receiver to the design by clicking the Plus Icon in the Inventory 

Pane, select Streaming I/O, and then find the Q-LAN RX Receiver.

2. Click and drag your new Receiver component into the Schematic, and configure 

the Q-LAN Receiver’s Properties. In the Right-Side pane, assign a Name and 

adjust the Channel Count to match the Receiver’s channel count. Lastly, set the 

Dynamic Stream Name to Yes.

3. Finally, Save to Core and Run by pressing F5.

4. Double-click the Q-LAN Receiver component to open its Control Panel.

5. In the Select Stream field, select your desired stream from the drop-down 

menu.

The component should instantly 

come to life once you’ve selected the 

stream. You can now see how the 

stream is playing and being received. 

You could wire the output of the 

Receiver component into your design 

just like any other audio, and you 

could listen to it over your computer 

loudspeakers by using the Hover 

Monitor.

EXCERCISE 15.2: CONFIGURING THE RECEIVER

Q-Sys allows you to have two 

instances of Q-Sys Designer 

open at the same time. Pretty 

cool, right?

If you’re not using the Dynamic 

Stream name option, then the 

Names of your Transmitter and 

Receiver must be identical, and 

this will create a link between 

the two. However, this only 

allows a single stream. If you 

use Dynamic Stream Names, 

then the Names of your 

components do not need to 

match.

DID YOU KNOW?

WHAT’S MY 
NAME?

15.2

MY NAME IS

?
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FIX THE RED:

Take note that the Receiver in the Inventory pane is no longer red. This indicates that the 

audio stream is working properly. A Transmitter or a Receiver will register a fault if it does not 

have a completed link with another Core.

BEFORE AFTER

15.2

You’ll notice that the Receiver’s Control 

Panel has its own controls for the audio, 

including the Gain control, Mute button, 

and the Invert button. 

Because you have enabled the Dynamic 

Stream and assigned a Name to each 

audio stream you planned on sending, you 

can now toggle between these streams 

from your Receiver without disconnecting 

from the Core. You could also rename a 

stream on the Transmitting side and select 

that stream from the Receivin Core.

CHANNELS COUNT!
In order for a Q-LAN Transmitter and Receiver to be able to communicate with each 

other, they must be configured to have the same number of channels. Otherwise, 

they will not be able to create a link. In the Stream Select field of the Receiver, you can 

only find valid streams that have the same number of channels as the receiver.

If you are using a Core250i, only 16 channels can be shared in this way. Higher Cores 

are limited only by their standard network channel count limitations.
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EXCERCISE 15.3: CONTROL LINK
15.3

Cores can exchange more than just audio data, they can share control data as well. If 

you want your receiving Core to have control over the play button of the Transmitter’s 

Audio Player, for instance, you can send this type of data using the Control Link 

component. Both Cores will need to have this component properly configured.

1. Drag a Control Link component into the schematic from the Control 

Components branch of the Schematic Library.

2. Select the Control Link and go to its Properties in the Right-Side Pane.

3. The Control Link Name must be identical on both components.

CLIENT/SERVER 

“Transmitting” and “Receiving” isn’t proper terminology for these components. For many 

types of controls such as knobs and toggle buttons, the controls become synchronized on 

both sides, which means that data is flowing in both directions. So instead of “Transmitter” 

and “Receiver,” one Control Link is designated the Client and the other one the Server.

Which one do I use? 

Trigger controls are only sent from 

a client to a server. 

Text displays, Meter controls and 

LEDs are only sent from a server to 

a client. 

All other controls are peers, and 

adjusting one in either design with affect the other.

If you aren’t sure, it will become obvious when you populate the Control Link with a 

control. If a control only has an input pin, then you know it cannot receive data from the 

other Link. If it only has an output pin, then you know it cannot send data.

The Trigger on the Client only 

has an input pin, and the 

Trigger on the Server only has 

an output pin. That’s because a 

Trigger can only be sent from a 

Client to a Server.

LOOK AT 
THE PINS!
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4. Add a Trigger button to each Control Link by changing the Type of its first group 

of controls to a Trigger button. Leave the Count at 1.

Now both Cores have a custom Trigger button, linked by the Control Link.

“CLIENT” CORE “SERVER” CORE

The Client Control Link Trigger button can now activate the Server 

Control Link Trigger button. The Client could simply use the button 

that has been populated in the Control Link’s control panel, or 

it could activate this trigger button from another component by 

using its exposed Control Pin. The control panel also displays the 

status of the connection between Control Links.

5. Expose the Play trigger of the Audio Player that is connected to the Q-LAN 

streamer.

6. Wire the Server’s Control Link trigger pin to the Audio Player’s input Play trigger.

Now the Receiving Core has the ability to activate the Audio Player that is streaming 

audio to it. This is obviously a simplified example, but being able to send controls 

and meters between two Cores will be very useful when Cores are also streaming 

audio to each other.

15.3
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Periodically, QSC releases new versions of the Q-Sys Designer software that 

may have some new features or recognize some new hardware elements 

that you might want to integrate into your design. These software updates are 

available for free at qsc.com.

BEFORE YOU START UPDATING:

Be aware that this process may take 

a little time, and there may be a few 

complications. You do not want to 

begin this procedure ten minutes 

before you need your system to 

be operational! Your Q-Sys system 

is mission-critical to your business, 

and taking it offline for any reason 

should only be done when there is 

ample time to accomplish your task.

And don’t forget: just because you can update, doesn’t mean you need to! 

If your system is working fine and you do not need any new features that are 

in the latest upgrade, then there’s no reason go through this process.

• Upgrade your system to the latest version of the Q-Sys Designer 
software

• Troubleshoot some possible problems that could arise during an 
updating procedure

Firmware Update

In This Chapter:

CHAPTER SIXTEEN
QUICKSTARTS

CHAPTER MAP

16.1  UPDATING THE 
SYSTEM 
page 224

16.2  TROUBLESHOOTING 
page 223

TSC-8
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EXERCISE 16.1: UPDATING THE SYSTEM

1. Download the latest version of Q-Sys Designer software from qsc.com and 

install it to your computer.

2. Launch the new version of Designer.

3. Match the Core properties in the blank design to the Core on your network. For 

help, visit “Lesson 3.1: The Q-Sys Configurator” (page 61).

4. Select File>Save to Core & Run.

5. A popup screen will warn you 

that the Core has a lower version 

than that of your design, so select 

Update to proceed.

You will see a status bar on your 

Core’s LED screen showing its 

progress. When it is complete, it 

will reboot.

6. Disconnect from the Core by pressing F7.

7. Add all hardware peripherals present in your system to the blank design using 

the Inventory panel. This includes I/O Frames, Page Stations, Touchscreens, etc.

8. Select File>Save to Core & Run.

9. Now the firmware will be updated on each of your peripheral devices. Once 

again, each of these devices will show a status bar of its progress.

10. Open your actual design with the new Designer software, and once again select 

File>Save to Core & Run. Your system has your updated firmware and design!

If you have a design running 
on your Core already, you 
may want to be certain that 
you have the latest version of 
it saved on your computer. 
If you don’t, then you may 
want to launch your old 
version of Designer and click 
File>Load From Core & 
Connect to access the design 
on your Core, then save the file 
somewhere safe.

BACK IT UP!

16.1
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EXERCISE 16.2: TROUBLESHOOTING

Occasionally, updating the firmware will result in an error message, or an endless 

cycle of rebooting, or a similar problem - particularly if the entire system was updated 

at once rather than step-by-step as described in the previous section. Don’t worry, it 

is easy to get back on track by trying these simple steps.

1. PULL THE PLUG 

If the progress bar hasn’t moved in over five minutes or there is some other 

error, don’t be afraid to simply unplug the device and plug it in again. This quick 

reboot will get the device responsive again, and in some cases it may pick up 

directly where it left off and complete its update as planned.

2. REDEPLOY 

After rebooting, if the device did not complete its update, simply send your 

design to the Core again. Any devices on the system that have not been properly 

updated will be sent the new firmware and your devices should update without 

consequence.

3. THE MIGHTY PAPER CLIP 

In extreme cases when multiple reboots and redeployments have not been 

successful, you may need to reset the device. On the front of the Core there is 

a small hole, and you can insert an unbent paper clip into the hole to reset the 

device to the factory default. The LED screen will let you know to hold the button 

for ten seconds, and then the reset will initialize. You will have to rename your 

Core in the Q-Sys Configurator to the name you like, and then you should be 

able to update the Core to your latest firmware without any further problems. For 

information on the reset procedure for other devices, consult its spec sheet.

Don’t forget to plug it back in!

16.2
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The Control Script component lets the user input script commands using 

the Lua coding language to further customize the design. This component 

can be wired to other controls to change or monitor their status. The scope 

of what can be accomplished with the Control Script block goes far beyond 

anything that can be demonstrated in this chapter, which will walk through a 

fairly simple use of its functionality.

OBJECTIVE: The owner of a popular night club has a problem with one of 

his DJs: as the room gets more crowded, the DJ raises the music until it is 

uncomfortably loud. The owner would like a way to alert the DJ when he is 

pushing the music too far – such as changing the color of his gain fader to 

bright red when it reaches a certain point. Ordinarily a fader control only has 

one color, but this attribute can be actively changed using Lua scripting.

• Learn about the Control Script component and Control Pins

• Write a very basic Lua script that changes the visual appearance of a 
control based on its value.

Control Script

In This Chapter:

CHAPTER SEVENTEEN

CHAPTER MAP

17.1  CONNECT THE 
CONTROL SCRIPT 
COMPONENT  page 227

17.2  FADER TURNS RED  
page 230

17.3  VARIATIONS      
page 234

QUICKSTARTS
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EXERCISE 17.1: CONNECT THE CONTROL SCRIPT 
COMPONENT

The first thing you need to do is connect your Control Script to the target you would 

like it to control - in this case a Gain Fader. 

1. In the Schematic Library, under Audio Components, drag an Audio Player 

into your Schematic. This will represent the music that the DJ plays.

2. In Audio Components under Mixers, drag a Matrix Mixer into the Schematic. 

This contains the gain fader that the DJ uses to adjust the volume.

3. Select the Mixer and go to its Properties panel in the Right-Side Pane. Change its 

Input Count to 1 Mono Channel, and its Output Count to 1 Mono Channel. 

This is to simplify the Mixer purely for the purpose of this tutorial.

4. Wire the Audio Player to the Mixer. 

5. Double-click the Mixer to 

open its Control Panel, 

and drag the Input 1 

Gain Fader into the 

Schematic.

A REAL TEST

Although it isn’t required in 

order to see the control’s color 

change, you’re more than 

welcome to use your Audio 

Player to play an actual file 

while running this exercise. If 

you’re unfamiliar with how to 

load music and other audio 

tracks to your Core, check out 

“Exercise 3.7: Audio Files” 

(page 75).

17.1
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6. In the Schematic Library, under Control 

Components, drag a Control Script 

component into your Schematic.

7. Select the component and go to its Properties 

panel in the Right-Side Pane.

8. Change its Input Count to 1 and its Output Count to 0. This will simplify the 

component for the purpose of this tutorial since you are only wiring it to one 

control.

Next you need to connect the Control Script to the fader. However the fader is just a 

control, not a component, so you cannot wire anything to it.

9. Select the Mixer and go its Controls Pins panel in the Right-Side Pane. Check 

the box for the Input 1 Gain. This will add a row of pins on the bottom of the 

component that can control the Gain.

This allows an outside control, such as your Control Script component, to adjust the 

Mixer’s Input 1 Gain. However this will still not accomplish your goal in this exercise 

– you don’t want to change the value of the gain, you want to change the color of 

the fader that controls that gain. In order to do this you will need to use the Custom 

Control component to create a control that has its own control pin.

QUESTION: Well then why 

did I drag it into the Schematic? 

Are you trying to trick me 

again?

ANSWER: We would never 

trick you.

QUESTION: What!? Why did 

I do that then? You only made 

me do that so you could tell 

me it wouldn’t work?

ANSWER: Disappointment is 

a powerful teacher.

10. Under Control Components in the 

Schematic Library, drag a Custom 

Control component into the Schematic.

17.1
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11. Double-click the Custom Control component to open its Control Panel.

12. Select the Custom Control component and go to its Properties panel in the 

Right-Side Pane.

13. Change its Group 1 Type to 

Level fader w/taper (dB). 

You will now see one level fader 

populate its Control Panel.

QUESTION: Hey! There’s 

nothing in this Control Panel - 

it’s completely empty! Why do 

I keep on falling for your tricks?

ANSWER:  There is nothing 

in this Control Panel ... yet. 

You can manipulate the 

properties of a Custom Control 

component to populate its 

Control Panel with as many 

and various blank, unassigned 

controls as you would like.

14. Drag this fader into the 

Schematic and close the 

Control Panel.

15. Wire the output of the Fader 1 Control Pin of the Custom Control component 

to both the Input 1 Gain Control Pin of the Mixer and the input of the Control 

Script.

16. Delete the original fader that you dragged out of the Mixer.

Whenever this new control is moved by the DJ, it sends information to both the 

Mixer’s Input 1 Gain (which adjusts its gain the same way its original fader did) as 

well as the Control Script (which will trigger your scripting, and the Control Script will 

feed its response back to the custom control to change its color). Next it’s time to 

write the Lua script that will make this possible.

QUESTION: I knew there was 

no reason for me to drag it into 

the Schematic in the first place! 

You were tricking me, I knew it! 

ANSWER: Congratulations.

17.1
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EXERCISE 17.2: FADER TURNS RED

NOTE: 
If you are unfamiliar with Lua scripting, or even 
computer coding in general, this section may be 
very confusing. If you do not feel comfortable 
writing Lua script, it is not recommended that you 
use the Control Script component. This tutorial is 
not intended as an introduction to computer coding 
or to the Lua language, but instead to show the 
ways in which your pre-existing knowledge in these 
areas can be applicable in the Q-Sys software.

1. Enter Emulation Mode by pressing F6 or selecting File > Emulate.

2. Double-click the Control Script component to open the scripting block.

Instead of a traditional control panel, this component has a new window in which 

you can type your Lua script. You can treat this page much like any other page – you 

can toggle between different tabs on the Schematic, or you can undock it from the 

Schematic and move it elsewhere on your screen.

DID YOU 
KNOW?

If you want to split your screen 

between multiple Schematic 

pages, or in this case the 

Scripting block, you can drag 

and hover one page over 

another and use the Split 

Screen tool (shown above) to 

select the direction in which 

you would like to split the 

screen. To rejoin the page as a 

tab, select the center option.

17.2
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3. If you wish, start your script by labeling it with a comment. You can add a 

comment by typing two dashes. If you have multiple scripts in a design, this is a 

useful way to quickly identify which is which.

Notice that as soon as you made a change in the script, a yellow bar appeared at 

the top of the block that reads Script has changed and is out of sync. Click to 

update script. This is to let you know that the changes you made are not yet active, 

and the component is still running whatever script was in the block beforehand. This 

way you can edit your script without interrupting the audio by shutting down the 

active design or redeploying the system. Once you click the yellow bar, your changes 

will go active.

Your first job is to tell the Control Script what it’s connected to, so we’ll use Lua to 

give this connection a name. You can name this anything you wish, although it might 

be useful to name it something indicative of its function, such as “DJGain.”

4. Type: DJGain = Controls.Inputs[1]  in the scripting block.

SIDE COMMENT

A comment will appear in 

green text in the scripting 

block. This comment is ignored 

by the software and is for your 

viewing purposes only. You can 

create a comment anywhere in 

the block by using two dashes. 

The remainder of that line of 

code will be your comment.

TRANSLATION 

PLEASE ...

This indicates that “DJGain” is 

connected to “Input 1” of the 

“Controls” block. For more 

information on the ways to 

parse the attributes of Q-Sys 

components, check out the 

help file’s Using Lua in Q Sys 

page.

When the fader is moved, by the DJ for instance, this action is called an event. 

Every control has an EventHandler which determines what happens in response to 

this event. You need to access this EventHandler in order to create your new color-

changing function. Once again you’ll be able to name your function anything you 

wish, such as “FaderGuy.”

5. Type: DJGain.EventHandler = function(FaderGuy)

17.2
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You have started a function now, which cannot be complete until it has an end.

6. Skip a few lines down, leaving room for your function, and type: end.

All that is left is to define this function. You want to change the color of the Fader 

when it reaches a certain level. This can be done with a simple if statement. 

7. Type: if FaderGuy.Value > 3 then FaderGuy.Color = “red” 

else FaderGuy.Color = “yellow” 

end

An If statement is a simple 

chain of logic. For example, if 

you stub your toe, then you 

scream like a baby.

This simply states that when the Value of the control is pushed above 3 dB, then 

the Color of the control will turn red. If it is not (else) above 3 dB, then it will be 

yellow. You can find a complete list of all of the editable attributes of Controls (such 

as Value and Color) in the Help file. Be sure to use the correct capitalization when 

referencing an attribute in the Lua script.

8. Click the yellow bar at the top of the Scripting block to update the script.

“Red” and “Yellow” aren’t just 

arbitrary names. These follow 

the standard HTML color 

code chart. If you search this 

online, you will quickly find 

a chart of colors and their 

corresponding names and 

hexadecimal color codes. 

The color code for “red” is 

#FF0000. In Lua script, you can 

use either of these to indicate 

the color of your choice. You 

could even use an HSV value if 

you are familiar with that color 

style.

COLOR 
SELECTION

17.2



233Q-SYS QUICKSTARTSCHAPTER SEVENTEEN: CONTROL SCRIPT

9. Move your fader to test your script. If you have written your code correctly then 

the fader will be yellow as long as it is beneath 3 decibels, and becomes red 

when it is above 3 decibels.

10. If your fader is not working properly, look in the Debug Output window at 

the bottom of your scripting block. This window will report any errors in your 

script in red, and identify the line of code that the error is found in. If you have 

misspelled a label or left a logic statement incomplete, this will help you find that 

problem.

Your script is now complete. If you are proficient in Lua scripting, it should be easy to 

imagine the possibilities that this component can unlock; however it can be terrifying 

to someone who has no experience with computer coding. The degree to which 

you use the Control Script block is entirely up to you, and your ability in Lua script. 

The Q-Sys help file gives you as much assistance as you should need in taking your 

knowledge and applying it to the components in the software.

17.2

IT’S A BUG HUNT

Do you see the error in the 
script to the left? The Debug 
Output reads “5: Property 
‘Xolor’ does not exist on 
Control.” If you look at Line 
5, you’ll see near the end that 
“Color” has been misspelled 
as “Xolor”, which is not a valid 
handle. 
 
However, keep in mind that 
the debug doesn’t act like a 
“spell-check.” This error will 
only be discovered when 
the function is triggered (by 
moving the fader above 3). The 
debug doesn’t scan your entire 
text for any errors, it simply 
reports when it is told to do 
something and encounters a 
problem.
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EXERCISE 17.3: VARIATIONS

If you haven’t given up yet, try these other variations on the coding that create 

different results.

1. To have the fader turn red above 3 decibels but turn green if it is under 0 

decibels, try this variation of the code:

2. To have the fader suddenly drop its gain to -10 if the DJ pushes the gain above 

3 decibels, use this variation:

3. To have the fader suddenly drop its gain to -10 and then have the control 

disappear entirely, use this variation:

You can see how your knowledge of Lua, mixed with the Q-Sys library of Lua controls 

and a little creativity, can really open up a new level of customization for your design. 

Feel free to continue to explore on your own, and experiment with these new 

possibilities.

That should shock the DJ! 

He’s much less likely to push 

the volume too far if it will 

suddenly dive down when he 

does so!

Now there’s a punishment!

17.3
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Dynamic Pairing is a special feature in the Q-Sys Designer software that 

allows the user to link a virtual peripheral device in the design with a new 

physical hardware device on the network, without needing to redeploy the 

design. In essence, it creates a virtual “placeholder” device that will become 

active once the physical device is connected to the network.

Without using Dynamic Pairing, the only way to add new hardware is to 

take the system offline, add the new devices into the Inventory panel and 

update the design, then redeploy to the Core. If your sound system is critical 

to running your business, this 

would make it impossible 

to add any new hardware 

during operational hours. With 

Dynamic Pairing, a designer 

can plan ahead for expected 

additions to the design by 

letting the system know what 

to do when those peripherals 

are plugged into the network.

• Understand the purpose of Dynamic Pairing and how it can be useful in 
your design.

• Build a simple design to demonstrate Dynamic Pairing in action

Dynamic Pairing

In This Chapter:

CHAPTER EIGHTEEN

CHAPTER MAP

18.1  BUILD A SAMPLE 
DESIGN  page 236

18.2  CONFIGURE 
DYNAMIC PAIRING  
page 238

18.3  SEND AUDIO      
page 240

QUICKSTARTS

• NOTE: You will need an active Core, an IO-22 peripheral device, and open ports on  
 a network switch to complete this tutorial.

“Did someone ask for the Dynamic Pairing?”
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EXERCISE 18.1: BUILD A SAMPLE DESIGN

To begin, you’ll need to build a sample design that requires Dynamic Pairing to work:

 
THE SCENARIO:
 
This sample conference hall has four rooms that are rented out for various events, one of 
which is a nightly Bingo game. The Bingo game might take place in a different room each 
night, depending on the conference hall’s availability. The Bingo operator has a multimedia 
cart with various audio sources and an IO-22 peripheral device, and would like to play his 
audio directly over the loudspeakers of whichever room the cart is in. With Dynamic Pairing, 
all the operator has to do is plug the IO-22 into a network port in any given room, and the 
Bingo Cart’s audio will be played over that room’s loudspeakers and none of the others.

1. Add an IO-22 to your 

Inventory from the 

Peripherals menu and drag 

its Mic/Line In component 

into your design. 

18.1
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2. Create a short signal path to represent this room. In this example, the audio 

from the IO-22 is sent to an Automatic Gain Control component, which then 

mixes with a Background Music Audio Player in a 2x2 Matrix Mixer, before being 

delivered to the room’s amplifiers via an IO Card in the room (In reality there 

may be much more complicated processing happening in this room, but this is 

just an example).

3. Duplicate this signal path for all four conference rooms. (NOTE: This means that 

you will need to add a total of FOUR IO-22 devices to your Inventory that will all 

be present in the design, even though there will only be ONE physical IO-22 in 

the actual space – on the Bingo Cart. Don’t worry!)

4. Select one of your IO-22 

devices and go to its Properties 

panel in the Right-Side Pane.

5. Change the Dynamically 

Paired field to Yes.

6. Change the Is Required field to No.

7. Repeat steps 5 and 6 for each of your four IO-22 devices.

8. Save your design and Run it to the Core by pressing F5.

The two changes you just made to these IO-22s are critical: First, you have enabled them to 
be Dynamically Paired, which will let the Administrator use them during the next exercise. 
Secondly, you’ve told the system that their presence is not required, which means that the 
Event Log will not trigger a fault when it is unable to locate them on your network. Instead, 
the software will simply display a grey box around the device in the Inventory when running 
on a Core, as seen in the image to the right.

X X

X
X X

X
Remember, you only have one 
physical IO-22, even though 
there are four virtual instances 
of that device in your design. If 
you don’t tell your system that 
these devices aren’t required, 
your Event Log will constantly 
fill with faults, since at least 
three of these four IO-22s will 
be missing at any given time!

18.1
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EXERCISE 18.2: CONFIGURE DYNAMIC PAIRING

Dynamic Pairing is configured in the Administrator, which 

can be accessed using the icon in the upper-right corner or by 

using the standalone Administrator software. This process will 

only have to be completed once, after which the device will 

automatically pair itself in the system when it is connected to 

your network. But before that is possible, your design must 

know what it is looking for, and where to look for it.

NOTE: This Exercise requires you to have an IO-22 as well as access to a network 

switch with multiple available ports.

1. Click on the Dynamic Pairing 

Administrator tab.

This is a new tab that is only available when one or more devices have their Dynamic 

Pairing properties set to Yes. This window shows a list of the Names of the available 

devices, as well as a column for their Dynamic Pairing Method and Pairing Data. 

These two columns are currently blank, and need to be configured.

2. Click on a device and open the drop-down menu in its Method column.

3. Select Switch Port.

18.2

Need to brush up on your 
Administrator skills? Check out 
the Administrator tutorial 
starting on page 60.
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18.2There are two methods to discover a device using Dynamic Pairing- Net Name and 
Switch Port – and each has its own specific purpose.

Selecting Net Name means that your primary concern is 
the exact name of the device you are looking for, regardless 
of where it is found on the network. For instance, you may 
be building a design that will eventually expand to include 
an additional Page Station. Since paging is critical to your 
business you won’t want to shut your system down in 
order to integrate that new Page Station. So you could add it to your original design 
using Dynamic Pairing even though it doesn’t exist yet, and when it is connected to your 
network later (wherever that may be) it will function as desired. 

Selecting Switch Port means that your primary concern is the 
location of the device you are looking for, which is appropriate 
for this chapter’s example. This location comes in the form of a 
specific switch port, which may be displayed as a MAC address 

or another label, depending on your switch type. A benefit 
of this method is that this allows any IO-22 to function that 
is plugged into that port. This means you are not limited to 

the Bingo Instructor’s cart - you may also have a DJ with 
an IO-22 as part of his gear, or a Dance Instructor using an IO-22, who 
could each plug into the network and be treated in the same manner.

YOU

ARE

HERE

4. Connect your IO-22 device to an available 

port in your network switch.

5. In the Administrator, open the drop-down 

menu in the Pairing Data column for the 

device you are currently working on.

6. Select the appropriate network port.

7. Repeat Steps 2-6 with three more open ports on your network.

For this example, we are using four ports to represent the four places that the Bingo 

Cart may connect to your network in the conference hall. In a real installation, these 

ports would likely be on different switches, one in each room. The system is now 

configured to pair an IO-22 device on each of these ports with your Inventory. 

It may take 30-60 seconds 
for the Pairing Data field to 
populate after you connect the 
device to your switch, while the 
Q-Sys Configurator discovers 
the device on the network. 
 
The only ports displayed will 
be those that have an IO-22 
connected to them (in this 
example), so if you have other 
IO-22s in your design be sure 
to select the correct port.

BE PATIENT!

KEEP YOUR 
CHANGES!

Don’t forget to click the 
Update button in the 
Administrator after making 
your changes in order to keep 
these settings!
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EXERCISE 18.3: SEND AUDIO

All that remains is to verify that the Dynamic Pairing is working as it should.

1. Connect an audio source to your IO-22’s input and play audio through the 

device.

2. Connect the IO-22 to the network switch port you associated with Room 1.

3. Hover your mouse pointer 

over the output signal from 

Room 1, and the Hover 

Monitor will display your 

audio signal. Feel free to 

click the Unmute button to 

listen over your computer’s 

loudspeakers.

4. Hover your mouse pointer over 

the output signal for another 

room, and notice that there is 

no audio being passed through 

that room’s loudspeakers.

5. Disconnect the IO-22 from the network, and then connect it to the switch port 

you associated for another room.

6. Hover your mouse pointer over the output signal for Room 1, and notice that 

the audio signal is no longer being passed through this room.

7. Hover your mouse pointer over the output signal for your new room, and notice 

that the audio has now been routed through this room.

8. Repeat these steps for all rooms to verify that Dynamic Pairing is properly 

configured.

Now that Dynamic Pairing is successful, your Bingo operator only needs to plug into 

the correct network port to have his audio sent over that room’s loudspeakers. No 

more work needs to be done in Administrator, it is literally as simple as plugging a 

device in and the audio will route correctly.

18.3
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Support Resources

19.1  APPLICATION 
ENGINEERING TEAM  
page 241

19.2  TECHNICAL 
SERVICES GROUP 
page 244

19.3  TRAINING & 
EDUCATION 
page 245

CHAPTER NINETEEN
TRAINING

• Meet three teams dedicated to helping you with your Q-Sys experience

In This Chapter:

When you’re working with QSC and Q-Sys products, you’re never alone. 

There are professional personnel available to you whenever you need them 

to help you assess and create a new design, validate an existing one, and 

troubleshoot any problems you may encounter. The next two pages will 

introduce you to three teams that you may find invaluable during your Q-Sys 

experience - the Application Engineering Team, Technical Services 

Group, and Training & Education.

CHAPTER MAP
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19.1

EXERCISE 19.1: APPLICATION ENGINEERING TEAM 
(AET)

The AET team includes staff with specialized experience to provide guidance for a 

wide range of projects such as medium to large scale installations, live performance, 

concert/production, and public address systems. To apply for any of these services, 

visit www.qscaet.com.

The following are services 

provided specifically in support 

of Q-Sys Systems:

• Q-Sys Design Proposal: QSC will submit a Q-Sys solution based on the 

supplied venue details. This includes a factory document outlining the 

recommended product selection for the design. This document may include 

examples of the software design demonstrating input blocks, output blocks, 

processing objects, and custom-control screens. 

Copyright © 2012 QSC Audio Products LLC 

All Rights Reserved

Christ Fellowship Missionary

System Rigging

Disclaimer: Suspension and mounting of loudspeakers represents a potential safety

hazard. QSC has no knowledge about the actual structural integrity of the venue for which

this design proposal has been given. Any recommended loudspeaker placement made by

QSC is based solely on predicted system performance, not on structural integrity - for any

structural design please contact a qualified structural engineer. The system installer

maintains sole responsibility for properly installing the equipment and complying with all

applicable standards and local regulatory requirements.

Page 36

Left & Right Arrays:

Company:
QSC

System Setup:
Wideline8

Pick Point:
X=32.00 ft

Y=31.00 ft

Cradle Angle:
-4.00°

Pin Point:
6 (Remaining Angle=3.00°)

Frame Weight:
377.26 lbs ("3rearWL212-sw")

Box Weight:
305.52 lbs ("WL3082")

Total Weight:
682.78 lbs

Height:
6.50 ft

Nr.
Box

Gain
Angle

Total

Frame 3rearWL212-sw

-4.00

0

1
WL3082

0 dB

-4.00°

2

2
WL3082

0 dB

-6.00°

3

3
WL3082

0 dB

-9.00°

5

4
WL3082

0 dB

-14.00°

6

5
WL3082

0 dB

-20.00°

7

6
WL3082

-3 dB

-27.00°

9

7
WL3082

-3 dB

-36.00°

10

8
WL3082

-3 dB

-46.00°

Copyright © 2012 QSC Audio Products LLC All Rights Reserved

Christ Fellowship Missionary

EASE Mapping – Direct Field Only

Page 32

Direct SPL 1kHz – 4kHz, Front Fill
Sound System Design Proposal

Christ Fellowship Missionary

Chicago, IL

Z-2494

August 20, 2012

Copyright © 2012 QSC Audio Products LLC All Rights Reserved

Christ Fellowship Missionary

Venue Overview

Venue Description:

Venue Requirements:

Page 6

The system design must be consistent with full contemporary worship and exhibit exceptional coverage, clarity, and dynamic range.

The venue is described as a full contemporary house of worship.  
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19.1

• Q-Sys System Validation: QSC will test to ensure the integrity of your Q-Sys 

Design.  

• Q-Sys Switch Validation: QSC can also provide testing and validation of 

non-approved Gigabit switches.  Please be aware that this service will require 

you to ship your Switch samples to our factory for testing. Note: this request 

must be tied to a project. 

• Q-Sys Feature Request: QSC will consider your request for a new Q-Sys 

Designer software feature.  Note: this request must be associated with a 

project. 

• Design Conversion: QSC will review a competitors’ system design or 

specification, and provide guidance on alternative solutions based upon QSC 

products. This service does not include any drafting of system designs or 

computer modeling. 

• Onsite Support: For a fee, QSC can deploy an experienced Application 

Engineer to travel onsite and assist with tuning, optimizing and commissioning 

the QSC system, using state-of-the-art measurement tools and practices.

QUALIFIED 
SWITCHES

You can find a list of approved 
switches in the Q-Sys Designer 
Help file. Simply press F1 and 
type in “Ethernet Switches” 
in the Search field and you’ll 
see a list of acceptable 
switches. You can also access 
the most up-to-date list online 
at qsc.com.
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19.2
EXERCISE 19.2: TECHNICAL SERVICES GROUP

If you need some immediate help with your design, QSC offers 24/7 support on 

Q-Sys networked audio systems.

Full Support Business Hours:

6 AM to 5 PM Pacific Time (Mon-Fri) 

Tel. 800-772-2834 (USA only) 

Tel. +1 (714) 957-7150

 

Q-Sys Emergency-only After-Hours and Weekend Support*

+1-888-252-4836 (USA/Canada) 

+1-949-791-7722 (non-USA)

* After hours calls are guaranteed a 30-minute response time from a Q-Sys Support 

Team member for Q-Sys ONLY!

 

E-mail: qsyssupport@qscaudio.com

(Immediate e-mail response not guaranteed. For URGENT issues use the phone 

numbers above.)

IT’S AN
EMERGENCY!

The After-Hours and Weekend 
Support line is for emergencies 
only! If your problem is that 
you can’t figure out how to 
change the color of your fader 
from dark blue to ocean blue, 
you can wait until Monday to 
call in.
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19.3
EXERCISE 19.3: TRAINING & EDUCATION

Last but not least, the Training & Education team has all the additional resources and 

materials you need to keep informed of anything Q-Sysrelated. QSCtraining.com is 

a valuable resource for new features, and allows users the ability to complete Q-Sys 

Certification.

1. Online Training & Certification 

All of the chapters of this textbook are available 

in video-training format, which can be watched 

by streaming online and are also available for 

download to watch offline. Users then complete 

the online assessment quizzes to earn their 

Q-Sys Certified status.

2. Textbook Training 

The online version of this textbook is a living document that will receive regular 

updates when new features come out.

3. Q-Sys Project Files 

A great education supplement for many of the exercises in 

this book, the website includes many downloadable project 

files that demonstrate the processes of each course. 

4. Presentations and Commercials 

There is a library of downloadable product sales presentations and video 

demonstrations on the website as well, particularly useful if you are a QSC 

representative or distributor. All content has been optimized for PC, Mac, and iOS 

devices.

5. Q-Sys Level Two Classes 

Ready for the next step? 

Sign up for an in-class Level 

Two class either at the QSC 

headquarters in Costa Mesa, 

CA, or in select classes closer 

to you!

Education
TRAINING &

LOOK AT 
THAT GUY!

That is one incredibly 
handsome man. Just thought 
I should point that out. No 
educational content here, 
just making sure it didn’t 
go unstated that I’m just 
amazingly ... I mean, that guy 
is amazingly good looking. 
Also, humble.
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Glossary
ACOUSTIC REFLECTIONS
The echoes of a sound that result from it 
taking multiple paths through a room from 
the audio source to the destination

ALIGNMENT LINES
Guideline in the Designer software that 
help arrange components without the help 
of a grid

ATTACK TIME
The length of time it takes for a process to 
be applied to a signal

AUTOMATIC PAGE
A Page that will be played live if a zone 
is available or recorded and delayed if a 
zone is unavailable

BREAKPOINT
A vertex in a wire, movable and deletable

COMPONENT
A virtual block in the Designer Schematic 
that represents a process or inventory 
item, which can be wired to other 
components as part of your signal path

CONTROL
An item in the Designer Schematic which 
can either alter or display the value of 
another item, including meters, faders, and 
buttons

CONTROL PANEL
The “inside” of a component in the 
Designer Schematic, which houses all of 
the component’s default controls

CONTROL PINS
Additional pins that can be made available 
on a component that allow controls from 
one component to directly affect the 
control of another

CORE
Referring to the Q-Sys Core, available in 
multiple models with various capacities, 
which is needed to manage and process 

the audio in a Q-Sys system 

DATAPORT
A proprietary connection for certain QSC 
amplifiers which routes audio as well as 
monitoring information

DELAYED PAGE
A Page that will be recorded and then 
broadcast when the target zones are 
available

DEPTH
The amount of attenuation applied to a 
signal when the corresponding process is 
active

DESIGNER SOFTWARE
The free program that allows a user to 
design and modify a Q-Sys system on their 
computer

EMULATION MODE
A method of simulating certain Core 
processes in the Designer software without 
the need of connecting to a Core

EVENT
A scheduled moment in the Administrator 
calendar that triggers one or more actions, 
such as a control command or snapshot

FAN-OUT
The process of sharing one audio signal 
input across multiple audio signal outputs, 
used to maximize audio channel count

FAR END
In reference to a teleconferencing system, 
the Far-End is the remote caller who is not 
a part of the integrated phone system

GATE
A gate refers to a process that impedes 
the passage of audio, usually based on 
certain frequencies of audio. To “gate” the 
audio is to prevent it from being sent (or 
attenuate it)

GPIO
General Purpose Input/Output, a 
connection available on many Q-Sys 
devices that allow communication with 
third-party devices

I/O CARD
An Input/Output Card is any of the 
available cards that can be installed into 
a Q-Sys Core or I/O Frame that allow 
connections of different types to interface 
with the Q-Sys system

I/O FRAME
An Input/Output Frame holds up to four 
I/O Cards that allow audio sources or 
destinations to be connected to the Q-Sys 
system without needing to be in close 
proximity to the Core

I/O-22
A compact standalone input/output device 
intended to be used when audio sources 
and destinations are physically spread out

LEFT-SIDE PANE
The collapsible section of the Designer 
Software that houses the Inventory, 
Schematic Pages, UCI, Snapshots, Named 
Controls, and Design Inspector

LIVE PAGE
A Page that is not recorded and broadcast 
at the same time that it is being made

NEAR END
In reference to a teleconferencing system, 
the Near-End consists of the room and 
callers who are on the same system as the 
integrated phone system that is processing 
the audio

NOM
An acronym that stands for Number of 
Open Mics, used in a Gated Ambient 
Compensator
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ORPHAN
In the Designer software, an orphaned 
object is a control that was pulled from a 
component that has since been deleted

PAGE
A message broadcast across different 
zones of a venue that is usually 
informative in nature, as opposed to 
background music

PAGE STATION
A Q-sys peripheral that provides access 
to the public address system and includes 
a microphone for making pages and 
buttons for recalling messages and other 
commands

PINS
The points of connectivity for a component 
in the Designer software. Pins on the left 
of a component represent audio/control 
entering the component, and pins on the 
right represent audio/control leaving the 
component. Pins may only be connected 
to another pin of the same type

PRIORITY
A numerical status of a message, page, 
user, or microphone that determines its 
importance in hierarchy in comparison 
to other similar items, which allows it to 
override (or be overridden) when multiple 
items are being used simultaneously

PS/X
A peripheral device to a Page Station that 
provides an additional microphone that 
can be connected remotely

Q-LAN
The network audio protocols that 
comprise the communication between all 
Q-Sys devices

QUEUING
The system that delivers messages and 

pages to a zone, in  order of their priority, 
for broadcast when the zone had multiple 
items sent to it simultaneously

RAMP TIME
The length of time for a particular process 
to take effect

REDUNDANCY
The status of having multiple identical 
devices networked together, allowing one 
device to take over all control in the event 
of a failure in the other device

RELEASE TIME
The length of time for a particular process 
to cease its effect

RIGHT-SIDE PANE
The collapsible section of the Designer 
software that houses the Schematic Library 
and Graphic Tools

ROOM IMPULSE RESPONSE
The manner in which a room affects the 
audio that is played within it, creating 
residual echoes of the sound as it bounces 
off the various surfaces of the room. This 
manner is used to predict how audio 
will respond to the room for purposes of 
deleting it in an Acoustic Echo Canceler 
component

RS232
A type of connection available on 
many Q-Sys devices that allow for 
communication with various third-party 
peripherals

SCHEMATIC
The center section of the Designer 
software that allows for free organization 
and customization of your audio 
signal path by wiring together various 
components and inventory items

SIGNAL PATH
The complete collection of wires and 

components in the Designer Schematic 
that represent the different processes and 
routing that happen to an audio signal 
between entering the Q-Sys network and 
being returned to an amplifier

TAGS
A customizable label that can be applied to 
different elements within the Administrator 
used to group similar elements together.

TERMINATED
The act of being completed - a wire 
is considered terminated when both 
ends of it are properly connected to an 
appropriate terminal

TOUCHSCREEN CONTROLLER
A peripheral device that allows for tactile 
control over a User Control Interface, such 
as a QSC Touchscreen device or an iPhone 
or iPad

USER CONTROL INTERFACE (UCI)
A customizable display that provides 
specific controls over the audio path 
designed to be used by an end user 
without giving access to the entire system

WEIGHT
In terms of text within the Designer 
software, weight refers to whether or not 
a text is bold

WIRING
The method of connecting components 
together within the Designer software, 
which could be done with Traditional 
Wiring, Signal Names, or Signal Snakes

ZONE
Different destination outputs for audio, 
specifically in regards to pages and 
messages sent through the public address 
system, that correlate to different areas of 
a venue

Glossary (cont’d)
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Index
Symbols

2-D Matrix Panner  51, 81

A

Acoustic Echo Canceler  190
Adaptive Algorithm  193, 195
Adaptive Filter  193, 194
Administrator  60
AES-3 Card  13, 162
Align and Distribute  29
alignment lines  28, 29
Ambient Noise Compensators  

140
Application Engineering Team  

241, 242
Audio Components  47, 48
Audio Files  64
Audio File Sync  34
Audio Player  47, 103, 205, 217
Audio Recorder  109
Audio Tracks  33, 106

B

Background Music (BGM)  168
Band Count  45
Bandwidth  161, 163
BGM Ducker  183
Blinking LED  52
breakpoint  39
Button  89

C

CCN32  13
CD player  6
Check Design  107, 161
CIML4  12
Clean Screen  52
Clocking  33
CobraNet  13
Code  66
CODP4  12
COL4  12, 19
Comfort Noise  193, 197
Command Buttons  181
Command Priority  175
Commands  64, 65
Command Schedule  64, 69

components  28
Compressor  47
Configurator  166
Continuous Ambient Compensa-

tor  140, 147, 148
Control Change Commands  65
Control Components  47, 52
Control Functions  206
Control ID  91
Control Link  221
Control Panel  30, 50, 87
Control Pins  27, 49, 205
Controls  30, 79, 87
Control Script  52
Core  6, 7, 32, 59

back panel  8
front panel  7
sizes  9, 161, 198
Status Component  34

Core-to-Core Pagin  188
Core-to-Core Paging  168
Core-to-Core Streaming  216
Corner Radius  54, 89
Crossover  47
Custom Voicing  45

D

DAB-801  21
Data Link  156
DataPort  18, 19, 21, 37, 44
DataPort Card  12
Delay  47
Designer  27
Design Inspector  27, 40, 41, 

56, 57
Doppler  48
Double-Talk Detector  193, 196
DUCKING  187
Dynamics  47
Dynamic Stream Name  218

E

Echo  48
Effects  48
E-Mailer  52
Enable Archive Export  179
Equalizers  48
Event  69

Event Log  64, 77, 179
Expander  47
Extract Names Controls  56

F

fan-out  107
File Management Protocol  73
Fill  53, 88
Filters  48, 68
Find  30
Finite Impulse Response Filter  

194
Firmware  223
Flanger  48
flex channels  161

G

Gain  48
Gain Ramp  48
Gain-Sharing Automatic Mixer  

129, 130
Gated Ambient Compensator  

140, 141, 143
Gated Automatic Mixer  129
Generic Speaker  45
Gigabit  158, 163
Global Priority Mode  175
Global Snapshot Bank  67
GPIO  8, 11
Graphic Equalizer  48
Graphic Tools  27, 53, 92, 97
Group Box  54
guidelines  98

H

Hardware  5
Header  54
Help  48
highlighting  29

I

ID Button  7, 10, 34, 62
Input Bank  51
Intel  9
Intrinsic Correction  45
Inventory  27, 32, 33, 35, 37, 45, 

56, 63

Inventory Status  34, 74, 94
I/O-22  14
I/O Card  6, 7, 8, 11, 12, 162
I/O Frame  6, 35, 160

back panel  11
front panel  10

I/O FRAME  10
IO Monitor  121
iPad  93, 95, 99
IP Address  155
iPhone  93, 95, 99

K

Keypad Commands  181
Knob  89

L

Layout  47, 52
LED  89
Left-Side Pane  27, 56
Line Out Card  12
Local Audio Channels  160, 162
Log Off  52
Loop  71, 105
Loudspeaker Monitor  121
Low-Pass Filter  48

M

MAC addresses  156
Media Drive  33
Messages  75, 165, 172
Meter  48, 90
Mic/Line Card  12
microphone  6
Mixers  48, 50

N

Named Controls  27, 56, 65, 67
network  6, 8, 153
Router  155
Network  155, 163
Network Audio Channels  160, 

161
Network Audio Streams  160, 163
Network Receive Buffer  33
Noise Reduction  193, 197
Non-Linear Processor  193, 196
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Index (cont’d)

O

Order  29
OSI 7-Layer Model  154
Overrides  176

P

Page  165
Page Archives  75, 179
Page Station  15, 66, 165, 166, 

167, 180
Page Tab  94
pagination  43
PA Global Settings  174
Panel Type  95
PA Page Commands  65, 172
paper clip  225
PA Play Message Commands  65, 

172
PA Play Messages  75
Parametric Equalizer  48
PA Router  48, 168, 182
password  61
Peak Limiter  47
peripherals  14, 15, 35
Physical  156
PIN  72
Pink Noise Generator  130, 141
pins  28, 37, 42
Playlists  76, 108
POE injector  166
Polygon  55, 92, 97
Popup Button  101
port  155
POWER LED  7, 10
Preambles  75, 173
Priority  165, 174
Priority Ducker  187
Private Field  95
Properties  27, 30, 49
PS-X  15
Public Address  48, 164

Q

QDP  158
Q-LAN  6, 8, 11, 153, 217
Q-LAN Receiver  219
QSC  9
Q-Sys App  99
Q-Sys Configurator  61
Queuing  165, 178

R

Ramp Time  66, 84
Redundancy  20
Remote Destination  168
Remote Source  168
Right-Side Pane  27
Room Combiner  48
Router  48
RS232  8, 11

S

Scene Mode  85
Schematic  27
Schematic Library  27, 47
Schematic Pages  27, 43, 56
Switch  158
Signal Names  36, 40
signal path  6
Signal Presence  48
Signal Snakes  36, 42, 52
Snapshot Count  80
Snapshot Load Commands  65, 

67
Snapshots  27, 56, 67, 79, 80
SoftPhone  190, 198, 200
Software  26
Spanning Tree  159
Squelch Priority  182
Station/User Priority  175
Status LED  7, 10
Streaming  217
Stroke Color  53
Stroke Width  53

Style  89, 91
Support  244
Swipe  94
switching  156, 243
System Mute  48

T

Tags  68, 74, 171
TCP  157
Technical Services Group  241, 

244
Test and Measurement  48
Text Block  53
Text Field  90
Timeline  110
TouchScreen Controllers  16
Traditional Wiring  36, 37
Transport  155
Troubleshooting  225
TSC-3  16, 95

U

UCI Viewer  99
UDP  157
Unlink  89
User Control Interfaces  16, 27, 

56, 64, 74, 93, 94
User-Defined Snapshot Bank  83
User Library  52, 122
Users  64, 72, 176

V

Verbose  34
Virtual Page Station  48, 165, 169, 

184
Voice Over Internet Protocol  190, 

200

W

Wiring  36
Write Protect Mode  85

Z

Zone Group  185
Zones  165, 171


